## Contents

1 What is interoperability?................................................................................................. 9
2 Industry standards........................................................................................................ 10
3 Compatible formats...................................................................................................... 11
4 Compatible software................................................................................................... 13
5 Importing to and exporting from Tekla Structures.................................................. 27
6 Conversion files........................................................................................................... 28
6.1 Twin profile conversion files.................................................................................... 29
6.2 Creating conversion files........................................................................................ 30
7 Reference models......................................................................................................... 33
7.1 Inserting a reference model....................................................................................... 34
7.2 Viewing reference models........................................................................................ 35
7.3 Modifying reference model details.......................................................................... 38
7.4 Locking reference models....................................................................................... 39
7.5 Detecting changes in a reference model................................................................. 40
7.6 Examining reference model contents....................................................................... 40
7.7 Reference model objects........................................................................................ 41
7.8 Examining reference model hierarchy and modifying reference model objects........ 41
7.9 Reference model assemblies.................................................................................. 45
8 IFC............................................................................................................................... 47
8.1 IFC import................................................................................................................ 47
   IFC object converter.................................................................................................. 48
   Converting IFC objects into native Tekla Structures objects..................................... 49
   Limitations in IFC object conversion......................................................................... 50
   Defining the settings for profile mapping of IFC objects............................................ 51
   Checking the profile and material of converted objects............................................. 52
   Copying IFC object properties to the user-defined attributes of converted objects........ 53
   Displaying catalog and mapping files of converted objects....................................... 53
   Creating reports of converted IFC objects................................................................... 54
   Example: Converting IFC objects into Tekla Structures objects................................ 56
8.2 IFC export................................................................................................................ 59
   Defining the IFC data for the exported model on a project level................................ 60
   Defining the IFC entity for the exported model objects............................................. 61
   Exporting a Tekla Structures model into an IFC file............................................... 62
9 SketchUp.................................................................................................................................73
9.1 Exporting a model to SketchUp..............................................................................................73

10 DWG and DXF.......................................................................................................................74
10.1 Importing a 2D or 3D DWG or DXF file...................................................................................75
10.2 Exporting a model to a 3D DWG or DXF file..........................................................................76
10.3 Exporting a drawing to a 2D DWG or DXF file.......................................................................77
Layers in exported drawings.........................................................................................................79
Creating layers for drawing export.............................................................................................79
Assigning objects to export layers.............................................................................................80
Example: Creating a rule for exporting beam marks to their own layer ......................................81
Copying export layer settings to another project .........................................................................82
Defining customized line type mappings in drawing export..........................................................83
Default line types in drawings.....................................................................................................85
Example: Setting up layers and exporting to DWG......................................................................86
  Example: Creating a selection filter for DWG export..................................................................86
  Example: Creating layers for DWG export..................................................................................87
  Example: Creating a rule for DWG export...................................................................................88
  Example: Defining a custom line type for DWG export.................................................................89
  Example: Defining line types and weights for layers in DWG export..........................................89
  Example: Exporting the drawing..................................................................................................91

11 LandXML...................................................................................................................................94

12 NC files.....................................................................................................................................96
12.1 DSTV file description..............................................................................................................96
12.2 Creating NC files in DSTV format..........................................................................................98
12.3 NC file settings.......................................................................................................................99
12.4 Customizing NC file header information ..............................................................................107
12.5 Pop-marks in NC files...........................................................................................................109
  Creating pop-marks in NC files..................................................................................................110
12.6 Contour marking in NC files................................................................................................112
  Creating contour marking in NC files.........................................................................................112
12.7 Creating NC files in DXF format ............................................................................................114
12.8 Fittings and line cuts in NC files.............................................................................................115
12.9 Creating tube NC files ..........................................................................................................116

13 PDF........................................................................................................................................118
13.1 Importing a PDF to a model................................................................................................118
26 Layout Manager........................................................................................................229
26.1 Creating a group in Layout Manager........................................................................230
  Defining numbering settings for groups in Layout Manager........................................231
  Defining a local coordinate system for a group in Layout Manager..............................232
26.2 Creating a layout point..........................................................................................232
26.3 Creating a layout line..........................................................................................233
26.4 Viewing groups, layout points and layout lines......................................................234
26.5 Exporting from Layout Manager...........................................................................235
  Defining default export settings in Layout Manager......................................................236
  Defining the drawing scale in Layout Manager.............................................................237
26.6 Importing to Layout Manager...............................................................................238
  Defining point file columns in Layout Manager............................................................239
  Measured points in Layout Manager...........................................................................240

27 Tekla Web Viewer.............................................................................................243
27.1 Publishing a model as a web page..........................................................................243
27.2 Customizing Web Viewer tooltips..........................................................................244
27.3 Web templates.....................................................................................................245
27.4 E-mailing Web Viewer models...............................................................................246
27.5 Receiving Web Viewer models...............................................................................246
27.6 Sending Web Viewer links....................................................................................247
27.7 Creating a named view in Web Viewer....................................................................247
27.8 Creating a clip plane in Web Viewer........................................................................248
27.9 Showing and hiding an object in Web Viewer.........................................................249
27.10 Using a large model in Web Viewer......................................................................250
27.11 Moving and zooming in Web Viewer.....................................................................250

28 Tekla BIMsight....................................................................................................252
28.1 Importing reference models from Tekla BIMsight....................................................252
28.2 Importing additional reference models from a Tekla BIMsight project...................253
28.3 Publishing a model to Tekla BIMsight....................................................................253

29 Tekla Structural Designer..................................................................................255
29.1 Example workflow of integration between Tekla Structures and Tekla Structural Designer.......................................................................................................256
29.2 Importing with Tekla Structural Designer integrator..............................................257
29.3 Re-importing with Tekla Structural Designer integrator........................................258
29.4 Exporting with Tekla Structural Designer integrator..............................................259
29.5 Additional information about integration between Tekla Structures and Tekla Structural Designer...............................................................................................260

30 Tekla Warehouse...............................................................................................263
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>Analysis and design systems</td>
<td>265</td>
</tr>
<tr>
<td>31.1</td>
<td>Analysis and design direct links</td>
<td>265</td>
</tr>
<tr>
<td>31.2</td>
<td>Robot</td>
<td>266</td>
</tr>
<tr>
<td>31.3</td>
<td>SAP2000</td>
<td>266</td>
</tr>
<tr>
<td>31.4</td>
<td>STAAD.Pro</td>
<td>267</td>
</tr>
<tr>
<td>31.5</td>
<td>ISM</td>
<td>267</td>
</tr>
<tr>
<td>31.6</td>
<td>S-Frame</td>
<td>268</td>
</tr>
<tr>
<td></td>
<td>The process of importing to and exporting from S-Frame</td>
<td>268</td>
</tr>
<tr>
<td>32</td>
<td>Disclaimer</td>
<td>270</td>
</tr>
</tbody>
</table>
Interoperability is often seen as the missing link between different software systems. It allows best-of-breed applications to share common objects, geometry and properties between applications. Interoperability is a process, which allows diverse systems and organizations to work together. This allows common 3D models to be built or information and geometry defined in one system to be used in another. An example of this would be a 3D structural frame from a modeling application being transferred and used by an Analysis & Design system. Another example would be an Architectural model being used within a structural modeling system.
There are many industry standard file transfer formats. The principle ones supported by Tekla Structures are IFC, CIS/2, DSTV, SDNF, DGN, DXF, DWG, IGES, and STEP. Older formats are also included. For a tighter integration, you can link to Tekla Structures using the Tekla Open API technology.

The file name extension normally informs the user which format it is based upon. If you do not know what format it is, or the file does not import, then you will need to open the file in a text editor to look at the header information, where the file type and the authoring application is usually noted. With CIS/2 files the authoring application and version number is sometimes written at the end of the file.

See also

Compatible formats on page 11
## Compatible formats

You can import and export several formats in Tekla Structures.

The following table lists many of the different formats you can use in Tekla Structures to import and export data.

<table>
<thead>
<tr>
<th>Format</th>
<th>Import</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD (.dwg)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AutoCAD (.dxf)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bentley ISM</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BVBS (.abs)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Cadmatic models (.3dd)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM5/LPM6 analytical</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM5/LPM6 design</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM6 manufacturing</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>DSTV (.nc,.stp,.mis)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EJE</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Elematic ELiPLAN, ELiPOS (.eli)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EPC</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>FabTrol Kiss File (.kss)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>FabTrol MIS Xml (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GTSdata Priamos</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>High Level Interface File (.hli)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HMS (.sot)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IBB Betsy</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IFC2x2 (.ifc)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IFC2x3 (.ifc)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IFCXML2X3 (.ifcXML)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IFCZIP (.ifcZIP)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification (IGES) (.iges,.igs)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>LandXML (.xml)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Microsoft Project (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Microstation (.dgn)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Oracle Primavera P6 (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Plant Design Management System (.pdms)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>RIB iTWO</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>SAP, Oracle, ODBC, etc.</td>
<td>X*</td>
<td>X*</td>
</tr>
<tr>
<td>SketchUp (.skp)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Staad ASCII file (.std)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Steel Detailing Neutral Format (.sdf,.sdnf,.dat)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Steel12000</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>STEP AP203 (.stp,.step)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>STEP AP214 (.stp,.step)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tekla BIMsight project file (.tbp)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tekla Collaboration files (.tczip)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Tekla-FabTrol Report (.xsr)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Tekla Structures shape (.tsc)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Trimble LM80 (.txt,.cnx)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unitechnik (.uni)</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

* Tekla OpenAPI used

See also

Compatible software on page 13
The following table lists Tekla Structures compatible software and the formats that you can import to and export from Tekla Structures. Some of the compatible interoperability applications are available on Tekla Warehouse, such as PDMS, ISM link, SCIA, Smart3D, and many more.

<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D+</td>
<td>Tekla</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>3ds Max</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>3ds Max Design/VIZ</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>Adapt Corporation</td>
<td>Adapt Corporation</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Advance Steel,</td>
<td>GRAITEC</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>Advance Design/Engineering</td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Allplan</td>
<td>Nemetschek</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>ANSYS</td>
<td>ANSYS</td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>ArchiCAD</td>
<td>Graphisoft / Nemetschek</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZIP (.ifczip)</td>
<td>IFCZIP (.ifczip)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coordinated view v1</td>
<td>Coordinated view v1</td>
</tr>
<tr>
<td>ArchonCAD</td>
<td>ArchonCAD Ltd.</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>ASI</td>
<td>Applied Science International LLC</td>
<td>Staad ASCII file (.std)</td>
<td></td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td>Architecture</td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td>Civil 3D</td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td></td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td>MEP</td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>AutoPLANT</td>
<td>Bentley</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>AutoVue</td>
<td>Oracle</td>
<td></td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------------------------------</td>
<td>-----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>AxisVM</td>
<td>Inter-CAD Kft.</td>
<td>Direct Link</td>
<td>Direct Link (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>Bentley Architecture</td>
<td>Bentley</td>
<td>Direct Link (ISM)</td>
<td>Direct Link (ISM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>Bentley Building Electrical Systems</td>
<td>Bentley</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>Bentley Building Mechanical Systems</td>
<td>Bentley</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>Bentley Structural</td>
<td>Bentley</td>
<td>Direct Link (ISM)</td>
<td>Direct Link (ISM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>BVBS</td>
<td>BVBS</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>CADmep+</td>
<td>MAP Software / Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZip (.ifczip)</td>
<td>IFCZip (.ifczip)</td>
</tr>
<tr>
<td>CADmatic</td>
<td>Cadmatic</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cadmatic models (.3dd)</td>
<td></td>
</tr>
<tr>
<td>CADPipe</td>
<td>AEC Design Group</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>CADWorx Plant</td>
<td>Intergraph / Hexagon</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>CAESAR II</td>
<td>Intergraph / Hexagon</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td>CATIA</td>
<td>Dassault</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>ConSteel</td>
<td>ConSteel Solutions Limited</td>
<td></td>
<td>ASCII</td>
</tr>
<tr>
<td>Constructor</td>
<td>VICO Software</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------</td>
<td>----------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>CYPECAD</td>
<td>Cype</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Daystar Software</td>
<td>Daystar Software Inc.</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
</tr>
<tr>
<td>DDS-CAD</td>
<td>DDS</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Diamonds</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Digital Project</td>
<td>Gehry Technologies</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
<td>STEP AP203/AP214 (.stp,.step)</td>
</tr>
<tr>
<td>DuctDesigner 3D</td>
<td>QuickPen / Trimble</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>elcoCAD</td>
<td>Hannappel SOFTWARE E GmbH</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>ELiPLAN</td>
<td>Elematic</td>
<td>ELiPLAN (.eli)</td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>ELiPOS</td>
<td>Elematic</td>
<td></td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>EliteCAD</td>
<td>Messerli Informatik</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>ETABS</td>
<td>Computers &amp; Structures, Inc.</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP214 (.stp,.step)</td>
<td></td>
</tr>
<tr>
<td>FabPro Pipe</td>
<td>UHP Process Piping Inc.</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>FabTrol MRP</td>
<td>FabTrol</td>
<td>FabTrol MIS XML (.xml)</td>
<td>FabTrol MIS XML (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FabTrol KISS File (.kss)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tekla-FabTrol Report (.xsr)</td>
</tr>
<tr>
<td>FactoryCAD</td>
<td>Siemens</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Fastrak</td>
<td>CSC</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>FelixCAD</td>
<td>SofTec</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>FEM Design</td>
<td>StruSoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Floor Pro</td>
<td>Adapt Corp.</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>FormZ</td>
<td>AutoDesSys, Inc.</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>GSA</td>
<td>Oasys</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>GT Strudl</td>
<td>GT Strudl</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td></td>
</tr>
<tr>
<td>HMS</td>
<td>HMS</td>
<td></td>
<td>HMS (.sot)</td>
</tr>
<tr>
<td>HOOPS</td>
<td>Tech Soft 3D</td>
<td></td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Inventor</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------</td>
<td>---------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>IronCAD</td>
<td>IronCAD</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>KeyCreator</td>
<td>Kubotek</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>LEIT2000</td>
<td>SAA</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>MagiCAD</td>
<td>Progman</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>MasterFrame</td>
<td>MasterSeries</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
</tr>
<tr>
<td>Maxon Cinema</td>
<td>Nemetschek</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td>4D</td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Maya</td>
<td>Autodesk</td>
<td>AutoCAD (.dxf)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Autodesk Maya AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>Filzmoser</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>Progress / EBAW E</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Microsoft</td>
<td>Microsoft Engineering</td>
<td>Project (.xml)</td>
<td>Project (.xml)</td>
</tr>
<tr>
<td>Office</td>
<td>Systems Pty Limited</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Project</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microtran</td>
<td>Bentley</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Midas Gen</td>
<td>MIDAS</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
</tbody>
</table>

Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>ModeSt</td>
<td>Tecnisoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Multiframe</td>
<td>Daystar Software Inc.</td>
<td>AutoCAD (.dxf) Steel Detailing Neutral Format (.sdf,.sdnf)</td>
<td>AutoCAD (.dxf) Steel Detailing Neutral Format (.sdf,.sdnf)</td>
</tr>
<tr>
<td>Nastran</td>
<td>MSC software corporation</td>
<td>AutoCAD (.dwg) IGES (.iges,.igs)</td>
<td>AutoCAD (.dwg) IGES (.iges,.igs)</td>
</tr>
<tr>
<td>NavisWorks</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg) IGES (.iges,.igs)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>NISA</td>
<td>Cranes software international ltd./CSC</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>NX (Unigraph)</td>
<td>Siemens</td>
<td>AutoCAD (.dwg) AutoCAD (.dxf)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>Orion</td>
<td>CSC</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>PDMS</td>
<td>AVEVA</td>
<td>Microstation (.dgn) Steel Detailing Neutral Format (.sdf,.sdnf,.dat) Tekla Collaboration files (.tczip)</td>
<td>Microstation (.dgn) Steel Detailing Neutral Format (.sdf,.sdnf,.dat) Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>PDS</td>
<td>Intergraph /Hexagon</td>
<td>Microstation (.dgn) Steel Detailing Neutral Format (.dat)</td>
<td>Microstation (.dgn) Steel Detailing Neutral Format (.dat)</td>
</tr>
<tr>
<td>PipeCAD</td>
<td>Mc4 software</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------</td>
<td>-------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>PipeDesigner 3D</td>
<td>QuickPen / Trimble</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Planca</td>
<td>Planca Ag / Trimble</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Plant-4D</td>
<td>CEA Technology</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PowerConnect</td>
<td>Buildsoft</td>
<td>Work in progress</td>
<td>Work in progress</td>
</tr>
<tr>
<td>PowerFrame</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Primavera</td>
<td>Oracle</td>
<td>P6 (.xml)</td>
<td>P6 (.xml)</td>
</tr>
<tr>
<td>ProConcrete, ProSteel, ProStructures</td>
<td>Bentley</td>
<td>Steel Detailing Neutral Format (.sdf,.sdnf)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pro/Engineer</td>
<td>PTC</td>
<td>IGES (.iges,.igs)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td></td>
</tr>
<tr>
<td>Prokon</td>
<td>Prokon</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td>QUESTware</td>
<td>QUESTware Corporation</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>RAM (CAD Studio)</td>
<td>Bentley</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISM</td>
<td>ISM</td>
</tr>
<tr>
<td>Revit Architecture/MEP</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td></td>
</tr>
</tbody>
</table>

Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revit Structure</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tekla Collaboration files (.tczip)</td>
<td>Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>RFEM</td>
<td>Dlubal</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Rhinoceros</td>
<td>McNeel North America</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>Geometry Gym link</td>
</tr>
<tr>
<td>RISA-3D (Suite)</td>
<td>Risa Technology</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Robot Millenium</td>
<td>Autodesk</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
</tbody>
</table>

Compatible software 22
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSTAB</td>
<td>Dlubal</td>
<td><a href="#">Direct Link</a> [CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
<td><a href="#">Direct Link</a> [CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[IFC2X3 (.ifc)]</td>
<td>[IFC2X3 (.ifc)]</td>
</tr>
<tr>
<td>SACS</td>
<td>Engineering Dynamics Inc.</td>
<td>[AutoCAD (.dx)]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdnf)</td>
<td></td>
</tr>
<tr>
<td>SAFE</td>
<td>Computers &amp; Structures, Inc.</td>
<td>[AutoCAD (.dwg)]</td>
<td>[AutoCAD (.dwg)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[AutoCAD (.dxf)]</td>
<td>[AutoCAD (.dxf)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
<td>[CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[iges (.iges, .igs)]</td>
<td></td>
</tr>
<tr>
<td>SAM</td>
<td>Bestech Limited</td>
<td>[AutoCAD (.dxf)]</td>
<td>[AutoCAD (.dxf)]</td>
</tr>
<tr>
<td>SAP2000</td>
<td>Computers &amp; Structures, Inc.</td>
<td><a href="#">Direct Link</a> [AutoCAD (.dwg)]</td>
<td><a href="#">Direct Link</a> [AutoCAD (.dwg)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[AutoCAD (.dxf)]</td>
<td>[AutoCAD (.dxf)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
<td>[CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
</tr>
<tr>
<td>SCIA</td>
<td>Nemetschek</td>
<td><a href="#">Direct Link</a> [AutoCAD (.dwg)]</td>
<td>[AutoCAD (.d)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[AutoCAD (.dxf)]</td>
<td>[AutoCAD (.dxf)]</td>
</tr>
<tr>
<td>SDS/2</td>
<td>Design Data</td>
<td>[AutoCAD (.dwg)]</td>
<td>[AutoCAD (.d)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[AutoCAD (.dxf)]</td>
<td>[AutoCAD (.dxf)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
<td>[CIS/2 LPM6 analytical (.stp, .p21, .step)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[CIS/2 LPM6 design (.stp, .p21, .step)]</td>
<td>[CIS/2 LPM6 design (.stp, .p21, .step)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Microstation (.dgn)]</td>
<td>[Microstation (.dgn)]</td>
</tr>
<tr>
<td>S-FRAME</td>
<td>S-FRAME Software Inc.</td>
<td><a href="#">Direct Link</a> [AutoCAD (.dxf)]</td>
<td><a href="#">Direct Link</a> [AutoCAD (.dxf)]</td>
</tr>
<tr>
<td>SketchUp</td>
<td>Trimble</td>
<td>[SketchUp (.skp)]</td>
<td>[SketchUp (.skp)]</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>SketchUp Pro</td>
<td>Trimble</td>
<td>SketchUp (.skp)</td>
<td>AutoCAD (.skp)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Smart 3D (SmartPlant / SmartMarine)</td>
<td>Intergraph / Hexagon</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 design (.stp,.p21,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc), with</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SmartPlant 3D</td>
<td></td>
</tr>
<tr>
<td>Solibri Model Checker</td>
<td>Solibri</td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>SolidEdge</td>
<td>Siemens</td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>SolidWorks</td>
<td>Dassault</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>SPA CE GASS</td>
<td>SPA CE GASS</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td>SpaceClaim</td>
<td>SpaceClaim Co.</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>STAAD.Pro</td>
<td>Bentley</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
<td>CIS/2 LPM6 analytical (.stp,.p21,.step)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------</td>
<td>---------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Steel Smart System</td>
<td>Applied Science International , LLC</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf) ISM</td>
<td>Staad ASCII file (.std) ISM</td>
</tr>
<tr>
<td>StruCAD</td>
<td>AceCAD Software, Inc.</td>
<td>AutoCAD (.dwg) AutoCAD (.dxf)</td>
<td>AutoCAD (.dwg) AutoCAD (.dxf)</td>
</tr>
<tr>
<td>StructureWorks</td>
<td>StructureWorks LLC.</td>
<td>AutoCAD (.dwg) AutoCAD (.dxf) IGES (.iges, .igs) STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>STRUDS</td>
<td>SoftTech</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Tekla BIMsight</td>
<td>Tekla</td>
<td>Tekla BIMsight Project (.tbp)</td>
<td>Tekla BIMsight Project (.tbp) * AutoCAD (.dwg) Microstation (.dgn) IFC2X3 (.ifc) IFCXML (.ifcXML) IFCzip (.ifcZIP)</td>
</tr>
<tr>
<td>Tekla Collaboration</td>
<td>Tekla</td>
<td>Tekla Collaboration files (.tczip)</td>
<td>Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>Trimble LM80 Desktop</td>
<td>Trimble</td>
<td>AutoCAD (.dxf) LM80 (.cnx, .txt)</td>
<td>AutoCAD (.dxf) LM80 (.cnx, .txt)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>TurboCAD</td>
<td>IMSI Design</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp,.step)</td>
<td>STEP AP214 (.stp,.step)</td>
</tr>
<tr>
<td>UniCAM</td>
<td>Unitechnik</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Unigraphics</td>
<td>Siemens PLM</td>
<td>IFC2X3 (.ifc)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>IGES (.iges,.igs)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>VectorWorks</td>
<td>Nemetschek</td>
<td>IFC2X3 (.ifc)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges,.igs)</td>
<td>AutoCAD (.dxf)</td>
</tr>
<tr>
<td>Volo View</td>
<td>Autodesk</td>
<td>AutoCAD (.dwg)</td>
<td>AutoCAD (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AutoCAD (.dxf)</td>
<td>AutoCAD (.dxf)</td>
</tr>
</tbody>
</table>

**See also**

*Compatible formats on page 11*
5 Importing to and exporting from Tekla Structures

Tekla Structures has several tools you can use to import and export physical and reference models and the information they contain.

You can use import and export in Tekla Structures for several purposes:

• You can import 2D or 3D models created by other software, then detail or manipulate the structural objects using Tekla Structures. Once the model is complete, you can export it, and return it to the architect or engineer for review.

• You can create reports from the imported models from most of the formats.

• You can export Tekla Structures models for use in Analysis & Design (several formats). Then you can import the Analysis & Design results back to the Tekla Structures model.

• Various model transfers can be completed for the engineering and contractor phase of the project.

• You can import shapes from many formats. Shapes are used in defining items.

• You can export data for use in manufacturing information systems and in the fabrication phase:
  • You can export CNC data (Computer Numerical Control) for use by automated cutting, drilling and welding CNC machinery.
  • You can export to MIS (Manufacturing Information Systems) so that fabricators can track project progress, for example.
Conversion files map Tekla Structures profile, twin profile, and material names with names used in other software. Conversion files are simple text files, containing the Tekla Structures name in the first column, and the name used in the other software package in the second column. Columns are separated by a space. All parametric profiles must be entered in the profile conversion file.

You can use the same conversion file both when importing and exporting models, and you can specify the location of conversion files in most of the import and export tools.

If you enter a conversion file name without a path, Tekla Structures searches for the file in the current model folder. If you leave the box empty, Tekla Structures searches for the file indicated by the advanced option XS_PROFDB in Tools --> Options --> Advanced Options... --> File Locations. This is also the case, if the tool does not allow you to define the path and conversion file.

Tekla Structures has several conversion files in the standard installation, and you can also create your own. Standard conversion files are located in the \environments \<environment>\profile folder. All conversion files have the .cnv extension.
6.1 Twin profile conversion files

Tekla Structures contains separate conversion files for twin profiles, and it reads the twin profile conversion file before the profile conversion file, so you must include the profiles from the original model in the import.

The twin profile conversion file is a text file containing the profile prefix (characters only) and the distance between the profiles in mm, separated by a space. Tekla Structures converts all profiles with the specified prefix to twin profiles.

The twin profile conversion file could be named `twin_profiles.cnv` and it could contain lines such as the one below:

```
DL 20
```

The distance between the profiles is the same for all profiles with the same profile prefix. For example, profiles with the prefix DL will always have the same spacing. If you want different spacing values, then you need to use a different profile prefix.

You also need to add the twin profile to the profile conversion file to get the DL profile converted to L-profile:

```
L200*20 DL200/20-20
```

Limitations

- Twin profile conversion cannot be used for profiles that start with a number. This means that you cannot define double angles as 2L. Instead, you need to use DL as the prefix for a twin profile, for example: `DL200/20-20`.

- Twin profile conversion does not work for FEM import. We recommend that each angle is modeled separately rather than as twin profiles, as SP3D does not control the gaps between members in the same way as Tekla Structures and there are, for example, various conversion and mapping difficulties. It is easier to convert members that are modeled as two members.

See also

Conversion files on page 28
Creating conversion files on page 29
6.2 Creating conversion files

You can create your own conversion files if the ones that come with Tekla Structures installation do not suit your needs.

To create a new conversion file:

1. Open an existing conversion file using any standard text editor that does not contain any special characters.

By default, conversion files are located in \ProgramData\Tekla Structures\<version>\environments\<environment>\profil.

2. Save the file with another name.

If the export/import tool allows you to define the path to the conversion file, you can save the file where you like. If this is not the case, save the file in a location defined by the advanced option XS_PROFDB in Tools --> Options --> Advanced Options --> File Locations.

3. Modify the file: enter profile names recognized by Tekla Structures in the first column, and the corresponding name recognized by the other software in the second column.

While modifying, ensure that:

• You do not have blank material definitions (" ", empty quotation marks).
• You do not have spaces in the profile position strings. For example, enter "Hand_Rail" not Hand_Rail".

4. Save your changes.

NOTE

• All the three files (profile, twin profile and material) are not needed if the differences in the profile name is just concerning * X or x formats, because these are normally handled automatically. For example, if you wanted to import UC254x254x73 to be UC254*254*73, the lower case "x" is automatically changed to "X" so the format of the conversion file would be UC254*254*73 254X254X73.

• If you have problems importing the model, check any error messages in the Tekla Structures log file, and check the conversion files.

Example

Below are some examples of conversion files:

! Profile name conversion Tekla Structures --> SDNF

! If Converted-name does not exist, it will be the same

! as Tekla Structures-name.

! Tekla Structures-name Converted-name
Profile name conversion Tekla Structures -> DSTV

If Converted-name does not exist, it will be the same as Tekla Structures-name.

Below there is first an example of an incorrect conversion file and then of a correct one, errors are highlighted:

Incorrect conversion:
```
00100782 4 0 2 "brace" "Tread 4" 1 "TREAD4.5" "" 0.000000 0 0
0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0
```

Correct conversion:
```
00100782 4 0 2 "brace" "Tread_4" 1 "TREAD4.5" "A36" 0.000000
0 0 0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
```

Conversion files
Creating conversion files
Reference models

A reference model is a file that helps you to build a Tekla Structures model. A reference model is created in Tekla Structures or another software or modeling tool and imported to Tekla Structures. For example, an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model can be used as a reference model. Reference models can also be simple 2D drawings that are imported and then used as a layout to directly build the model on. You can snap to reference model geometry.

Tekla Structures loads reference models only when they are needed, not every time you open a model. Tekla Structures does not save the reference model when you save the current model, but it saves the link to the reference model. The filename extension of a saved reference model properties file is .rmip.json. The values of Code, Title, Phase and Description cannot be saved in the standard properties file.

The following file types are supported:

- AutoCAD files .dxf
- AutoCAD files .dwg (supported version ACAD2014 and earlier)
- Cadmatic files .3dd
- IFC files .ifc, .ifczip, .ifcxml
- IGES files .igs, .iges
- LandXML files .xml
- MicroStation files .dgn, .prp
- PDF files .pdf
- Tekla Collaboration files .tczip
- SketchUp files .skp (supported version SketchUp 2014 and earlier)
- STEP files .stp, .STEP
- Tekla Collaboration files .tczip

Some reference models are automatically subdivided or split into reference model objects.

**TIP** You can disable the roll-over highlight, which should speed up zooming.
7.1 Inserting a reference model

To insert a reference model in a Tekla Structures model:

1. Open a Tekla Structures model where you want to insert the reference model.
2. Open the Reference Models list by clicking the Reference Models button in the upper-right corner of the Tekla Structures main view.
3. Click Add model.
4. If you have any previously created reference model properties files, load the desired file by selecting the file from the list at the top.
5. Browse for the reference model file by clicking Browse next to the Files box. You can also drag reference models from Windows Explorer. You can insert several models at a time.
6. Select a group for the model or enter the name of the group, if it is a new group. You can also drag models to an existing group later on, or create a new group.
7. Select a Coordinate system, which determines whether the model is inserted relative to model origin or work plane.
8. Select where you want to place the reference model. You can use coordinates or pick a position for the reference model origin. The origin is displayed as a handle.
9. Set the scale of the reference model if it is different from the one in the Tekla Structures model (for example, if it uses different measurement units). Set the scale for a DWG or a DXF file already in AutoCAD. When you define the measurement unit for a DWG or a DXF file and save the file in AutoCAD, the unit is recognized in Tekla Structures and the reference model is scaled correctly.
10. You can rotate the model around model Z axis by entering the desired value in the **Rotation** box.

11. Click **More** to show more details and add the **Code**, **Title**, **Phase** and **Description** of the reference model.

   The code could be a site number, project number, or accounting number. Write the description according to the company conventions. The phase is the revision phase of the reference model (not the phase in the Tekla Structures model).

   Below is an example of these details when you inquire the reference model.

<table>
<thead>
<tr>
<th>Group</th>
<th>: Basement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>: 123456</td>
</tr>
<tr>
<td>ref_description</td>
<td>: Basement</td>
</tr>
<tr>
<td>Title</td>
<td>: First phase</td>
</tr>
<tr>
<td>RevisionPhase</td>
<td>: 1a</td>
</tr>
</tbody>
</table>

   You can also modify all the details after you have inserted the model.

12. Click **Add model**.

   The reference model is inserted in the current phase of the Tekla Structures model.

13. If the inserted reference model lies outside the work area and is not fully or at all visible in the model view, Tekla Structures displays the “Objects outside the work area” warning message. Click **Expand** to extend the work area to see the reference model in the model view.

**NOTE** Do not import the same reference model to the Tekla Structures model several times. If there are duplicate reference models, there are also duplicate GUIDs.

   When you want to update the reference model, do not delete the old reference model from an open Tekla Structures model and replace it with a new one, because then you would lose the work done on reference objects in the old model. Use the change detection functionality instead.

See also

*Modifying reference model details on page 38*

### 7.2 Viewing reference models

There are many ways you can select what you want to show about the reference models and how.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the <strong>Reference Models</strong> list</td>
<td>• Click the <strong>Reference Models</strong> icon in the upper-right corner of the Tekla Structures main view.</td>
</tr>
</tbody>
</table>

Reference models 35 Viewing reference models
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| Hide and show reference models | • Click the eye icon next to the model you want to hide.  
The icon changes to and the reference model is hidden in the 3D view.  
• Click the eye icon again to show the model. |
| Hide and show a group of reference models | • Click the eye icon next to the group you want to hide. The group eye icon and the reference model eye icons all change to and all the reference models included in the group are hidden in the Tekla Structures model.  
• Click the eye icon again to show all the models in the group.  
• If a group contains both hidden and visible models, the eye icon for the group looks like this |
| Highlight the reference model in the 3D view | • Click the reference model in the Reference Models list. |
| Show reference model details | • Double-click the reference model in the Reference Models list. |
| Show reference model object details | 1. Double-click the reference model in the Reference Models  
2. Ensure that the Select assemblies selection switch (for assemblies) or Select objects in assemblies (for parts) is active.  
3. Point the reference model, hold down Shift and scroll to the hierarchy level where the desired reference model object is located.  
4. Point the object and double-click it to open the reference model object details. |
| Rotate the reference model around model Z axis. | Enter the desired value in the Rotation box. |
| Hide and show reference model layers | 1. Double-click the reference model in the Reference Models list to open the details.  
2. Click the small arrow on the Layers row to show the list of layers. |
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. You can show and hide individual layers or all layers:</td>
<td>3. You can show and hide individual layers or all layers:</td>
</tr>
<tr>
<td>• To hide all layers, click the eye icon on the Layers row.</td>
<td>• To hide all layers, click the eye icon on the Layers row.</td>
</tr>
<tr>
<td>• To hide individual layers, click the eye icons of the individual layers.</td>
<td>• To hide individual layers, click the eye icons of the individual layers.</td>
</tr>
<tr>
<td>• To hide several layers, holding down Ctrl, click the desired layers and then click the eye icon of one of the selected layers.</td>
<td>• To hide several layers, holding down Ctrl, click the desired layers and then click the eye icon of one of the selected layers.</td>
</tr>
<tr>
<td>• If the Layers list contains both hidden and visible layers, the eye icon for the Layers row looks like this .</td>
<td>• If the Layers list contains both hidden and visible layers, the eye icon for the Layers row looks like this .</td>
</tr>
<tr>
<td>• If you hide all layers, the eye icon for the Layers row changes to .</td>
<td>• If you hide all layers, the eye icon for the Layers row changes to .</td>
</tr>
<tr>
<td>• If you hide individual layers, the eye icon for the hidden layers changes to .</td>
<td>• If you hide individual layers, the eye icon for the hidden layers changes to .</td>
</tr>
<tr>
<td>Detect changes in the reference model</td>
<td>1. Double-click the reference model in the Reference Models list to open the details.</td>
</tr>
<tr>
<td>2. Click the small arrow on the Change detection row to open the Change detection section.</td>
<td>2. Click the small arrow on the Change detection row to open the Change detection section.</td>
</tr>
<tr>
<td>3. Browse for an older version of the reference model and click the buttons to select what you want to show (Inserted, Changed, Unchanged, Deleted).</td>
<td>3. Browse for an older version of the reference model and click the buttons to select what you want to show (Inserted, Changed, Unchanged, Deleted).</td>
</tr>
<tr>
<td>4. Click Apply.</td>
<td>4. Click Apply.</td>
</tr>
<tr>
<td>Update all reference models</td>
<td>• Open the Reference Models list and click theRefresh button .</td>
</tr>
<tr>
<td>All models that are not up to date are reloaded. If a reference model is not found, a warning sign is displayed.</td>
<td>All models that are not up to date are reloaded. If a reference model is not found, a warning sign is displayed.</td>
</tr>
<tr>
<td>Update a single reference model</td>
<td>1. Double-click the reference model in the Reference Models list to open the details.</td>
</tr>
<tr>
<td>2. Click the Refresh button .</td>
<td>2. Click the Refresh button .</td>
</tr>
</tbody>
</table>
To: View user-defined attributes  

Do this:  
The model is reloaded. If the reference model is not found, a warning sign ⚠️ is displayed.

1. Double-click the reference model in the Reference Models list to open the details.
2. Click the small arrow on the User-defined attributes row to show the list of user-defined attributes.
3. The user-defined attributes that are specified for reference models in the objects.inp file are listed in the User-defined attributes list. Enter or select a value from the list. By default, the objects.inp is located in ..\ProgramData\Tekla Structures <version>\environments\common\inp. You may also have some objects.inp files that you modify and keep in firm or project folders. These files are read in certain order.

See also

Modifying reference model details on page 38  
Reference model objects on page 41  
Examining reference model hierarchy and modifying reference model objects on page 41  
Detecting changes in a reference model on page 39  
Locking reference models on page 39

7.3 Modifying reference model details

After you have inserted a reference model, you can modify its details.

Limitation: Coordinates given in the Details area are always relative to model coordinates. You can modify the coordinate system only if model coordinate system is used in the reference model.

To modify reference model details:
1. In the Reference Models list, double-click the reference model.
2. Change the desired details:
   - Change Code, Title, Phase and Description of the reference model.
• Click the arrow on the Details row. In Details, you can change the reference model File, the model Group, Origin, and Scale.

• Click the arrow on the User-defined attributes row, and enter values for the user-defined attributes.

You may enter strings (texts), select dates or enter numeric information depending on the type of the user-defined attribute. The reference model user-defined attributes are defined in their own section in the objects.inp file. If you have several objects.inp files, they are read in a specific reading order, for more information, see Customizing user-defined attributes.

3. Click Modify. The changes that you made are implemented in the reference model.

See also
Inserting a reference model on page 34

7.4 Locking reference models

You can prevent reference models from moving and from detail updates.

To lock a reference model:

1. Move your mouse over the desired reference model in the Reference models list.

   The Lock icon is displayed.

2. Click the Lock icon.

   Now the reference model is locked. You can only add values for user-defined attributes and work with layers, but you cannot modify the details in any other way or move the model.

   To unlock the reference model, click the Lock icon again.

See also
Reference models on page 33
Modifying reference model details on page 38
7.5 Detecting changes in a reference model

Reference models are often updated, and sometimes the changes are not documented. You can check the changes between the old and the new reference model in Tekla Structures by using the Change detection feature.

Change detection works with the following file formats:

- .ifc
- .ifcxml
- .ifczip
- .tczip

To view changes in the reference model:

1. Double-click the reference model in the Reference Models list.
2. Open the Change detection list by clicking the arrow on the Change detection row.
3. Browse for a previous version of the reference model.
4. Ensure that both models are visible. Comparison is active only when both of the eye icons are in visible state.
5. Select any of the check boxes for the following options: Changed, Unchanged, Inserted and/or Deleted.
6. Click Update view. For example, select Deleted to show with red color the objects that were deleted between the two versions.

See also

Inserting a reference model on page 34

7.6 Examining reference model contents

You can examine the contents of a reference model. This is something you might want to do after importing a reference model into Tekla Structures.

To examine the contents of a reference model:
1. Click Tools --> Inquire --> Object.

2. In your Tekla Structures model, click the reference model you want to examine.

   The contents of the reference model are listed in the Inquire Object dialog box.

See also

   Inserting a reference model on page 34

7.7 Reference model objects

Some types of reference models are automatically subdivided into reference model objects, which is an individual part of an imported reference model. You can define user-defined attributes separately for each reference model object and use them for reports and the view and selection filters. They can also be moved to a Tekla Structures model that is currently being worked on. Information included in a reference model object can be saved in the model database.

The reference model objects are read-only.

Whether the reference model supports splitting depends on the file format and file structure. .ifc models are always automatically subdivided. .dwg files that include any of the following objects, are also automatically subdivided:

- block table
- polyface mesh
- polygon mesh
- proxy object (for example, ADT)
- ACIS objects (3DSolid, Body, Region)

The file formats .dgn, .prp, .skp, .step, and .iges are not subdivided.

See also

   Reference models on page 33

7.8 Examining reference model hierarchy and modifying reference model objects

You can view the reference model hierarchy and check which objects are on which hierarchy level. You can also add user-defined attributes to the reference model objects. The added properties can be used for filtering, for example. Additionally, you can view the native reference object attributes and properties.

To examine and modify reference model objects:
1. Ensure that the **Select assemblies** selection switch (for assemblies) or **Select objects in assemblies** selection switch (for parts) is active.

2. Point the reference model, hold down **Shift** and scroll using the middle mouse button to the hierarchy level where the reference object is. Notice that if the cursor is too close to a grid, the hierarchy is not scrolled.

3. Do any of the following:
   - To inquire the native reference object properties and attributes, click the object, right-click and select **Inquire** from the pop-up menu.
   - To view or modify the user-defined attributes of a reference object, point the object and double-click it to open the reference model object details.

**TIP** There are many more commands available for the selected reference model object. Check rest of the commands on the pop-up menu.

Below is an example of a reference model representing a sanitary system. When you want to scroll the hierarchy, the selection switch **Select assemblies** or **Select objects in assemblies** must be on. The 0 level IfcProject in the example is the upmost level.

Below you can see one of the reference objects on the 3 level, IfcBuildingStorey, of the same reference model.
The last level, level 4, shows the individual parts.
In the example below, one of the reference objects on the lowest level has been inquired.
7.9 Reference model assemblies

Imported IFC reference models can contain assemblies. You can select reference model assemblies in the model view and view assembly level information in Tekla Structures.

- You can add user-defined attributes to reference model assemblies.
- You can use the Inquire command to view information on reference model assemblies. For example, you can view GUIDs of child objects.
• You can create reports to view information on reference model assemblies.

See also
IFC stands for Industry Foundation Classes, the set of internationally standardized object definitions for use in the construction industry. IFC is developed as an open standard by buildingSMART.

IFC offers a high-level common language for the sharing of intelligent objects, such as building elements, between disciplines across the building life cycle. The principal benefit of IFC is the object description – not only does the IFC protocol preserve the full geometric description in 3D, but it also knows its location and relationships, as well as all the properties (or parameters) of each object.

See also
IFC import on page 47
IFC export on page 59

8.1 IFC import
You can import IFC models as reference models to Tekla Structures, and optionally convert the imported IFC objects into native Tekla Structures objects by using the IFC object converter. You can use imported IFC models, for example, in clash checking, reporting and scheduling.

Tekla Structures supports the following IFC schemas:

- IFC2X2
- IFC2X3 (recommended)

The IFC import functionality has the IFC certification granted by buildingSMART international http://www.buildingsmart.org/compliance/certified-software/.
The IFC import functionality in Tekla Structures supports all the sub-objects of the IfcBuildingElement class and sub-objects of the IfcProduct class including:

- Architectural entities
- Structural entities
- Building services entities

IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed (.ifcZIP) or uncompressed import files.

See also

Inserting a reference model on page 34
IFC object converter on page 48

**IFC object converter**

You can convert most linear IFC objects such as beams, columns, and braces into native Tekla Structures objects. Also plates, slabs, footings and walls can be converted.

The purpose of converting IFC objects in Tekla Structures is to help in the creation of the structural model and to avoid rework in an early modeling phase. For example, use an architectural model as a basis for the structural model and for further detailing. If the architect modifies the architectural model later, you cannot merge the changes between the models.

In Tekla Structures reference model objects can be used in a way similar to the native objects, for example, in clash detection, reporting and scheduling. There is no need to have everything as native, because the reference model objects can also be used in many ways. For example, reference model objects can be shown in drawings and they can be listed in reports beside the data of native objects.

See also

Converting IFC objects into native Tekla Structures objects on page 49
Limitations in IFC object conversion on page 50
Defining the settings for profile mapping of IFC objects on page 50
Checking the profile and material of converted objects on page 52
Copying IFC object properties to the user-defined attributes of converted objects on page 52
Displaying catalog and mapping files of converted objects on page 53
Creating reports of converted IFC objects on page 54

Converting IFC objects into native Tekla Structures objects

Before converting IFC objects, check that the profiles and units in the IFC model are compatible with the environment you are using.

To convert IFC objects into native Tekla Structures objects:

1. Select the IFC objects you want to convert.
   - Ensure that the **Select objects in assemblies** or **Select objects in components** switch is active when selecting the objects.
2. Click **Tools** --> **Convert IFC objects**.
3. Click **Settings** to open the **IFC object converter settings** dialog box.
4. Define the settings for conversion as required.
   - To create a report of the converted IFC objects automatically after the conversion, select **Create report after conversion**.
   - To convert B-rep objects into Tekla Structures objects, select **Convert Brep object**.
     After conversion B-rep objects are either items or concrete items and they are added to the shape catalog. The items belong to class 996.
   - To set the reference lines of beams to top flange, select **Set handles to top flange**.
     If **Set handles to top flange** is not selected, the reference lines of beams are located in the middle of the beams.
   - Define the settings for profile mapping.
     See **Defining the settings for profile mapping of IFC objects on page 50** to find out more.
   - If needed, copy properties from an IFC object property set.
     See **Copying IFC object properties to the user-defined attributes of converted objects on page 52** to find out more.
5. Click **Check** to check the profile and material of the objects that you want to convert.
   See **Checking the profile and material of converted objects on page 52** to find out more.
6. Click **OK** in the **IFC object converter settings** dialog box.
7. Click **Convert**.
Tekla Structures creates native Tekla Structures objects. The **Conversion Result Summary** is displayed in the **Convert IFC objects** dialog box showing the conversion result and possible errors.

The original IFC reference model objects are also kept as such. We recommend that you always check the results of the conversion, for example, by viewing the conversion report.

**See also**
- Limitations in IFC object conversion on page 50
- Creating reports of converted IFC objects on page 54
- Example: Converting IFC objects into Tekla Structures objects on page 55

**Limitations in IFC object conversion**

Tekla Structures is dependent on the quality of the IFC model, because it uses information available in the model when converting objects.

Tekla Structures converts most linear IFC objects to native Tekla Structures objects. You can also convert double type UDAs.

The following limitations exist in IFC object conversion:

- If the target IFC model does not comply with standard, it might not be converted as expected.
- Only IFCBuildingElement and IFCDiscreteAccessory and their sub types are supported.
- Only SweptSolid, Brep, CSG and Clipping representations are supported.
- Multiple representations for one object are not supported.
- Profile offset is not supported.
- Profiles with more than 99 polygon points are not converted correctly.
- In rare cases, chamfers may be converted incorrectly.

**See also**
- Converting IFC objects into native Tekla Structures objects on page 49
- Creating reports of converted IFC objects on page 54
Defining the settings for profile mapping of IFC objects

Tekla Structures checks IFC object profiles against the profiles in the Tekla Structures profile catalog by comparing profile names or dimensions. You can choose which of the two methods is primarily used in mapping.

You can define profile mapping settings for parametric and arbitrary profiles.

To define profile mapping settings:
1. Click **Tools --> Convert IFC objects --> Settings** to open the IFC object converter settings dialog box.
2. Do one of the following:
   - To map profiles primarily by comparing the profile names between the IFC model and Tekla Structures profile catalog, select **Profile name** in the Primary profile mapping area.
   - To map profiles primarily by comparing the object dimensions, select **Dimensions** in the Primary profile mapping area.

   If **IFC object converter** cannot map profiles with the primary method, it applies the secondary method.

   3. If needed, enter tolerance values for dimension comparison. The unit of measurement is based on the environment.

      The \( r \) value affects only rectangular hollow profiles and it is used to distinguish hot rolled profiles from cold rolled profiles.

   4. Click **OK**.

Conversion logic

Parametric profile used in IFC model (Full data set):
1. If profile with same name is found from Tekla Structures **Profile Catalog**, it will be used.
2. Otherwise, Tekla Structures checks parameter values to find a corresponding profile. If found, that will be used.

Arbitrary profile used in IFC model (Limited amount of data):
1. If the object is not a linear member, an object with profile will be created.
2. If the shape is detected and found from Tekla Structures catalog, that profile will be used. The shape detection supports the standard types of hot rolled profiles.

3. Otherwise, a new profile is created.

B-rep geometry used in IFC model (Shape data only):
1. If corresponding item exits in Tekla Structures model, it is used.
2. Otherwise, a new item will be created and used.

**Checking the profile and material of converted objects**

Before you convert IFC objects into native Tekla Structures objects, you can check their profile and material to ensure that the conversion will be successful.

**IFC object converter** checks the profile information for the boundary representation (B-rep) geometry only.

To check the profile and material of converted objects:
1. Click **Tools** --> **Convert IFC objects** --> **Settings** --> **Check**.
   - If there are any missing profiles or materials, Tekla Structures displays them on the **Missing Profiles** and **Missing Materials** tabs in the **Missing Mapping** dialog box.
2. Select an appropriate option in the Tekla Structures profile and Tekla Structures material lists to define a mapping for the missing profiles or materials.
   - The mapping of profiles works for IFC data that has a profile name but does not include enough information for conversion.
   - You can change your mappings later if needed.
3. Click **Update Mapping Catalogs and Close**.

**NOTE** You can also map profiles and materials by modifying the .txt files in any standard text editor. The files are in the attributes folder under the model folder. The changes take effect when you restart **IFC object converter**.

- **MappedMaterials-default.txt** maps the materials and **MappedProfiles-default.txt** maps the profiles. The maps are used in conversion only if the profiles are not found from Tekla Structures catalogs.
Copying IFC object properties to the user-defined attributes of converted objects

You can copy properties from the IFC object property sets to the user-defined attributes of converted Tekla Structures objects.

To copy properties from an IFC object property set:

1. Go to Tools --> Convert IFC objects.
2. Click Settings.
   
   The IFC object converter settings dialog box opens.
3. Click Add to add rows.
4. Enter the name of the property to the Property cell.
5. Enter the name of the user-defined attribute to the UDA cell.
   
   The maximum length of the user-defined attribute name is 20 characters.
6. Click Type to select the format of the attribute.
   
   The possible formats are string, integer or double.
7. Click OK to save the settings.

If you have selected the Create report after conversion check box, a report is created after the conversion based on the converted objects.

NOTE When you add the user-defined attribute to the objects.inp file, ensure that the attribute name is unique.

Enter the original name of the user-defined attribute, not the translation.

See also

Displaying catalog and mapping files of converted objects

You can display the catalog and mapping files of converted objects in the .txt format. When you do this, you can also modify the .txt files and, for example, add more profiles in the catalogs manually if needed.

To display the catalog and mapping files of converted objects:

• Click Tools --> Convert IFC objects --> Settings --> Catalogs.

   Tekla Structures opens the profile and material catalogs and mapping files for profiles and catalogs in .txt format. The files are available in the attributes subfolder of the model folder.

See also
Creating reports of converted IFC objects

You can create reports of the IFC objects that have been converted into native Tekla Structures objects.

To create a report of the converted IFC objects, click Report in the Convert IFC objects dialog box.

**TIP** Tekla Structures creates a report of the converted IFC objects automatically after the conversion when you have selected the check box next to the Create report after conversion option in the IFC object convertor settings dialog box.

When you select an item in the report, the related object is selected in the model.

The created report is in IFC-converted.txt in the Report folder under the model folder.

If you need to modify the report template, modify IFC-converted.rpt in the ... \environments\common\system\Mark folder.

Limitations

Sometimes the input data in the IFC model is not adequate to successfully create the converted object. The status of the converted object is reported in the Info box in the report with the Class value.

<table>
<thead>
<tr>
<th>Class value</th>
<th>IFC object data</th>
<th>Converted object description</th>
</tr>
</thead>
<tbody>
<tr>
<td>990</td>
<td>Parametric profile with a name</td>
<td>There is enough information in the IFC model to convert the object successfully.</td>
</tr>
<tr>
<td>991</td>
<td>Parametric profile without a name</td>
<td>Tekla Structures determines the name of the object based on the object's profile.</td>
</tr>
<tr>
<td>992</td>
<td>Arbitrary profile with a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.</td>
</tr>
<tr>
<td>993</td>
<td>Arbitrary profile without a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model. The profile name is set to UNKNOWN.</td>
</tr>
<tr>
<td>994</td>
<td>Brep piece with a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.</td>
</tr>
<tr>
<td>995</td>
<td>Brep piece without a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model The profile name is set to UNKNOWN.</td>
</tr>
</tbody>
</table>
Class value | IFC object data | Converted object description
--- | --- | ---
996 | Brep piece | The object is converted using the **Convert Brep object** option in converter settings. The converted Brep object is either an item or a concrete item and is added to the shape catalog.

**Example**

Below is a report of converted parts.

```
<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Profile</th>
<th>Initial profile</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>760</td>
<td>STRIP_FOOTING</td>
<td>1800*1800</td>
<td>1800*1800</td>
<td>994</td>
</tr>
<tr>
<td>743</td>
<td>STRIP_FOOTING</td>
<td>1000*1000</td>
<td>1000*1000</td>
<td>994</td>
</tr>
<tr>
<td>1455</td>
<td>COLUMN</td>
<td>HEA300</td>
<td>HEA300</td>
<td>994</td>
</tr>
<tr>
<td>1445</td>
<td>COLUMN</td>
<td>HEA300</td>
<td>HEA300</td>
<td>994</td>
</tr>
<tr>
<td>1437</td>
<td>COLUMN</td>
<td>HEA300</td>
<td>HEA300</td>
<td>994</td>
</tr>
<tr>
<td>1428</td>
<td>COLUMN</td>
<td>HEA300</td>
<td>HEA300</td>
<td>994</td>
</tr>
<tr>
<td>1476</td>
<td>BEAM</td>
<td>IPE300</td>
<td>IPE300</td>
<td>994</td>
</tr>
<tr>
<td>1464</td>
<td>BEAM</td>
<td>IPE300</td>
<td>IPE300</td>
<td>994</td>
</tr>
</tbody>
</table>
```

**See also**
Example: Converting IFC objects into Tekla Structures objects

In this example, you use an IFC model as a basis for your structural model. You will convert the beams and columns into native Tekla Structures objects.

To convert the IFC model’s beams and columns into native Tekla Structures objects:

1. Hide irrelevant IFC layers.
   a. Click the **Reference Models** icon.
   b. In the **Reference Models** list, double-click the reference model to open the details.
   c. Open the **Layers** list by clicking the down arrow on the right.
   d. Hide the necessary layers by clicking the eye icon next to the layer.

<table>
<thead>
<tr>
<th>Layers</th>
</tr>
</thead>
<tbody>
<tr>
<td>fans</td>
</tr>
<tr>
<td>M-HVAC-DUCT</td>
</tr>
<tr>
<td>ventilation</td>
</tr>
</tbody>
</table>

Tekla Structures shows only the layers you selected to show.
2. Select all visible IFC objects.
3. Click **Tools --> Convert IFC objects**.
   The **Convert IFC objects** dialog box opens.
4. Check the profiles and materials of the IFC objects.
   a. Click **Settings**.
   b. Click **Check**.
      Tekla Structures lists the missing profiles and materials.
   c. View the **Missing Profiles** and **Missing Materials** tabs.
      Tekla Structures lists a missing reference part material **Concrete Block**.
   d. Select **CONCRETE_UNDEFINED** from the list.

   ![Concrete Block Missing Material](image)

   e. Click **Update Mapping Catalogs and Close**.
      a. Click **OK** in the **IFC object converter settings** dialog box.
5. Click **Convert**.
Tekla Structures converts the objects and opens the conversion report.

---

**TEKLA STRUCTURES CONVERTED PARTS**

<table>
<thead>
<tr>
<th>ID</th>
<th>NAME</th>
<th>Profile</th>
<th>Initial Profile</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id: 124779</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124782</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124785</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124788</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124791</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124794</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124797</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124800</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124803</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124806</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124809</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
<tr>
<td>Id: 124812</td>
<td>BEAM</td>
<td>W610X82</td>
<td>W610X82</td>
<td>992</td>
</tr>
</tbody>
</table>

The **Class** for all the converted objects is 992. That means that the profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.

6. Check the conversion results.
   - Read the conversion report. Select objects in the conversion report to highlight them in the model.
   - Compare the converted objects with the IFC objects.
   - Use the **Inquire object** command to view detailed information on objects.
Below is an image of converted beams and columns.

8.2 IFC export

You can export Tekla Structures models as IFC models.

You can export all basic parts in the Tekla Structures model such as beams, columns, braces, slabs, panels, plates, reinforcing bars, and bolts with nuts and washers.

The IFC export functionality in Tekla Structures supports the IFC2X3 schema. The IFC export functionality has the IFC certification granted by buildingSMART international http://www.buildingsmart.org/compliance/certified-software/.

See also

Converting IFC objects into native Tekla Structures objects on page 49
IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed (.ifcZIP) or uncompressed import files.

**See also**

- Defining the IFC entity for the exported model objects on page 61
- Exporting a Tekla Structures model into an IFC file on page 62
- Checking the exported IFC model on page 64
- IFC Export type settings on page 64
- IFC base quantities on page 65
- Tekla Structures model objects and related IFC entities on page 65
- Color of the exported IFC objects on page 66
- Property sets in IFC export on page 67
- Defining additional property sets using the Property Set Definitions tool on page 68
- Property set configuration in XML on page 70

**Defining the IFC data for the exported model on a project level**

Before you export your model, you can define geographic coordinates and default spatial hierarchy for the resulting IFC model.

To define the IFC data for the exported model on a project level:

1. Click **File --> Project Properties...**
2. Enter a name for the project if needed.
   
   The project name is the IFC project name in the exported IFC model.
3. Click **User-defined attributes...** in the **Project Properties** dialog box.
4. On the IFC export tab, enter values for spatial hierarchy in IFC site name, IFC building name and IFC building storey name as needed.

The spatial hierarchy entered in the Project’s user-defined attributes is default for model objects in the project. You can enter specific IFC building name and IFC building storey name values for model objects in the objects’ user-defined attributes.

5. On the Geo coordinates tab, enter values for geographic coordinates as needed.

6. Click OK.

7. Click OK.

See also
Defining the IFC entity for the exported model objects on page 61
Exporting a Tekla Structures model into an IFC file on page 62

Defining the IFC entity for the exported model objects

Before you export Tekla Structures model objects to IFC, you can define the resulting IFC entities for the exported model objects by using user-defined attributes.

To define IFC entities for exported model objects:

1. Double-click an object, for example a column, to open the part properties dialog box, and click the User-defined attributes button.

2. On the Parameters tab, set Load bearing to Yes, if you want to define the user-defined attribute LOAD_BEARING for the exported object.

   Yes is the default value. Set this option to No for all non-load bearing objects.

3. On the IFC export tab, select an option in the IFC entity list to define the IFC entity for the exported model object.

   Below is an example list for entities available for a column:

   Auto
   None
   IfcBeam
   IfcColumn
   IfcWall
   IfcBuildingElementPart
   IfcSlab
   IfcPlate
   IfcFootings
   IfcPile
   IfcRailing
   IfcBuildingElementProxy
   IfcMember
   IfcDiscreteAccessory

4. Select Auto or Brep in the IFC export type list:
The Auto option will select the kind of Swept Solid IFC object that a Tekla object becomes in the IFC.

If Auto fails for some reason (such as with a deformation), the export reverts to Brep automatically, and creates a mesh-based IFC object with less intelligence. These objects are data heavy but still geometrically correct.

Brep will force the IFC object to be mesh based in every case.

5. Enter names in the IFC building name and IFC building storey name boxes to define the spatial structure in the IFC model, if needed.

6. Click OK in the user-defined attributes dialog box.

7. Click OK in the part properties dialog box.

See also
Tekla Structures model objects and related IFC entities on page 65
Defining the IFC data for the exported model on a project level on page 60

Exporting a Tekla Structures model into an IFC file

Before you start:
- Define the IFC entities for the Tekla Structures model objects. For more information, see Defining the IFC entity for the exported model objects on page 61.
- Ensure that the work plane is in the desired location. Tekla Structures exports the IFC file using the work plane origin. For more information, see Changing the coordinate system of the exported IFC file on page 63.

To export a Tekla Structures model into an IFC file:
1. Select the model objects to export.
   If you want to export all, you do not have to select anything.
2. Click File > Export > IFC.
3. Browse for the Output file location and replace the name out with the desired file name.
   IFC files are by default exported to the \IFC folder under the model folder. The length of the file path is limited to 80 characters. You do not need to enter the file name extension, it will be automatically added according to the File format.
4. Select the File format.
   The formats are IFC, IFC XML, zipped IFC, and zipped IFC XML.
5. Select the Export type.
   - Surface geometry is ideal for design coordination and viewer type of use.
• **Coordination view 2.0** is recommended for software that has the Coordination view 2.0 import certificate, and for Tekla BIMsight when your model contains reinforcement.

• **Steel fabrication view** is recommended for exporting detailed information on steel objects for steel fabrication.

• For more information about the export types, see [IFC Export type settings on page 64](#).

6. You can define additional property sets for IFC export:

   • To define a new property set, select `<new>` and click **Edit**.
   
   • To use an additional property set created earlier, select the property set from the **Additional property sets** list.

   For more information about the additional property sets, see [Defining additional property sets using the Property Set Definitions tool on page 68](#).

7. Select either **Selected objects** or **All objects** to define the object selection for the export.

8. On the **Advanced** tab, select **Assemblies**, **Bolts**, **Welds**, **Pour Objects**, **Reinforcing bars**, **Surface treatments** and **Grids** in the **Object types** area to export the corresponding objects.

   When you select **Pour Objects**, cast in place concrete parts are exported as pour objects.

   When you export **Assemblies**, you can exclude single part assemblies by selecting **Exclude single part assemblies**.

9. Select **Base quantities** to include in the exported IFC model a **Quantity takeoff add-on view** containing additional information on the entities in the exported IFC model.

   For more information about the base quantities, see [IFC base quantities on page 65](#).

10. Select either **Property sets: Default** or **Property sets: Minimum**.

    The option **Minimum** exports the minimum set of properties required by the buildingSMART IFC standard. You can view the property sets by clicking **View**.

11. Select **Layer names as part names** to use part names, such as COLUMN and BEAM, as layer names for exported objects.

    You can define part names in part properties.

12. Select **Export flat and wide beams as plates** to export flat and wide beams as plates.

    Select this if you have modeled plates as beams or columns with flat profiles. For example, some system components use beams or columns instead of plates.

13. Select **Use current view colors** to export the objects using the colors defined in **Object Representation**, not the class colors.

14. Click **Export**.
Changing the coordinate system of the exported IFC file

If you want to export the IFC file with another coordinate system than the 0,0,0 in Tekla Structures, you can move the work plane and the IFC file will use that as the 0,0,0 for localization.

1. Set the work plane to the desired location.
2. Export the IFC file.
3. Click Export anyway in the warning message box that is displayed.

The exported IFC model now has the origin set according to the work plane. For more information, see Export IFC model to project coordinates.

See also
Exporting a Tekla Structures model into an IFC file on page 62

Checking the exported IFC model

To check the exported IFC model, insert the model as reference model to the original Tekla Structures model.

Check the following things:

• Check the IFC model visually. Use different colors for the IFC model and the original model. Use clip planes to check the model thoroughly.

• Compare the number of objects. If there are differences, check the export log.

• Check the modeling of unsuccessfully exported objects. For example, unnecessary cuts may result in unsuccessful export. Consider remodeling the incorrect objects or set IFC export type to Brep for the objects.

TIP You can use Tekla BIMsight for viewing and checking the IFC model.

See also
Defining the IFC entity for the exported model objects on page 61
Tekla BIMsight on page 252

IFC Export type settings

See the Export type settings below.

The Coordination view 2.0 settings are the following:

• Reinforcing bars as extrusion
• CSG support on
• Curved elements as RevolvedAreaSolid
• Bolts as B-rep

The **Surface Geometry** settings are the following:
• Reinforcing bars as B-rep
• No CSG
• Curved elements as B-rep
• Bolts as B-rep

The **Steel fabrication view** settings are the following:
• Assembly presentation and base quantities
• Welds as IfcFastener
• Finish of the total piece as IfcCovering
• Vertical braces as IfcMember
• Bolt holes as voids

**IFC base quantities**

Additional **Quantity takeoff add-on view** is included to the exported IFC model if you set **Base quantities** to **Yes** in the **Tekla Structures IFC Export** dialog box.

The **Quantity takeoff add-on view** contains the following information on the entities in the exported IFC model:

<table>
<thead>
<tr>
<th></th>
<th>Beam</th>
<th>Column</th>
<th>Slab</th>
<th>Wall</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Net area</strong></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td><strong>Outer surface area</strong></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Gross footprint area</strong></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td><strong>Net volume</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td><strong>Net weight</strong></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**IFC**  65  **IFC export**
Tekla Structures model objects and related IFC entities

Tekla Structures maps model objects automatically as IFC entities when you export a model into an IFC file. You can also map objects manually in user-defined attributes of objects.

The following table lists Tekla Structures model objects and the recommended related IFC entities.

<table>
<thead>
<tr>
<th>Tekla Structures object</th>
<th>IFC entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>IfcBeam, IfcMember</td>
</tr>
<tr>
<td>Column, Pile</td>
<td>IfcColumn, IfcPile, IfcMember</td>
</tr>
<tr>
<td>Polybeam</td>
<td>IfcBeam, IfcMember</td>
</tr>
<tr>
<td>Curved beam</td>
<td>IfcBeam, IfcMember</td>
</tr>
<tr>
<td>Pad footing, Strip footing</td>
<td>IfcFooting</td>
</tr>
<tr>
<td>Slab</td>
<td>IfcSlab</td>
</tr>
<tr>
<td>Panel</td>
<td>IfcWall or IfcWallStandardCase</td>
</tr>
<tr>
<td>Contour plate</td>
<td>IfcPlate, IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Bolts, nuts and washers</td>
<td>IfcMechanicalFastener</td>
</tr>
<tr>
<td>Bolt holes</td>
<td>IfcOpeningElement</td>
</tr>
<tr>
<td>Vertical braces</td>
<td>IfcMember</td>
</tr>
<tr>
<td>Railings</td>
<td>IfcRailing</td>
</tr>
<tr>
<td>Assemblies, cast units</td>
<td>IfcElementAssembly, IfcRailing, IfcRamp, IfcRoof, IfcStair</td>
</tr>
<tr>
<td>Assembly sub-parts</td>
<td>IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Reinforcements</td>
<td>IfcReinforcingBar</td>
</tr>
<tr>
<td>Pour objects</td>
<td>IfcBuildingElementProxy</td>
</tr>
<tr>
<td>Surface treatment</td>
<td>IfcCovering</td>
</tr>
<tr>
<td>Welds</td>
<td>IfcFastener</td>
</tr>
</tbody>
</table>

**NOTE**  
IfcBuildingElementPart entity can also be used. IfcBuildingElement matches beams, columns, etc., but not assemblies.  
Polybeams are always exported as Brep.

See also

Defining the IFC entity for the exported model objects on page 61
Color of the exported IFC objects

The setting **Use current view colors** on the **Advanced** tab of the Export to IFC dialog box defines which colors are used in the exported IFC objects:

- If you select **Use current view colors**, the exported objects have the colors that you have defined using color and transparency settings of **Object groups** defined in the **Object Representation** dialog box.

- If you do not select **Use current view colors**, the exported objects use the color of the classes set for the objects in the properties dialog box.

The classes have the following colors:

<table>
<thead>
<tr>
<th>Class</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>light gray</td>
</tr>
<tr>
<td>2 or 0</td>
<td>red</td>
</tr>
<tr>
<td>3</td>
<td>green</td>
</tr>
<tr>
<td>4</td>
<td>blue</td>
</tr>
<tr>
<td>5</td>
<td>turquoise</td>
</tr>
<tr>
<td>6</td>
<td>yellow</td>
</tr>
<tr>
<td>7</td>
<td>magenta</td>
</tr>
<tr>
<td>8</td>
<td>gray</td>
</tr>
<tr>
<td>9</td>
<td>rose</td>
</tr>
<tr>
<td>10</td>
<td>lime</td>
</tr>
<tr>
<td>11</td>
<td>aqua</td>
</tr>
<tr>
<td>12</td>
<td>pink</td>
</tr>
<tr>
<td>13</td>
<td>orange</td>
</tr>
<tr>
<td>14</td>
<td>light blue</td>
</tr>
</tbody>
</table>

Property sets in IFC export

Tekla Structures uses configuration files for defining which user-defined attributes and template attributes are exported as property sets into IFC models. When you export to IFC, you select one predefined configuration file as **Export type** that you use as a main property set. In addition, you can define your own property set to add additional information to exported IFC models.

The predefined configuration files are read-only and they are located in `{ProgramData\Tekla Structures\<version>\Environments\Common\inp.`
• IfcPropertySetConfigurations_CV2.xml (Default property sets)/
  IfcPropertySetConfigurations_CV2_1.xml (Minimum property sets)
  contains the property sets for Export type Coordination view 2.0.

• IfcPropertySetConfigurations_SG.xml (Default property sets)/
  IfcPropertySetConfigurations_CV2_1.xml (Minimum property sets)
  contains the property sets for Export type Surface geometry.

• IfcPropertySetConfigurations_AISC.xml (Default property sets)/
  IfcPropertySetConfigurations_AISC_1.xml (Minimum property sets)
  contains the property sets for Export type Steel fabrication view.

The IfcPropertySetConfigurations_CV1.xsd file in the same folder is a
schema file that describes the structure of the XML file and is used for validation of the XML
file. This file is read when the software is started.

The additional property sets you create using the Property Set Definitions tool are saved to
the \AdditionalPSets folder under the model folder by default. You can also read
additional property sets from the following folders:

• XS_SYSTEM
• XS_PROJECT
• XS_FIRM

If you use the above mentioned folders, please save the files in a folder called
\AdditionalPSets under the system, project or firm folder.

See also
Defining additional property sets using the Property Set Definitions tool on page 68
Property set configuration in XML on page 70

**Defining additional property sets using the Property Set Definitions tool**

You can create additional property sets out of template attributes and user-defined
attributes, define property definitions for the attributes, and bind the property sets to IFC
entities for IFC export using the Property Set Definitions tool. Tekla Structures saves
additional property sets in configuration files. You can keep several configuration files in
several locations.

To create property sets, property definitions and bindings:
1. Select File --> Export --> IFC .
2. Select <new> in the Additional property sets list and click Edit.
   The Property Set Definitions dialog box opens.
3. Enter a name for the configuration file in the Name text box.
4. Enter a name for the property set next to the **New** button and click **New**.
   You can create several property sets in a configuration file.

5. Select the entity type you want to use in the **Select entity types** list.
   The **Select attributes** list shows the attributes that can be used for the selected entity type and added to the current property set.

6. Add the desired attributes by selecting the check boxes next to the attribute names.
   The attribute is added to the **List of all selected properties** list on the right. This list shows which attributes are exported and in which format:
   - You can add new attributes by entering an attribute name in the **Attribute** box in the **Create/Modify property** area and clicking the **Add** button.
   - You can modify and remove attributes on the list by selecting the attributes on the list and clicking **Modify** or **Remove**.

7. In **Create/Modify property**, you can select **Property type** for the selected attribute.
   Select **Template attribute** for user-defined attributes whose name contains more than 19 characters. For example, select **Template attribute** for **ASSEMBLY.USERDEFINED.PLANS_STATUS**.

8. In **Create/Modify property**, you can give a new **Name** for the selected attribute, and select the **Type** of the attribute. The **Type** can be one of the following: **String**, **Boolean**, **Integer**, **Measurement**, **Real**, or **Time stamp**.

9. If the type of the user-defined attribute is **Measurement**, you can select the **Measurement type**: **Length**, **Area**, **Volume**, **Mass**, **Positive length** or **Count**.

10. If the type of the user-defined attribute is **Measurement**, you can also select the **Conversion factor** and **Accuracy**.
    User-definable accuracy allows better IFC file size optimization.

11. Click **Save** to save your modifications.

You can later modify your property set by selecting the property set from the **Additional property sets** list in the **Export to IFC** dialog box and clicking **Edit**.

**Example**

Below is an example of the contents of the **Property Set Definitions** dialog box.
See also

Property set configuration in XML on page 70

Property set configuration in XML

We recommend you use the Property Set Definition tool for creating additional property sets to ensure that the XML configuration files are valid.

A configuration file

- Includes the structure of property sets, and the data definitions for the properties inside the property sets:
- Template attribute or UDA name. Template attributes are read from content_attributes_global.lst and the user-defined attributes from the environment database.
• Data type, such as String, Integer, Float, Timestamp, Boolean, Logical, or planeanglemeasure.
• Unit type, such as length, area, volume, or mass.
• Unit value scaling of unitless UDA values. Conversion factor is added so that unitless values can be converted to correspond to the global units used in the IFC files. Area and volume units need these factors.
• Possibility to use default values.
• Possibility to ignore the set to export if template attribute or UDA does not have a value.

• Includes property set binding rules to IFC entities:
  • Binding to IFC entity type hierarchy including support for not only building elements but also for bolts, reinforcing bars, and assemblies.
  • Possibility to use limiting rules, such as Equal, NotEqual, LessThan, GreaterThan, LessThanOrEqual, and GreaterThanOrEqual for numbers, and Equal and NotEqual for texts.
    You need to modify your additional property set configuration file using a suitable editor, if you want to add these limiting rules.
  • There can be any number of binding rules for any property set, but only one property set definition for each ReferenceId.
  • You can bind different property sets to different IFC entity types. For example, a plate may have a different property set than a beam.
• If no value is found for a property in export, the export does not write the property set at all. To avoid this, add optional=true for that property in the property set.

Example
Below is an example of the contents of the IfcPropertySetConfigurations_CV2.xml file.
See also

Defining additional property sets using the Property Set Definitions tool on page 68
Trimble SketchUp is a modeling software used in, for example, architecture, construction, engineering and landscape architecture. 3D Warehouse contains lots of SketchUp models that you can import as reference models to Tekla Structures.

Both SketchUp export and import as reference model support SketchUp version 2014 and earlier.

You can export Tekla Structures models as .skp files to be used in SketchUp.

See also

Inserting a reference model on page 34
Exporting a model to SketchUp on page 73

9.1 Exporting a model to SketchUp

To export a Tekla Structures model to SketchUp in the .skp format:

1. Select the model objects to export.
   
   If you want to export all, you do not have to select anything. We recommend exporting large models in portions.

2. Click File --> Export --> SketchUp...

3. Browse for the Output file location and enter the file name.

4. On the Advanced tab, select the objects that you want to export.

5. Click Create selected.

   If you want to export everything, click Create all.
DWG is the native file format of AutoCAD and the standard file format for Autodesk products. DWG is used for 2D and 3D CAD data that is supported by Tekla Structures.

DXF (Drawing eXchange Format) was developed by Autodesk for enabling data interoperability between AutoCAD and other programs. As the file format does not contain any form of part ID it is not possible to track changes between different physical objects contained within different versions of a file. Clash checking is not possible with a DXF file in Tekla Structures.

In DWG/DXF import Tekla Structures supports ACAD2012 or earlier.

To determine the AutoCAD version of the DWG file, open the file in a text editor. You will find the version code in the first six bytes:

- AC1027 = 2013
- AC1014 = 14
- AC1012 = 13
- AC1009 = 12, 11
- AC1006 = 10
- AC1004 = 9
- AC1002 = 2

See also
- Importing a 2D or 3D DWG or DXF file on page 75
- Exporting a model to a 3D DWG or DXF file on page 75
- Exporting a drawing to a 2D DWG or DXF file on page 77
10.1 Importing a 2D or 3D DWG or DXF file

The DWG/DXF import tool imports 2D and 3D models that are in DXF or DWG format. You can import the file as parts or reference lines.

To import DWG and DXF files:

1. Select File --> Import --> DWG/DXF...
2. Enter the name of the import file.
   Click Browse to browse for the file.
3. Enter the offset from X, Y and Z.
4. Enter the scale.
5. Select how to show the imported parts:
   - Reference lines displays parts in the model using their reference lines in the original model.
   - Parts displays the full profile of parts in the original model, based on the profile sizes defined in the Beam profile and Plate profile boxes. You can only use metric profiles with this option.
6. Select Use 2D import to import a two-dimensional representation of the original model. This is useful when have selected the Reference line option. Do not select Use 2D import if you want to import the model in 3D.
7. Click Import.

Tekla Structures imports the file you specified.

Limitations

When importing DWG profiles, note the following:

- The profile must be the only object in the DWG file. The file should not include any titles, blocks or any other graphics.
- The profile must be a closed POLYLINE.
- Generating the polylines from an ADSK 3D model requires a number of steps to clean the profile.
- The profile needs to be scaled up.
- The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted to part profiles that can be used to create a model. If you want to show surfaces of the objects, import DWG and DXF files by inserting them in a Tekla Structures model as a reference model.
10.2 Exporting a model to a 3D DWG or DXF file

You can export models to 3D DWG or 3D DXF file types. By default, Tekla Structures creates a `model.dwg` file in the current model folder.

To create a 3D DWG or DXF export file:

1. Open a Tekla Structures model.
2. Select File --> Export --> 3D DWG/DXF... to open the Export 3D DWG/DXF dialog box.
3. Accept the default export file name, or enter another one.
   To replace an already existing export file, click the ... button and browse for the file.
4. Select whether to export as DWG or DXF.
5. In Export as, select the representation for the exported objects:
   - **Faces** exports parts as faces.
     Exporting 3D DWG or DXF files as Faces uses more memory and may take longer, but the end result is better.
   - **Lines** exports parts as lines located in the center of the profile cross section. Suits well for exporting to analysis software.
   - **Center lines** exports parts as part center lines.
   - **Reference lines** exports parts as reference lines, drawn between the creation points. Suits well for exporting to analysis software.
     If the model is large, or you have less memory to use, the Reference lines option is faster, and the resulting file size is smaller.
6. Select the **Part accuracy**:
   - The options are **High** and **Normal**. High also exports chamfers in profile cross-sections.
7. Select the **Bolt accuracy**:
   - **High** exports entire bolt assemblies, including washers.
   - **Normal** only exports the bolt and nut.
   - **No bolts** exports no bolts.
8. Select whether to include **Cuts** in the export.
   - **Yes** exports cuts, **No** does not.
9. Select whether to include **Inner contours**:
   - **Yes** includes the inner contours, **No** does not.
10. In the Export list, select what to export:
    - **All objects** exports the whole model.
    - **Selected objects** exports the parts selected from the model.
11. Click **Create**.

Tekla Structures creates the export file in the current model folder. The ID of each part is exported as an attribute and written into the export file for each part.

**Limitations**

- Bolt holes are not exported.
- Curved beams and polybeams are exported as single, continuous beams.
- The number of segments in the curved beams is as defined for the particular curved beam.

**See also**

*Exporting a drawing to a 2D DWG or DXF file on page 77*

### 10.3 Exporting a drawing to a 2D DWG or DXF file

You can export drawings to 2D DWG and DXF files from the **Drawing List**, using the **Export** command from the pop-up menu, or using the menu commands **File --> Export --> Drawings...** and **Drawing File --> Export...**.

To export Tekla Structures drawings to DXF or DWG format from the **Drawing List**:

1. Click **Drawings & Reports --> Drawing List...**.
2. Select from the list the drawings that you want to export.
3. Right-click and select **Export...** from the pop-up menu.
   
   The **Export Drawings** dialog box is displayed.
4. On the **Export file** tab, enter the export file name.
   
   If you are exporting several drawings, leave the file name box empty.
   
   The drawings are exported by default to the *\PlotFiles* folder under the current model folder. If you want to use another folder, enter the full path.
   
   Tekla Structures uses one of the following advanced options to define the names for the export files: **XS_DRAWING_PLOT_FILE_NAME_A**, **XS_DRAWING_PLOT_FILE_NAME_C**, **XS_DRAWING_PLOT_FILE_NAME_G**, **XS_DRAWING_PLOT_FILE_NAME_W**, or **XS_DRAWING_PLOT_FILE_NAME_M**. The advanced option that is used depends on the drawing type.
5. Select the file type: **DXF** or **DWG**.
6. If you want to include a revision mark in the file name, select **Include revision mark to file name**.
7. Set the layer options on the **Layer options** tab:
• Select the layer rules file.

To add or modify layers, and to assign object groups to different layers, click **Setup**.

• If you want to use advanced conversion to convert the type, color and weight of lines and layers, select **Use advanced line type and layer conversion**.

• In the **Conversion file** box, enter the name of the file to be used in the conversion.

  By default, Tekla Structures uses the **LineTypeMapping.xml** file in the .. \Tekla Structures\<version>\environments\common\inp folder.

  If you need to define your own line type mappings, you can use the file **LineTypeMapping.xml** as a template when you create a conversion file of your own.

• Select **Include empty layers** if you want to include empty layers in the export.

• Select **Object color by layer** to have different colors on different layers.

8. Set the other drawing export options on the **Options** tab:

• Set **Drawing scale** and **Line type scale**.

• If you want to export the drawings so that the DWG/DXF content is grouped by object, select **Export objects as groups**. When you do this, Tekla Structures makes a new group for each object (part, mark, dimension line, etc.).

• Select **Cut lines with text** if you do not want to display continuous lines in exported drawings, for example, to run the line through text or drawing marks.

• Select **Export custom lines as split lines** to ensure that custom line types have the same appearance in the software you are exporting to and when printed. If **Export custom lines as split lines** is selected, custom line types are exported as solid lines that are split to several short lines. If **Export custom lines as split lines** is not selected, custom line types are exported as defined in **TeklaStructures.lin**.

• Select **Use paper space** to export to both model space and paper space. The unscaled contents of the drawing views are exported into model space. The drawing layout is exported into paper space. The layout contains scaled viewports showing appropriate areas of the model space.

  When exporting to paper space, ensure that all objects in the view are inside the view frame. Objects that are partially outside the drawing view frame are not exported.

9. Click **Export**.

See also

- Default line types in drawings on page 85
- Defining customized line type mappings in drawing export on page 83
- Example: Setting up layers and exporting to DWG on page 86
- Layers in exported drawings on page 79
- Creating layers for drawing export on page 79
Layers in exported drawings

In drawing DWG/DXF export, you can define the layers to which different drawing objects belong. The benefit of using layers in export is that if you do not want to show a certain layer in the drawing, you can turn it off.

You can define the different layers using Tekla Structures selection filters.

You can use the LineTypeMapping.xml file to define the line type, line weight and line color for objects on different layers. You can also add custom line types in the TeklaStructures.lin file and use these when mapping Tekla Structures line types to the line types in the exported DWG and DXF files.

You can export into layers of their own all object types that are listed in the Drawing Export Layers dialog box.

The following objects cannot have layers in export because they cannot be identified as separate objects that can have selection filters: clouds, hatches, neighbor parts, symbols in drawings, section view titles, grid label texts, dimension labels, weld labels, bolt mark leader lines, and part mark leader lines. For example, hatches are exported to the same layer with the part that the hatch belongs to.

See also

Example: Setting up layers and exporting to DWG on page 86

Creating layers for drawing export

You need to define the layers that are included in the exported DWG and DXF files.

NOTE To keep track on the layers that you have, create all the layers that you need for the final DWG/DXF drawings at the same time.

To create a layer:

1. In the model, click File --> Export --> Drawings...
2. In the Export Drawings dialog box, go to the Layer options tab and click Setup... next to the Layer rules box.
3. In the Drawing Export Layers dialog box, click Modify layers....
4. To add a layer, click Add.
   You can add as many layers as you need.
5. Click the row of the new layer in the Name column and enter a name for the layer.
6. Click the row of the new layer in the **Color** column and select a color for the new layer.

7. Click **OK**.

Next you can assign objects to the new layer.

**See also**

- Assigning objects to export layers on page 80
- Displaying catalog and mapping files of converted objects on page 53
- Example: Setting up layers and exporting to DWG on page 86

### Assigning objects to export layers

You need to define which objects you want to export in a certain layer in the DWG/DXF file. You can do this by using a selection filter for identifying the desired objects among all objects, and by creating a rule to export these objects in a certain layer.

Before creating the rule, first create the selection filter.

To create a layer rule and assign objects to an export layer:

1. Click **File --> Export --> Drawings...** to display the **Export Drawings** dialog box, and go to the **Layer options** tab.
2. Click **Setup...**
3. Open an object group by clicking the plus sign next to the group name. For example, click the plus sign next to **Model Object**.
4. Right-click a rule in the list and select **Add Next Level Rule...**. For example, right-click **Part**.
5. Enter a name for the rule and select the related selection filter.
6. Click OK.

7. Double-click the row under the rule you just created and select the desired layer for it in the Select Layer dialog box.

8. Click OK.

Tekla Structures maps the selected layer to the rule.

9. Save the created layer rule settings for later use by entering a name next to the Save as button and clicking Save as.

**NOTE** The order of rules is important. Organize the rules by right-clicking the rule, and selecting Move up or Move down. The objects are exported to the first matching layer. If there is no matching layer, the objects are exported as Other object type.

---

**Example: Creating a rule for exporting beam marks to their own layer**

You can export all kinds of drawing objects to layers of their own. This example shows how you can do that for beam marks. All kinds of marks can be exported separately to their own layers: bolt marks, part marks, connection marks, neighbor part marks, reinforcement marks and component marks.

First you need to create a selection filter selecting the beams and then you can define the layer rule. Name the beam selection filter Beams.

To export beam marks to their own layers:

1. Select File --> Export --> Drawings...
2. Go to the **Layer options** tab of the **Export Drawings** dialog box and click **Setup...** next to the **Layer rules** box.

3. Under **Mark** in the **Drawing Export Layers** dialog box, select the layer rule of the mark you want to define to its own layer (part, bolt, connection, neighbor part, or reinforcement mark).
   
   Select **Part mark**.

4. Right-click **Part mark** and select **Add Next Level Rule** from the pop-up menu.
   
   This opens the **Layer manager rules** dialog box.

5. Enter a rule name (for example, *BeamMark*) and select a filter that you have created (Beam).

   ![Layer manager rules dialog box](image)

6. Click **OK**.

   Tekla Structures creates a new rule *BeamMark*. Now you can connect the new rule to a layer you have created for beam marks and use when exporting drawings.

   **See also**

   Assigning objects to export layers on page 80

---

**Copying export layer settings to another project**

If you want your layer settings to also be available in other projects, you can copy them to a firm or project folder.

To copy the layer settings to another project:

1. Define the required rule and layer settings in the **Drawing Export Layers** dialog box (**File --> Export --> Drawings... --> Layer options --> Setup...**).

2. Enter a name for the layer rule settings file next to the **Save as** button and click **Save as**.

3. Copy the file `<your_layer_rule>.ldb` from the `\attributes` folder under the current model folder to the firm or project folder.

   **See also**

   Assigning objects to export layers on page 80
Defining customized line type mappings in drawing export

You can use advanced conversion to convert the type, color and weight of lines and layers. This way you will get the line types that you want to use in the target software, for example, AutoCAD.

By default, Tekla Structures uses the file LineTypeMapping.xml in the folder ..\Tekla Structures\<version>\environments\common\inp for the conversion.

If you need to define your own line type mappings, you can use the file LineTypeMapping.xml as a template.

**NOTE** When modifying the line type mappings file, use an editor that is capable of validating XML in order to maintain a valid document structure.

To define your own line type mappings, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Map according to line types only | 1. Open the mapping file in an XML editor.  
2. Enter only the line type information.  
   For example, all lines in all layers with line type XKITLINE01 will be exported to DASHED.  
3. Save the mapping file to the model folder. |
| Map according to line types and layers | 1. Open the mapping file in an XML editor.  
2. Enter the line type and layer name.  
   Define the layers that the mapping will apply to in the LayerName attribute.  
   If you leave out the attribute LayerName, Tekla Structures uses the line type mapping for any layer. If you include the attribute LayerName, Tekla Structures uses the line type mapping for that layer only.  
   For example, all lines on the layer BEAM with line type XKITLINE01 will be exported to DASHED. Tekla Structures first searches for these kinds of mappings by default.  
3. Define the color of the line in the Color attribute. Enter the color values in AutoCAD Color Index (ACI) codes (numbers from 0 to 255).  
4. Define the thickness of the line in the Weight attribute. Enter the values in hundredths of millimeters.  
5. Save the mapping file to the model folder. |
This is how the file LineTypeMapping.xml is composed:

```xml
<?xml version="1.0" encoding="UTF-8" standalone="yes" ?>
<!DOCTYPE Mapper []
<!ELEMENT Mapper (Mapping*)>
<!ATTLIST Mapper Version CDATA #REQUIRED>
<!ELEMENT Mapping (From, To)>
<!ATTLIST Mapping LayerName CDATA #IMPLIED>
<!ATTLIST Mapping From EMPTY #REQUIRED>
<!ATTLIST Mapping From Linetype CDATA #REQUIRED>
<!ATTLIST Mapping To EMPTY #REQUIRED>
<!ATTLIST Mapping To Linetype CDATA #REQUIRED>
<!ATTLIST Mapping To LayerName CDATA #IMPLIED>
<!ATTLIST Mapping To Color CDATA #IMPLIED>
<!ATTLIST Mapping To Weight CDATA #IMPLIED>
>
<Mapper Version="1.1">
  <Mapping LayerName="Part">
    <From Linetype="XLTLINE0"/>
    <To Linetype="BYLAYER" Color="4" weight="100"/>
  </Mapping>
  <Mapping LayerName="Part">
    <From Linetype="XLTLINE2"/>
    <To Linetype="HIDDEN" LayerName="Part_Hidden" Color="8" weight="100"/>
  </Mapping>
  <Mapping LayerName="Part">
    <From Linetype="XLTLINE0"/>
    <To Linetype="DASHED"/>
  </Mapping>
  <Mapping>
    <From Linetype="XLTLINE2"/>
    <To Linetype="DASHEDX2"/>
  </Mapping>
  <Mapping>
    <From Linetype="XLTLINE0"/>
    <To Linetype="DASHDO"/>
  </Mapping>
  <Mapping>
    <From Linetype="XLTLINE2"/>
    <To Linetype="DASHDOX2"/>
  </Mapping>
  <Mapping>
    <From Linetype="XLTLINE0"/>
    <To Linetype="DOT2"/>
  </Mapping>
  <Mapping>
    <From Linetype="XLTLINE0"/>
    <To Linetype="DIVIDE"/>
  </Mapping>
  <Mapping>
    <From Linetype="XLTLINE0"/>
    <To Linetype="CENTER"/>
  </Mapping>
</Mapper>
```

1. The first section consists of XML and document type definition. Do not change or remove this section.
2. The mappings that are available are defined here. You can use these mappings as a template for your own mappings.

DWG and DXF 84 Exporting a drawing to a 2D DWG or DXF file
Examples

In the first example, a new Mapping element is added, where XKITLINE00 lines in the Beam layer are converted to BORDER line type, color is converted to 10 and weight to 1.00 mm:

```xml
<Mapping LayerName="Beam">
  <From LineType="XKITLINE00"/>
  <To LineType="BORDER" Color="10" weight="100" /></Mapping>
```

In the second example, a new Mapping element is added, where XKITLINE02 lines in the Part layer are converted to HIDDEN2 line type, the layer name is converted to PartHidden, the color is converted to 8 and weight to 1.00 mm.

You can use the LineTypeMapping.xml file for exporting hidden lines to separate layers. The hidden lines must then be defined to their own layers (here PartHidden).

```xml
<Mapping LayerName="Part">
  <From LineType="XKITLINE02"/>
  <To LineType="HIDDEN2" LayerName="PartHidden" Color="8" Weight="100" /></Mapping>
```

**NOTE** For the export to succeed, ensure that the layer (here PartHidden) exists on the list of available layers in the Modify Layers dialog box.

See also

Default line types in drawings on page 85

Default line types in drawings

Default line types are available in Tekla Structures drawings. You can map default line types to customized line types, which are defined in TeklaStructures.lin and further exported to DWG/DXF files.

The table below describes which line type name corresponds to which line type appearance.

<table>
<thead>
<tr>
<th>Line type name</th>
<th>Line type appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>XKITLINE00</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE01</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE02</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE03</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE04</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE05</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE06</td>
<td>---</td>
</tr>
</tbody>
</table>

DWG and DXF 85 Exporting a drawing to a 2D DWG or DXF file
See also

Defining customized line type mappings in drawing export on page 83

Example: Setting up layers and exporting to DWG

This example shows how to define layers and export line types on a certain layer to their own sublayers in DWG export. The workflow consists of six tasks:

1. Example: Creating a selection filter for DWG export on page 86
2. Example: Creating layers for DWG export on page 87
3. Example: Creating a rule for DWG export on page 87
4. Example: Defining a custom line type for DWG export on page 88
5. Example: Defining line types and weights for layers in DWG export on page 89
6. Example: Exporting the drawing on page 91

Example: Creating a selection filter for DWG export

Start by creating a selection filter. This task is phase 1 in the workflow Example: Setting up layers and exporting to DWG on page 86.

To create a selection filter:

1. In the model, click Edit --> Selection Filter... to open the Object Group - Selection Filter dialog box.
2. Click New filter.
3. Add new filter rules.
   a. Create a filter rule that select parts according to the name BEAM.
   b. Create a filter rule that selects parts according to the material S* (as in steel).
4. Save the filter as steel-beam.
Example: Creating layers for DWG export

After creating a selection filter, you can continue by creating layers that you want to have in the exported DWG. This task is phase 2 in the workflow Example: Setting up layers and exporting to DWG on page 86.

To create the layers you want to have in the exported DWG:

1. Click File --> Export --> Drawings and go to the Layer options tab.
2. Click Setup... and Modify layers.
3. Click Add to add a new layer.
   Create separate layers for solid lines (steel-beam-layer) and hidden lines (steel-beam-layer-H) within steel beams.
4. Set the color for the layers.
   Set the solid lines to red and hidden lines to blue.

   steel-beam-layer-H
   steel-beam-layer

5. Click OK to accept the changes.
Example: Creating a rule for DWG export

After creating layers, you can continue by creating a rule to export an object group into a layer, and assign the layer to the created rule. This task is phase 3 in the workflow Example: Setting up layers and exporting to DWG on page 86.

To create a rule to export an object group into a layer, and assign the layer to the created rule:

1. Right-click a model object part rule and select Add Next Level Rule.
2. Enter a name for the rule (steel-beam-rule) and select the selection filter you created for steel beams (steel-beam).

   ![Layer manager rules dialog](image)

   - Rule name: steel-beam-rule
   - Filter: steel-beam

3. Click OK.
4. To assign a layer to a rule, double-click the row under the steel-beam-rule and select a layer, in this case steel-beam-layer.
5. Click OK.

   ![Layer manager rules](image)

6. Save the layer rule settings with the name example1 using Save as.

   ![Drawing Export Layers](image)

7. Close the dialog box by clicking OK.
**Example: Defining a custom line type for DWG export**

After creating a rule, you can continue by defining a custom line type for continuous lines in the exported DWG. In this example, there is no need to delete the existing line types. This is phase 4 in the workflow *Example: Setting up layers and exporting to DWG on page 86.*

To define a custom line type:

1. Open the *TeklaStructures.lin* file in a text editor (`..\ProgramData\Tekla Structures\<version>\environments\common\inp`).

2. Add the following line type definition in the file:

   ```
   *HIDDEN, Hidden __ __ __ __ __ __ __ __ __ __ __ __ __
   A, 1.5875, -0.79375
   *HIDDEN2, Hidden (.5x) __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ ____
The lines are on the steel-beam-layer layer.

The lines are drawn with XKITLINE00 (solid lines).

The lines are exported to CONTINUOUS lines in DWG. The line color in DWG was already defined in the layer properties (red). The line weight in DWG is 35.

The lines are on the steel-beam-layer layer.

The lines are drawn with XKITLINE02 (hidden lines).

The lines are exported to DASHED lines into a separate layer called steel-beam-layer-H in DWG. The line color in DWG was already defined in the layer properties (blue). The line weight in DWG is 35.
Example: Exporting the drawing

After you have defined all the layer settings, you can continue by exporting the drawing. Before exporting the drawing, make sure that all the drawing properties are as you wish. This task is phase 6 in the workflow Example: Setting up layers and exporting to DWG on page 86.

To export the drawing:
1. Open the drawing that you want to export.
2. Click Drawing File --> Export... to open the Export Drawings dialog box.
3. Enter a name for the file.
4. Set the Type to DWG.
5. Go to the Layer options tab page and load the layer rule settings that you saved earlier with the name example1.
6. Select the following check boxes: Use advanced line type and layer conversion, Include empty layers and Object color by layer.
8. Go to the Options tab, set the scale for the export and select the Export objects as groups check box and, if you want to, Cut lines with text and Export custom lines as split lines.
9. Click Export.

Open the exported DWG with an applicable DWG viewer software. You can see that the solid lines of the steel beam are on one layer and the hidden lines are on another layer. You can
also see that columns do not match with the layer rules you defined, so they are handled according to other rules.

Below are examples of how the selecting and not selecting **Cut lines with text** affects the result.

In the following example, **Cut lines with text** is selected.

![Example of Cut lines with text selected](image)

In the following example, **Cut lines with text** is not selected.

![Example of Cut lines with text not selected](image)
Exporting a drawing to a 2D DWG or DXF file
You can import LandXML reference models to Tekla Structures. The supported contents of LandXML files are terrain models, line alignments of roads and railways, and rain water systems.

You can export files in .xml format from applications like Bentley InRoads, Autodesk Civil, and Trimble Business Center, and import the .xml files in Tekla Structures as reference models.

An example of an imported LandXML reference model:

![An example of an imported LandXML reference model](image)

An example of layers in a LandXML reference model:
See also

Inserting a reference model on page 34
NC (Numerical Control) refers to a method where machine tool operations are controlled with a computer. The NC data controls the motion of CNC (computer numerical control) machine tools. During the manufacturing process a machine tool or machining center drills, cuts, punches or shapes the piece of material.

After you have finished detailing a Tekla Structures model, you can export the NC data as NC files from Tekla Structures to be used by CNC machine tools. Tekla Structures transforms the part length, hole positions, bevels, notches, and cuts into sets of coordinates that the machine tools can use to create the part in a shop. In addition to the CNC machine tools, the NC files can also be used by MIS and ERP software solutions.

Tekla Structures produces NC files in DSTV format. Tekla Structures can also produce NC files in DXF format by converting DSTV files to DXF files.

The data for the NC files comes from the Tekla Structures model. We recommend that you complete detailing and create drawings before producing the NC files.

See also
Creating NC files in DSTV format on page 97
DSTV file description on page 96
Creating NC files in DXF format on page 114
NC file settings on page 99

12.1 DSTV file description
Tekla Structures produces NC files in DSTV format. DSTV format is an industrial standard defined by the German Steel Construction Association (Deutsche Stahlbau-Verband).

A DSTV file is a text file in ASCII format. In most cases each part has its own DSTV file.

Blocks
The DSTV file is divided into blocks that describe the content of the file.
### DSTV block

<table>
<thead>
<tr>
<th>DSTV block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST</td>
<td>Start of the file</td>
</tr>
<tr>
<td>EN</td>
<td>End of the file</td>
</tr>
<tr>
<td>BO</td>
<td>Hole</td>
</tr>
<tr>
<td>SI</td>
<td>Hardstamp</td>
</tr>
<tr>
<td>AK</td>
<td>External contour</td>
</tr>
<tr>
<td>IK</td>
<td>Internal contour</td>
</tr>
<tr>
<td>PU</td>
<td>Powder</td>
</tr>
<tr>
<td>KO</td>
<td>Mark</td>
</tr>
<tr>
<td>KA</td>
<td>Bending</td>
</tr>
</tbody>
</table>

### Profile types

Profile types are named according to the DSTV standard.

<table>
<thead>
<tr>
<th>DSTV profile type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>I profiles</td>
</tr>
<tr>
<td>U</td>
<td>U and C profiles</td>
</tr>
<tr>
<td>L</td>
<td>L profiles</td>
</tr>
<tr>
<td>M</td>
<td>Rectangular tubes</td>
</tr>
<tr>
<td>R</td>
<td>Round bars and tubes</td>
</tr>
<tr>
<td>B</td>
<td>Plate profiles</td>
</tr>
<tr>
<td>CC</td>
<td>CC profiles</td>
</tr>
<tr>
<td>T</td>
<td>T profiles</td>
</tr>
<tr>
<td>SO</td>
<td>Z profiles and all the other types of profile</td>
</tr>
</tbody>
</table>

### Part faces

Single letters in the DSTV file describe the part faces.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Part face</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>front</td>
</tr>
<tr>
<td>o</td>
<td>top</td>
</tr>
<tr>
<td>u</td>
<td>bottom</td>
</tr>
<tr>
<td>h</td>
<td>behind</td>
</tr>
</tbody>
</table>

### See also

- NC files on page 96
- Creating NC files in DSTV format on page 97
12.2 Creating NC files in DSTV format

Tekla Structures produces NC files in DSTV format. You can select the information to be included in NC files and NC file headers. You can also select the desired pop-mark and contour mark settings. You can also produce MIS (Manufacturing Information System) list files according to the DSTV standard.

By default, Tekla Structures creates the NC files in the current model folder. In most cases each part has its own NC file.

**NOTE** The DSTV standard does not support curved beams, and therefore Tekla Structures does not create NC files for curved beams. Use polybeams instead of curved beams.

To create NC files in DSTV format:

1. Click **File** --> **Export** --> **Create NC Files** to open the **NC Files** dialog box.
2. Click a row that contains the NC file settings you want to use, and select the corresponding check box in the **Create** column.
   
   Tekla Structures will create the NC files using the settings you have selected.
3. To modify the selected NC file settings, click **Edit** to open the **NC File Settings** dialog box.

   If you want to add new NC file settings, click **Add**.
4. Modify the settings on the **Files and part selection**, **Holes and cuts**, **Hard stamp** and **Advanced Options** tabs.

   You can select to create only DSTV files, MIS files, both, or DSTV files embedded in MIS files.

   Hard stamps can be created for both the main part and the secondary parts. By default, Tekla Structures creates hard stamps only for the main part. Set the advanced option XS_SECONDARY_PART_HARDSTAMP to **TRUE** to also create hard stamps for secondary parts.

   For more information on NC File Settings, see **NC file settings on page 99**.
5. You can enter a unique name for the settings using **Save as**. Tekla Structures saves the settings in the ..\attributes folder under the current model folder.
6. Click **OK** to save your NC file settings and to close the **NC File Settings** dialog box.
7. To select the information to be included in the NC file header, click **Header**, modify the information, and click **OK**.

   For more information on NC header information, see **Customizing NC file header information on page 107**
8. To modify the pop-mark settings, click **Pop-marks**, modify the settings and click **OK**.

   For more information about pop-marks, see **Creating pop-marks in NC files on page 109**
9. To modify the contour marking settings, click **Contour marking**, modify the settings and click **OK**.

For more information on contour marking, see *Creating contour marking in NC files on page 112* and the support article *How to create contour marking for steel beams*.

10. In the **NC Files** dialog box, use the **All parts** or **Selected parts** options to select whether to create the NC files for all parts or only for the selected parts.

If you use the **Selected parts** option, the parts need to be selected in the model.

11. Click **Create**.

Tekla Structures creates .nc1 files for the parts using the selected NC file settings. By default, the NC files are created in the current model folder. The filename consists of a position number and the extension .nc1.

12. If all expected parts are not exported, check that the parts which were not exported pass all the profile type, size, hole and other limits set in the NC file settings.

See also

*Pop-marks in NC files on page 108*

*Contour marking in NC files on page 112*

### 12.3 NC file settings

You can open the **NC File Settings** dialog box by clicking **Add** or **Edit** in the **NC Files** dialog box. Here you can define settings for NC files, folder locations, part selection, hard stamps, holes and cuts, AK and IK block curve radius signs, and curve detection.

**Files and part selection tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td><strong>DSTV</strong> is the only available value.</td>
</tr>
<tr>
<td>File location</td>
<td>Browse for the location where you want to save the NC file.</td>
</tr>
<tr>
<td></td>
<td>You can enter a folder name or a relative path directly in the File location box.</td>
</tr>
<tr>
<td></td>
<td>If you leave the field empty, the file will be created in the current model folder.</td>
</tr>
<tr>
<td></td>
<td>If you enter ., the file will be created in the current model folder.</td>
</tr>
<tr>
<td></td>
<td>If you enter .\MyFiles, the file will be created in the current model folder.</td>
</tr>
<tr>
<td></td>
<td>\MyFiles</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If you enter C:\TEMP, the file will be created in C:\TEMP. When you use relative paths, you can use the advanced option XS_MIS_FILE_DIRECTORY to control where the NC files and also the MIS files are created. For more information about using this advanced option and relative paths, see XS_MIS_FILE_DIRECTORY.</td>
<td></td>
</tr>
<tr>
<td>Include revision mark</td>
<td>Add a revision mark to the NC file name. The file name then includes a number indicating the revision of the file, for example, P176.nc1 becomes P176_1.nc1.</td>
</tr>
<tr>
<td>File extension</td>
<td>.nc1 is the default value.</td>
</tr>
<tr>
<td>Create what</td>
<td>Select the type of files to create. <strong>NC files</strong> creates only DSTV files. <strong>Part list</strong> creates only a MIS list file (.xsr). If you create an MIS list file, enter a name for the list in the <strong>Part list file name</strong> box. Also, you need to click the <strong>Browse</strong> button next to the <strong>Part list file location</strong> box and browse for the location where you want to save the list. <strong>NC files and part list</strong> creates both the DSTV files and an MIS list file. <strong>Combined NC files and part list</strong> embedds DSTV files in an MIS list file (.xsr).</td>
</tr>
<tr>
<td>Maximum size</td>
<td>The options define the maximum length, width, and height of the parts the machine tool can handle. Larger parts are sent to other machines.</td>
</tr>
<tr>
<td>Profile type</td>
<td>All profiles that are set to Yes in the <strong>Profile type</strong> list can be handled by the machine tool. Profile types are named according to the DSTV standard. <strong>I</strong>: I profiles <strong>U</strong>: U and C profiles <strong>L</strong>: L profiles <strong>M</strong>: Rectangular tubes</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>R</td>
<td>Round bars and tubes</td>
</tr>
<tr>
<td>B</td>
<td>Plate profiles</td>
</tr>
<tr>
<td>CC</td>
<td>CC profiles</td>
</tr>
<tr>
<td>T</td>
<td>T profiles</td>
</tr>
<tr>
<td>SO</td>
<td>Z profiles and all the other types of profile</td>
</tr>
</tbody>
</table>

By default, Tekla Structures unwraps round tubes as plate profiles and uses the plate profile type B in the NC file header data. To change this, use the advanced option `XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC`.

**Maximum size of holes**

The **Maximum size of holes** options define how large holes the machine tool is able to drill. The NC file is not created if a part contains larger holes or its material is thicker than the specified values. The hole size is connected to material thickness or plate thickness.

Each row contains the maximum hole diameter and the material thickness. Both conditions have to be met for the NC file to be created. For example, a row with the values 60 45 means that when the material thickness is 45 mm or smaller, and the hole diameter is 60 mm or smaller, the NC file is created. You can add as many rows as needed.

**Example**

The following example shows how the **Maximum size of holes** can be defined. In this example, we have the following situation:

- Three plates of different thickness.
- Two bolt groups with equal sizes, and one bolt group with a larger size.

Maximum size of holes are defined as follows:

**Test1** creates a folder under the model folder for the plates that meet the following criteria:

- **Hole diameter**: 22
- **Plate thickness**: 10

Test2 creates a folder under the model folder for the plates that meet the following criteria:

- **Hole diameter**: 22
- **Plate thickness**: 20

When you create NC files for the plates, the folder Test1 includes the plate PL350*10 and the folder Test2 includes the plate PL350*20. The plate PL350*15 is not included in any folder, because the hole size criterion is not met.

**NOTE** The order in which you enter the criteria is important: enter the most exclusive criteria first. If you define the criteria in a different order, the results will also be different.

### Holes and cuts tab

#### Inner corners shape

The **Inner corners shape** options define the shape of, for example, web notches or flange cuts at the beam end.

The examples in the table below show how the different inner corner shape options affect the part in the NC file. The original part in the model has flanges cut entirely and the web is notched:

<table>
<thead>
<tr>
<th>Option</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0      | ![Example](image) | Radius  
The inner corners are shaped like holes with a given radius. A separate BO block is not written to the NC file. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><img src="image1" alt="Tangential Example" /></td>
<td><strong>Tangential</strong>&lt;br&gt;The inner corner is rounded according to the value in the <strong>Radius</strong> box.</td>
</tr>
<tr>
<td>2</td>
<td><img src="image2" alt="Square Example" /></td>
<td><strong>Square</strong>&lt;br&gt;The corner is as it is in the model.</td>
</tr>
<tr>
<td>3</td>
<td><img src="image3" alt="Drilled hole Example" /></td>
<td><strong>Drilled hole</strong>&lt;br&gt;A drilled hole is added to the inner corner. The hole radius is the same as the value in the <strong>Radius</strong> box. Holes are written as a separate BO block to the NC file.</td>
</tr>
<tr>
<td>4</td>
<td><img src="image4" alt="Tangential drilled hole Example" /></td>
<td><strong>Tangential drilled hole</strong>&lt;br&gt;A drilled hole is added tangentially to the inner corner. The hole radius is the same as the value in the <strong>Radius</strong> box. Holes are written as a separate BO block to the NC file.</td>
</tr>
</tbody>
</table>

The inner corner shape options also affect cuts on the flange.
NOTE The inner corner shape options are not applied to rectangular openings that are located in the middle of a part:

The inner corner shape options do not apply to those inner contours that are already rounded in the model. The model values remain intact.

**Distance from flange within which web is not cut**

The **Distance from flange within which web is not cut** option defines the height of the flange clearance area. The clearance check only affects the I, U, C, and L DSTV profile types.

If a cut in a part is located closer to the flange than the clearance in the model, the cut points inside that clearance are moved to the border of the clearance area when the NC file is written.

<table>
<thead>
<tr>
<th>Model</th>
<th>NC file</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Model" /></td>
<td>The part how it is modeled. The cut goes closer to the top flange than the defined flange clearance in the NC file settings.</td>
</tr>
<tr>
<td><img src="image2.png" alt="NC file" /></td>
<td>The part how it is written in the NC files. The dimension shows the clearance. The top of the original cut is moved so that the clearance area is left free. The bottom of the cut is not moved.</td>
</tr>
</tbody>
</table>

**Machine slots as**

The **Machine slot as** options define the how slotted holes are created.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore slots</td>
<td>Slotted holes are not created in the NC file.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>A single hole in the center of the slot</td>
<td>Drills a single hole in the center of the slotted hole.</td>
</tr>
<tr>
<td>Four small holes, one at each corner</td>
<td>Drills four smaller holes, one at each corner.</td>
</tr>
<tr>
<td>Internal contours</td>
<td>Flame-cuts the slots as internal contours.</td>
</tr>
<tr>
<td>Slots</td>
<td>Leaves slots as they are.</td>
</tr>
</tbody>
</table>

**Maximum diameter for holes to be drilled**

The **Maximum diameter for holes to be drilled** option defines the maximum hole diameter. Holes and slotted holes that are larger than the maximum hole diameter are manufactured as internal contours.

**Hard stamp tab**

**Hard stamp content**

The **Elements** list defines which elements are included in hard stamps and the order in which the elements appear in the hard stamp. You can also define the **Text height** and **Case**.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project number</td>
<td>Adds the project number to the hard stamp.</td>
</tr>
<tr>
<td>Lot number</td>
<td>Adds the lot number to the hard stamp.</td>
</tr>
<tr>
<td>Phase</td>
<td>Adds the phase number to the hard stamp.</td>
</tr>
<tr>
<td>Part position</td>
<td>Prefix and position number of the part.</td>
</tr>
<tr>
<td>Assembly position</td>
<td>Prefix and position number of the assembly.</td>
</tr>
<tr>
<td>Material</td>
<td>The material of the part.</td>
</tr>
<tr>
<td>Finish</td>
<td>The type of finish.</td>
</tr>
<tr>
<td>User-defined attribute</td>
<td>Adds a user-defined attribute (user fields 1-4) to the mark.</td>
</tr>
<tr>
<td>Text</td>
<td>Opens a dialog box where you can add user-defined text to the hard stamp.</td>
</tr>
</tbody>
</table>

If you include part position and/or assembly position in the hard stamp, they affect the NC filename:

- Part position: P1.ncl, P2.ncl
- Assembly position: A1.ncl, A2.ncl
- Assembly and part position: A1-P1.ncl, A2-P2.ncl

The following example shows a hard stamp that contains the elements **Phase**, **Part position**, **Material**, and **Text**.

```
SI
u 30.00s 270.00 0.00 005 1b/4S235JRNEW
```

**Hard stamp placing**

<table>
<thead>
<tr>
<th>NC files</th>
<th>105</th>
<th>NC file settings</th>
</tr>
</thead>
</table>
The Side option defines the side of the part on which the hard stamp is placed.

The Position along the part and Position in depth of part options define the position of hard stamps on parts.

These options move the hard stamp on the same face it is created, but they cannot move the stamp to a different face. If the face is, for example, the bottom flange, you can move the stamp to a different place on bottom flange, but not to the top flange.

If you set the option By orientation mark to any value, the default face is changed from bottom (u) to top (o) for L profiles, rectangular tubes and round bars.

<table>
<thead>
<tr>
<th>Profile</th>
<th>Default face</th>
</tr>
</thead>
<tbody>
<tr>
<td>I profile</td>
<td>Bottom flange (u)</td>
</tr>
<tr>
<td>U and C profiles</td>
<td>Back side of web (i)</td>
</tr>
<tr>
<td>L profiles</td>
<td>Back (h) or Bottom (u)</td>
</tr>
<tr>
<td>Rectangular tubes</td>
<td>Bottom flange (u)</td>
</tr>
<tr>
<td>Round bars</td>
<td>Bottom flange (u)</td>
</tr>
<tr>
<td>Circular tubes</td>
<td>Front (v)</td>
</tr>
<tr>
<td>T profiles</td>
<td>Back side of web (i)</td>
</tr>
<tr>
<td>Plate profiles</td>
<td>Front (v)</td>
</tr>
</tbody>
</table>

For more information about hard stamps:
XSSECONDARY_PART_HARDSTAMP

Advanced Options tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of decimals</strong></td>
<td>Define the number of decimals shown in NC files.</td>
</tr>
<tr>
<td><strong>Change external contour (AK block) radius sign on top (o) and back (h) faces</strong></td>
<td>Change the AK block curve radius signs on top (o) and back (h) faces.</td>
</tr>
<tr>
<td><strong>Change internal contour (IK block) radius sign on top (o) and back (h) faces</strong></td>
<td>Change the IK block curve radius signs for on (o) and back (h) faces.</td>
</tr>
<tr>
<td><strong>Curve detection</strong></td>
<td>When Curve detection is set to Yes, Tekla Structures checks the edges to see if they are curved or straight based on the Chord tolerance value. Curve detection is on by default.</td>
</tr>
</tbody>
</table>

Below is an example, where the Change external contour (AK block) radius sign on top (o) and back (h) faces is not selected.
Below is an example, where the Change external contour (AK block) radius sign on top (o) and back (h) faces is selected.

<table>
<thead>
<tr>
<th>AR</th>
<th>0.00s</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>3000.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>115.98</td>
<td>-40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1356.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1316.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1086.75</td>
<td>155.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>115.98</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>1046.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

See also

Creating NC files in DSTV format on page 97

12.4 Customizing NC file header information

You can customize the order in which information is displayed in an NC file, and add additional information on individual parts in the NC file header.

To customize NC file header information:

1. Click File --> Export --> Create NC Files...
2. Click the Header... button in the NC Files dialog box.
3. In the NC File Header Information dialog box, arrange the file header information options in the desired order by selecting the option and using the Move up and Move down buttons.
4. If needed, add additional information on individual parts.
You can enter text in the **Text info on piece 1 – 4** boxes, and enter desired template attributes in double angle brackets, for example `< WEIGHT >` to display the weight of the part.

5. Click **OK**.

6. Create the NC files.

7. If you want to restore the default file header information, click the **Default** button in the **NC File Header Information** dialog box.

**See also**

*Creating NC files in DSTV format on page 97*
12.5 Pop-marks in NC files

Pop-marks are small holes that help the shop assemble individual parts to form an assembly. Tekla Structures can write the pop-mark information in NC files to help position parts that will be manually welded to the assembly main part. Pop-marks are usually made using a drilling machine that drills a small hole in the surface of the material.

Tekla Structures pop-marking does not work on polybeams.

Tekla Structures only creates pop-marks for parts for which you have defined pop-mark settings. You can save the pop-mark settings in a .ncp file, which Tekla Structures saves by default in the ..\attributes folder under the current model folder.

**NOTE** Pop-marking affects numbering.

For example, if two parts have different pop-marks, or one part has pop-marks and the other one does not, Tekla Structures gives the parts different numbers.

Tekla Structures displays thick red lines for each pop-mark pair in the model view which was last updated.

If needed, pop-marks can also be displayed in drawings. In drawings, select the on/off check box in the part properties to display the pop-marks.

**See also**

Creating pop-marks in NC files on page 109
Creating pop-marks in NC files

To create pop-marks in an NC file:

1. Click File --> Export --> Create NC Files.
2. In the NC Files dialog box, select the parts for which you want to create the pop-marks by selecting the corresponding check boxes in the Pop-marks column.
3. Click the Pop-marks button in the NC Files dialog box.
   The Pop-Mark Settings dialog box appears.
4. Click Add to add a new row.
5. To define which parts are pop-marked and where the pop-marks are created, click each item in a row.
   The order of the rows in the Pop-Mark Settings dialog box is important. Enter the most limiting definition first, and the most generic one last.
   a. In the Main part profile type list, select the main part profile type that is pop-marked. The list contains profiles according to the DSTV standard.
   b. In the Main part name column, enter the name for the main part profiles. You can enter several part names separated by commas, for example, COLUMN, BEAM. You can use wildcards (* ? [] ). For example, HE* matches all parts with a profile name that begins with the characters "HE".
   c. In the Sec part profile type list, select the secondary part profile type.
   d. In the Secondary part name column, enter the name for the secondary part profiles. You can enter several part names separated by commas. You can use wildcards (* ? [] ).
   e. In the Pop-mark location list, select how the secondary part is projected onto the main part.
      • Left side: The left side of the secondary part is marked on the main part. The left side is the side of the secondary part that is closest to the start point of the main part.
      • Right side: The right side of the secondary part is marked on the main part.
      • Both sides: Combines Left side and Right side.
      • Center: Center of the secondary part.
      • Left side holes: Marks the main part with the position of holes in the secondary part, on the left side of the secondary part.
      • Right side holes: Marks the main part with the position of holes in the secondary part, on the right side of the secondary part.
      • Both side holes: Combines Left side holes and Right side holes.
      • Middle line: Marks two points on the middle line of the secondary part x axis.
f. In the Move to flange list, select to which part of the main part flange the pop-marks are moved.

g. In the Edge distance column, enter the minimum distance from a pop-mark to the edge of the main part. Tekla Structures does not create pop-marks inside this distance.

If a pop-mark is inside the defined edge distance, Tekla Structures moves it, unless you have set Pop-mark location to Center.

h. In the Secondary pop-marks list, select whether pop-marks are created to the secondary parts.

6. If there are pop-marks in the back, go to the Pop-marking options tab, select one of the following and define the Hole diameter:

- Rotate part in if no pop-marks or items, for example, holes in front but some in the back.
- Rotate part and drill through pop-marks in the back if no other items in the front but some in the back or more pop-marks in the back than in front.
- Drill through pop-marks in the back, if no other items in the back.

7. If you do not want to have pop-marks on overlapping holes, select No pop-marks on overlapping holes.

8. To have pop-marks in the stud centers, select Pop-mark centers of studs.

9. To show pop-marks in the model, select Show pop-marks in the model.

10. Click OK.

11. Select the parts in the model.

12. Click Create in the NC Files dialog box.

Pop-marks are written in the BO block in the DSTV file as 0 mm diameter holes.

**Examples**

Tekla Structures marks the center point of all round secondary profiles on a main part, and does not create pop-marks closer than 10 mm to the main part edge.

<table>
<thead>
<tr>
<th>Parts to pop-mark</th>
<th>Pop-marking options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part type</td>
<td>Main part name</td>
</tr>
<tr>
<td>Sec part profile type</td>
<td>Secondary part name</td>
</tr>
<tr>
<td>Pop-mark location</td>
<td>Move to flange</td>
</tr>
<tr>
<td>Edge distance</td>
<td></td>
</tr>
</tbody>
</table>

All profiles * Round bar * Center None 10.00

Tekla Structures projects the hole location in the secondary plates onto a main part.

<table>
<thead>
<tr>
<th>Parts to pop-mark</th>
<th>Pop-marking options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part type</td>
<td>Main part name</td>
</tr>
<tr>
<td>Sec part profile type</td>
<td>Secondary part name</td>
</tr>
<tr>
<td>Pop-mark location</td>
<td>Move to flange</td>
</tr>
<tr>
<td>Edge distance</td>
<td></td>
</tr>
</tbody>
</table>

All profiles * All profiles "PLATE" Both side holes None 1.00

Pop-marks in NC files on page 108
12.6 Contour marking in NC files

Tekla Structures can generate contour marking in NC files. This means that information on the layout and the parts that are welded together can be added to the NC files and passed on to the machine tool.

Tekla Structures contour marking does not work on polybeams.

Tekla Structures only creates contour markings for parts for which you have defined contour marking settings. You can save the contour marking settings in a .ncs file, which Tekla Structures saves by default in the ..\attributes folder under the current model folder.

You can add contour marking to both the main and the secondary parts.

**NOTE** Contour marking affects numbering.

For example, if two parts have different contour markings, or one part has contour markings and the other one does not, Tekla Structures gives the parts different numbers.

See also

Creating contour marking in NC files on page 112

Creating contour marking in NC files

To create contour marking in an NC file:

1. Click File --> Export --> Create NC Files.
2. In the NC Files dialog box, select the parts for which you want to create the contour marks by selecting the corresponding check boxes in the Contour marking column.
3. Click the Contour marking button in the NC Files dialog box.
   The Contour marking settings dialog box appears.
4. Click Add to add a new row.
5. To define which parts are contour marked and how they are contour marked, click each item on a row.
   a. In the Main part profile type list, select the main part profile type that is contour marked. The list contains profiles according to the DSTV standard.
b. In the **Main part name** column, enter the name for the main part profiles. You can enter several part names separated by commas, for example, **COLUMN, BEAM**.

You can use wildcards (*** ? [ ]**). For example, **HE*** matches all parts with a profile name that begins with the characters "HE".

c. In the **Sec part profile type** list, select the secondary part profile type.

d. In the **Secondary part name** column, enter the name for the secondary part profiles. You can enter several part names separated by commas.

You can use wildcards (*** ? [ ]**).

e. In the **Secondary contour marking** list, select whether the secondary parts are contour marked.

f. In the **Punch or powder** list, select how the part is contour marked.

- **Punch**: The part is punched.
- **Powder**: The part is marked with powder.
- **Both**: Both techniques are used.

g. In the **Hard stamp** list, select whether hard stamps are created.

h. Select whether you want to mark parts that are welded on site in **Mark parts welded on site**.

6. Define the minimum distance from a contour mark to the edge of the main part in **Edge distance**. Tekla Structures does not create contour marks inside this distance.

7. Click **OK**.

8. Select to create files for all parts or selected parts.

9. Click **Create** in the **NC Files** dialog box.

Contour marking is written in the **PU** and **KO** blocks in the DSTV file.

Tekla Structures displays contour marking as thick magenta lines in the model view.
12.7 Creating NC files in DXF format

You can also create NC files in DXF format by converting DSTV files to DXF files. Before running a DXF conversion, you must first create the NC files in DSTV format.

To convert DSTV files to DXF files:

1. Create the NC files in the DSTV format.
2. Click the Applications and Components button in the upper-right corner of the Tekla Structures main window to open the Applications and Components catalog.
3. Click the arrow next to Applications to open the applications list.
4. Double-click Convert_DSTV2DXF to open the Convert DSTV Files to DXF dialog box.
5. Browse for the folder that contains the NC files you want to convert to DXF files.
6. Select the NC files and click Open.

Tekla Structures automatically creates an NC_dxf folder in the model folder and the DXF files are created there.

If you want to check the converted DXF files, select Yes in the dialog box that appears after the DXF files have been created. The DXF files open in Tekla DWG Viewer.
WARNING The macro has been designed for simple plates. Therefore it may not give correct conversion results for beams, columns and bent polybeams.

Creating NC files using dstv2dxf.exe program

Alternatively, you can use a separate Tekla Structures program dstv2dxf.exe to convert the DSTV files to DXF format. The program is located in the ..\Tekla Structures \<version>\nt\dstv2dxf folder. Only one side of a part (front, top, back or bottom) is written to the file, and therefore this export format is most suited to plates.

To start the conversion:

1. Create a folder for the NC files, for example c:\ dstv2dxf.

   Do not use spaces in the folder path. You should not save the files, for example, in the Tekla Structures folder under the Program Files folder, because the folder path contains spaces.

2. Copy all files from C:\Program Files\Tekla Structures\<version>\nt \dstv2dxf to the folder you created (C:\dstv2dxf).

3. Save the NC files in the in the folder you created (C:\dstv2dxf).


   The program converts the files to DXF format in the same folder.

If you need to adjust the conversion settings, modify the settings in an appropriate dstv2dxf.def file and restart the conversion.

For more information on settings, see the DEF File Description.pdf document in the same folder.

See also

Creating NC files in DSTV format on page 97

12.8 Fittings and line cuts in NC files

When creating NC files in DSTV format, the method you use to cut the end of the beam affects the beam length in the NC file:

- **Fittings** affect the length of the beam in the NC file.
- **Line cuts** do not affect the length of the beam in the NC file.

When you cut the beam end, use the fitting method to make sure that the beam length is correct in the NC file.

The overall length of a beam will be the fitted net length of the beam. This means that Tekla Structures always takes the fitting into account when calculating the beam length.
For lines, polygons, or part cuts, the cut does not affect beam length, but the overall length in the NC file will be the gross (initially modeled) length of the beam.

1. Fitting
2. Line cut
3. Polygon or line cut
4. Fitting

**Shortest length**

If you want to use the shortest possible length in an NC file, use the advanced option `XS_DSTV_NET_LENGTH`.

**Net and gross length**

If you want to include both net and gross length into NC file header data, use the advanced option `XS_DSTV_PRINT_NET_AND_GROSS_LENGTH`.

See also

Creating NC files in DSTV format on page 97

`XS_DSTV_NET_LENGTH`

`XS_DSTV_PRINT_NET_AND_GROSS_LENGTH`

12.9 Creating tube NC files

To be able to create NC files for tubular hollow sections, you need to first use the specific tube components to create the tube-to-tube and tube-to-plate connections:

- Tube-Chamfer (1)
- Tube-CrossingSaddle (1)
- Tube-MitreSaddle+Hole (1)
• Tube-Saddle+Hole (1)
• Tube-SlottedHole (1)

After using the components, you can create an NC file for data export. The tube NC file creation results into an XML file which includes the model data.

To create tube NC files:

1. Click **File** --&gt; **Export** --&gt; **Create Tube NC Files...** to open the **Tube NC Files** dialog box.
2. Enter a name for the export file, and browse for the location where you want to save the file.
3. Select whether you want to create the file for selected parts or for all parts.
4. Click **Create**.

   Tekla Structures creates an XML file and a log file in the location you defined.

---

**WARNING** To get the correct tube NC export results, note the following limitations:

- Part cuts and polygon cuts are not supported, and they will not be exported.
- Line cuts and fittings created manually or by other components will be exported as simple chamfers.
- Holes created by bolts are not supported, and they will not be exported.

---

**See also**

Tube-Chamfer (1)
Tube-CrossingSaddle (1)
Tube-MitreSaddle+Hole (1)
Tube-Saddle+Hole (1)
Tube-SlottedHole (1)
You can import a PDF as a reference model to your model. During import, Tekla Structures converts the PDF into the DXF format. Only vector graphics are converted.

**See also**

Importing a PDF to a model on page 118

### 13.1 Importing a PDF to a model

To import a PDF as a reference model:

1. Click File --&gt; Insert PDF document...
   
   The **Insert PDF Reference Model** dialog box opens.

2. Click **Browse**...

3. Browse for the PDF and click **Open**.

4. Set the scale for the reference model.

5. Enter the page number that you want to import.

6. Click **OK**.

7. Pick a point to place the reference model.

   Tekla Structures converts the PDF into the DXF format. The conversion creates a DXF file for every imported page. Tekla Structures saves the DXF files to the same folder where the PDF is.

**Limitations**

Only vector graphics are converted, not raster graphics.
The DGN format has been used especially for data transfer between plant design programs. It was developed by MicroStation. It is similar to DWG in that it is only a graphical data format. It contains unique part IDs in the given model. It is possible to check for clashes between the Tekla Structures model and a DGN reference model.

This format has the following limitations:

- GUID is not supported
- Change management is not possible with a DGN file.

See also

- Reference models on page 33
- Inserting a reference model on page 34
- Exporting to 3D DGN files on page 121

## 14.1 DGN import

You can import DGN models as reference models to Tekla Structures. You can view DGN model objects in different reference model layers according to the level settings in the DGN file. You can use DGN models for clash checking. Tekla Structures reference model import supports V7 and V8 DGN formats.

A DGN file can contain one or more DGN models. A DGN model can be one of three types: a design model, an extrusion model or a sheet model. Design models are most useful in Tekla Structures as they contain appropriate structural data. If there are many model types available in a DGN file, Tekla Structures selects the imported model type in the following order:

1. Active model is imported if it is a design model.
2. Default model is imported if it is a design model.
3. If DGN file contains design models, the first one is imported.
4. If there are no design models in the DGN file, the first model regardless of model type is imported.
You can view a log about DGN import on the **Log file** tab in **MessageDialog (Tools --> Toolbars --> Message Panel)**.

**See also**

- Inserting a reference model on page 34
- Supported DGN objects on page 120

## Supported DGN objects

Tekla Structures can display the following DGN objects in reference models:

<table>
<thead>
<tr>
<th>Object</th>
<th>Type no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell</td>
<td>2</td>
<td>A collection of grouped entities with a common insertion point/origin, scale and orientation in 2D/3D space.</td>
</tr>
<tr>
<td>Line</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Line string</td>
<td>4</td>
<td>A series of interconnected lines.</td>
</tr>
<tr>
<td>Shape</td>
<td>6</td>
<td>Like a line string, but closed (first point = last point).</td>
</tr>
<tr>
<td>Text node</td>
<td>7</td>
<td>A multi-line paragraph/block of text.</td>
</tr>
<tr>
<td>Curve</td>
<td>11</td>
<td>A parametric spline curve.</td>
</tr>
<tr>
<td>Complex chain</td>
<td>12</td>
<td>A chained collection of other entities (lines, line strings, arcs, curves or b-spline curves).</td>
</tr>
<tr>
<td>Complex shape</td>
<td>14</td>
<td>Like a complex chain, but closed (first point = last point).</td>
</tr>
<tr>
<td>Ellipse</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>17</td>
<td>Supports TrueType fonts and text styles (bold, underline, italic, etc).</td>
</tr>
<tr>
<td>3D surface</td>
<td>18</td>
<td>Like a 3D solid, but not capped on the ends.</td>
</tr>
<tr>
<td>3D solid</td>
<td>19</td>
<td>The solid created by projecting or rotating from a boundary entity (line, line string, curve, arc or ellipse).</td>
</tr>
<tr>
<td>Cone</td>
<td>23</td>
<td>Actually a truncated cone described by two parallel circles; if the radius of both circles is the same, a cylinder is produced.</td>
</tr>
<tr>
<td>B-spline surface</td>
<td>24</td>
<td>See description of b-spline curves, which also applies here; additional data is provided by surface boundary entities (type 25).</td>
</tr>
<tr>
<td>B-spline curve</td>
<td>27</td>
<td>Can be rational/non-rational, uniform/non-uniform, open/closed; entity type 27 supplies</td>
</tr>
</tbody>
</table>
header data and additional data is provided by pole entities (type 21), knot entities (type 26) and weight factor entities (type 28).

**Shared cell definition** 34  Similar to a DWG block definition; basically defines a set of grouped entities.

**Shared cell instance** 35  Similar to a DWG block instance; given a particular cell 'definition', numerous cell 'instances' can be created at differing locations, scales and orientations.

**Multiline** 36  A set of parallel lines, which can be jointed (with or without visible seams at the joints), and have various types of end caps (rounded, square, etc).

**Mesh** 105  Supports indexed face loops, quad list, quad grid, triangle grid and triangle list meshes.

**Smart solid**  -  Smart solids (solids created from embedded Parasolid/ACIS data) can be imported into Tekla Structures as wireframe outlines.

### Limitations

The following objects have specific limitations:

<table>
<thead>
<tr>
<th>Object</th>
<th>Type no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point string</td>
<td>22</td>
<td>Not supported. (A point string is a series of points with associated orientations; point strings are typically used for defining walkthrough paths).</td>
</tr>
<tr>
<td>Dimension</td>
<td>33</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Mesh</td>
<td>105</td>
<td>The point cloud mesh type is not currently supported.</td>
</tr>
<tr>
<td>Smart solid</td>
<td>-</td>
<td>Smart solids (solids created from embedded Parasolid/ACIS data) are currently supported as wireframe outlines only; for this reason, smart solids do not currently participate in clash checking operations.</td>
</tr>
</tbody>
</table>

### See also

- Inserting a reference model on page 34
- DGN import on page 119
14.2 Exporting to 3D DGN files

You can export selected parts or the whole model to 3D DGN.

To export a 3D DGN file:

1. Open a Tekla Structures model.
2. Click File --> Export --> 3D DGN... to open the Export 3D DGN dialog box.
3. In the Output file box, enter the name of the export file.
   If you want to replace an already existing file, click the ... button and browse for the file.
4. In the Export list, select All objects, or Selected objects and select the parts to export.
5. Click Create.

   Tekla Structures creates the <name>.dgn file in the current model folder.

See also

If you have tubular parts in your model and you want to reduce the size of the DGN files or
the complex display in the rendered views, you can use the following advanced options to
control this:

You can also use the following advanced options to control DGN exports:
Computer-aided design (CAD) means that you can create, modify, analyze, and optimize a design using software. CAD software applications are available for generic design or specialized use, such as for architectural or plant design. More complex forms of CAD are solid modeling and parametric modeling, which allow objects to be created with real-world characteristics. In parametric modeling, objects have meaningful relationships with each other.

In Tekla Structures, the CAD import tool supports several different formats to import models, and is able to import a maximum of 10,000 parts. If the number of parts exceeds this, Tekla Structures displays a warning message, and does not import the model.

See also
Conversion files on page 28
CAD model import settings on page 129
CAD model export settings on page 135

15.1 CAD import and export formats

You can import to and export from Tekla Structures the following file types using the CAD import tool.

<table>
<thead>
<tr>
<th>Option</th>
<th>Import</th>
<th>Export</th>
<th>Imports from/Exports to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF</td>
<td>x</td>
<td>x</td>
<td>SDNF (Steel Detailing Neutral File) is used in importing to and exporting from several different CAD systems.</td>
</tr>
<tr>
<td>HLI</td>
<td>x</td>
<td>x</td>
<td>HLI (High Level Interface). IEZ AG Speedikon software</td>
</tr>
<tr>
<td>Plantview</td>
<td>x</td>
<td></td>
<td>Plantview design system</td>
</tr>
</tbody>
</table>
### 15.2 Importing an SDNF model

To import an SDNF file:

1. Select File --> Import --> CAD...
   The Import Models dialog box is displayed.
2. Select Import CAD from the Type list.
3. Use the default name import model or enter a new name.
4. Click OK.
5. Select the model from the list.
6. Click Properties to open a dialog box where you can define the settings for the import file:
   - You can load the standard parameters for PDS and PDMS SDNF files with the Load option.
   - On the Conversion tab, enter the conversion file names or browse for the conversion files.
   - On the Parameters tab, enter the name of the SDNF file you want to import in the Input file box, or use the default name.

SDNF files normally have a * .dat extension. The version number for SDNF 3.0 files can be found in the header if you open the file with a text editor.

---

<table>
<thead>
<tr>
<th>Option</th>
<th>Import</th>
<th>Export</th>
<th>Imports from/Exports to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF (PDMS)</td>
<td>x</td>
<td>x</td>
<td>Plant Design Management System. Aveva 3D plant design software. Data is exported to PDMS via SDNF link. Tekla Structures writes the information of finish field in the member class attribute, whereas in SDNF export it omits the class information.</td>
</tr>
<tr>
<td>XML</td>
<td>x</td>
<td>x</td>
<td>ArchiCAD modeling system. There are some limitations in the export: • Conversion files are not used. • Holes, bolts and welds are not exported.</td>
</tr>
<tr>
<td>PDMS</td>
<td></td>
<td>x</td>
<td>Outdated format. We do not recommend using this option.</td>
</tr>
<tr>
<td>SCIA</td>
<td></td>
<td>x</td>
<td>SCIA is used for SteelFab interface.</td>
</tr>
</tbody>
</table>
• On the **Parameters** tab, set the file **Type** to SDNF, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.

• Set the SDNF options on the **SDNF** page:
  • In the **Part Pos_No** area enter a prefix and a start position number. This relates to the **Position number type** setting.
  
  • In **SDNF version number**, select the SDNF format type (2.0 or 3.0). SDNF 3.0 is generally the format to select. However, with StruCAD it is better to share SDNF 2.0 files.
  
  • Set **Apply cuts and fittings** to **Yes** (default) to apply cuts and fittings in the import. These will only be included if contained within the SDNF file.
  
  • Set **Consider offsets** to **Yes** to create offsets. In most cases you should select **Yes. No** (default) positions part creation points at part end points.
  
  • You can create a log file. If the import fails, examine the log file to find out why. Check the log file even if the import seems to have succeeded. In the **Create log** file, you can select **Create** to write a new log file, and delete the previous log file, each time you import the model. If you select **Append** (default), the log file information is added at the end of the existing log file.
  
  • You can also select how the log file is displayed, the options being **With an external viewer** (like Microsoft Notepad), **Not viewed**, and **In a dialog box**, which creates a separate list dialog box in which the file can only be viewed.
  
  • Enter the log file name or browse for an existing log file.
  
  • The SDNF file contains identifiers that can be included in a part’s user-defined attributes, or used as position numbers. In **Position number type**, select **Part position** if you want the identifier to become the part’s position number. Do not use the **Part Pos_No** fields with this option. Select **Universal ID** if you want the identifier to become a user-defined attribute for the part. In most cases, you would select **Universal ID**. To make user-defined attributes visible, you need to add them to the **objects.inp** file. For file imports from PDS or PDMS then the Universal ID option is the normal case

• If you wish to create a report of the import, enter the required information on the **Report** tab.

• On the **Advanced** tab, you can set some advanced options. Usually there is no need to change the defaults.

  7. Click **OK** to go to the **Import Model** dialog box.

  8. Select the import model name from the list and click **Import**.

      You can also click the **New** or **Properties** buttons if you require to make some changes.

      Tekla Structures displays the **Import model info** dialog box.

  9. Select which version of parts to import.
10. Click **Accept all**.

   The **Accept all** option is generally used if importing a new model over an existing one. If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

   **NOTE** If you want to import information, which Tekla Structures parts do not have, you can use the SDNF extension line in the SDNF file to be imported, and the **REVISION_NUMBER** user-defined attribute in Tekla Structures.

See also

**CAD model import settings on page 129**
15.3 Importing a Plantview model

To import a Plantview model:

1. Select File --> Import --> CAD...

   The New Import Model dialog box is displayed.

2. Select Import CAD.

3. Use the default name import model or enter a new name.

4. Click OK.

5. Select the model from the list.

6. Click Properties... to open a dialog box where you can define the settings for the import file type you selected:
   - On the Conversion tab, enter the conversion file names or browse for the conversion files.
   - On the Parameters tab, enter the name of the Plantview file you want to import in the Input file box, or use Browse to locate the file.
   - Set the file type to Plantview in the Type box, and set the origin coordinates in the Origin boxes if you want the file in a specific location.
   - Set the material grade in the Material box on the SDNF tab.
     You can also click ... next to the box, and browse for the material grade in the Select Material dialog box.
   - If you wish to create a report of the import, enter the required information on the Report tab.
   - If you are importing the model for the first time, you do not need to change the default values on the Advanced tab.

7. Click OK to go to the Import Model dialog box.

8. Click Import.

   Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all.

    If you have changed the model and want to re-import it, you can also reject all changes by clicking Reject all, or accept or reject individual changes by clicking Select individual....

11. Tekla Structures displays the message Do you want to save the import model for subsequent imports? Click Yes.

    Tekla Structures displays the imported model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the imported model is completely visible.
13. If parts are missing, check the View depth Up and Down values in the View Properties dialog box and change them if necessary.

See also

CAD model import settings on page 129

15.4 Importing a SteelFab/SCIA model

To import a SteelFab/SCIA model:

1. Select File --> Import --> CAD...
   The Import Models dialog box is displayed.
2. Select Import SteelFab/SCIA from the Type list.
3. Use the default name import model or enter a new name.
4. Click OK.
5. Select the model from the list.
6. Click Properties... to open a dialog box where you can define the settings for the import file:
   • Enter the input file name.
   • Enter the conversion file names.
   • Set the origin coordinates in the Origin boxes if you want the file in a specific location
   • Set Import weldings to Yes to include welds in the model.
   • Set Import holes to Yes to include holes in the model.
7. Click OK.
8. Click Import.
9. Select which version of parts to import.
10. Click Accept all.
11. If you have changed the model and want to re-import it, you can also reject all changes by clicking Reject all, or accept or reject individual changes by clicking Select individual....
12. Tekla Structures displays the message Do you want to save the import model for subsequent imports? Click Yes.
   Tekla Structures displays the import model in a model view.
13. Right-click the model view and select Fit work area to entire model to ensure that the imported model is completely visible.
14. If parts are missing, check the View depth Up and Down values in the View Properties dialog box and change them if necessary.

See also

CAD model import settings on page 129

15.5 CAD model import settings

The settings related to importing various types of models through the Import Model dialog box are listed below. All of the tabs and settings are not available for all import types. The import types are listed next to the settings, so that you can see which import type the settings belong to. The Import Model dialog box is displayed when you click Properties in the Import Models or New Import Model dialog box.

Conversion tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile conversion file</td>
<td>Set the conversion files you want to use.</td>
<td>CAD, FEM, CIS Model/CIMSteel, Eureka LMP, MicasPlus, SteelFab/SCIA</td>
</tr>
<tr>
<td>Material conversion file</td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software. For SteelFab/SCIA, these options are located on the Parameters tab.</td>
<td></td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Advanced tab

| Action when object status is (compared to) | Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be New, Modified, Deleted, or Same. Tekla Structures compares the state of imported objects with those in your model. They can be Not in model, Different, or Same. Use the options under Not in model, Different, and Same to specify the actions when importing changed objects. The options are No action, Copy, Modify, or Delete. | CAD, FEM, MicasPlus, Eureka LMP, CIS Model/CIMSteel |

See also

CAD model import settings on page 129
### Parts tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Pos_No</td>
<td>Enter a prefix and a start position number.</td>
<td>FEM</td>
</tr>
<tr>
<td>Assembly Pos_No</td>
<td>For SDNF, this option is located on the <strong>SDNF</strong> tab.</td>
<td></td>
</tr>
</tbody>
</table>

### Parameters tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input file or ASCII file name</strong></td>
<td>The file you want to import. You can also browse for the file.</td>
<td>All</td>
</tr>
<tr>
<td><strong>Type or Model type</strong></td>
<td>Set the input file or model type:</td>
<td>CAD, FEM, CIS Model/CIMSteel</td>
</tr>
<tr>
<td></td>
<td>CAD: SDNF, Calma, HLI, Plantview, SDNF (PDMS), XML</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FEM: DSTV, SACS, Monorail, Staad, Stan 3d, Bus CSM Model/CIMSteel: Design, Analysis, SP3D.</td>
<td></td>
</tr>
<tr>
<td><strong>CIS version</strong></td>
<td>Select CIS/1 or CIS/2:</td>
<td>CIS Model/CIMSteel</td>
</tr>
<tr>
<td></td>
<td>• CIS/1 imports files compatible with the CIMsteel LPM4DEP1 schema declaration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CIS/2 imports files compatible with the CIMsteel CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema declaration.</td>
<td></td>
</tr>
<tr>
<td><strong>Input scope</strong></td>
<td>Import the Entire model or Selection only.</td>
<td>CIS2 status</td>
</tr>
<tr>
<td><strong>Part rotation</strong></td>
<td>Select Front or Top.</td>
<td>MicasPlus</td>
</tr>
<tr>
<td><strong>Origin X, Y, Z</strong></td>
<td>Set the origin coordinates to place the file in a specific location.</td>
<td>CAD, FEM, CIS Model, Eureka LPM, MicasPlus, SteelFab/SCIA</td>
</tr>
<tr>
<td><strong>Default yield stress limit</strong></td>
<td>The Default material when yield stress &lt; limit setting is used for SACS import file. Define the material to use if yield stress is less than the limit.</td>
<td>FEM</td>
</tr>
<tr>
<td><strong>Default material when yield stress &gt;= limit</strong></td>
<td>The setting Default material when yield stress &gt;= limit is used for SACS or DSTV import files. For SACS, this field defines the material to use if yield stress is greater than or equal to the limit. For DSTV you can enter the material grade here, if it is not included in the import file.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Import type</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Combine members</strong></td>
<td>To combine several elements in the FEM or CIS model into one part in Tekla Structures, set Combine members to Yes. For example, if a beam in a file consist of more than one element, and you select Yes, the elements are combined to form one beam in the Tekla Structures model. If you use the value No, Tekla Structures creates a beam for each element in the FEM or CIS model. <strong>Max length for combining</strong> is only applied if you set Combine members to Yes. Use this setting to define the maximum length for combining parts. Tekla Structures combines elements into one part only if their combined length is less than the value you enter here.</td>
<td>FEM</td>
</tr>
<tr>
<td><strong>Max length for combining</strong></td>
<td></td>
<td>CIS Model/ CIMSteel</td>
</tr>
<tr>
<td><strong>Ignore offsets</strong></td>
<td>CIS/1 and CIS/2 analysis models can include member offsets, which means that nodes are not exactly at the beam’s end points. With the default Yes, Tekla Structures uses these offsets to locate the physical members. With No, Tekla Structures determines the location using the node locations.</td>
<td>CIS/CIMSteel</td>
</tr>
<tr>
<td><strong>Ignore forces</strong></td>
<td>Use to define how forces are imported. With No, Tekla Structures imports absolute values of maximum forces to parts’ user-defined attributes Shear, Tension and Moment. With Yes, Tekla Structures does not import forces.</td>
<td>CIS/CIMSteel</td>
</tr>
<tr>
<td><strong>Import GUID (design model)</strong></td>
<td>The part GUID is included in the import.</td>
<td>CIS/CIMSteel</td>
</tr>
<tr>
<td><strong>Create log file</strong></td>
<td>Select Create to write a new log file and delete the previous log file each time you import the model. Select Append (default) to add the log file information is at the end of the existing log file. If you do not need a log file, select No. In SDNF, this option is on the SDNF tab.</td>
<td>CAD (SDNF) CIS2 status</td>
</tr>
<tr>
<td><strong>Display log file</strong></td>
<td>Select With an external viewer to display the log file in an external viewer, like Microsoft Notepad. If you do not want to display the file, select Not viewed.</td>
<td>CAD (SDNF) CIS2 status</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Import type</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Select In a dialog box</td>
<td>To create a separate list dialog box in which the file can only be viewed. In SDNF, this option is on the SDNF tab.</td>
<td></td>
</tr>
<tr>
<td>Import weldings</td>
<td>Include weldings in the imported model.</td>
<td>SteelFab/SCIA</td>
</tr>
<tr>
<td>Import bolt holes</td>
<td>Include bolt holes in the imported model.</td>
<td>SteelFab/SCIA</td>
</tr>
</tbody>
</table>

**Report tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create report</td>
<td>Set to Yes to create a report.</td>
<td>CAD</td>
</tr>
<tr>
<td>Display report</td>
<td>Set to Yes to display the report.</td>
<td>CAD</td>
</tr>
<tr>
<td>Report template</td>
<td>Select the report template.</td>
<td>CAD</td>
</tr>
<tr>
<td>Report file name</td>
<td>Enter the report file name or browse for a report file.</td>
<td>CAD</td>
</tr>
</tbody>
</table>

**SDNF tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Pos_No</td>
<td>Enter a prefix and a start position number. This setting relates to the Position number type setting.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>SDNF version number</td>
<td>Set the SDNF format type to 2.0 or 3.0.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Apply cuts and fittings</td>
<td>Set to Yes (default) to apply cuts and fittings in the import.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Consider offsets</td>
<td>Set to Yes to create offsets. In most cases you should select Yes. No (default) positions part creation points at part end points.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Log file name</td>
<td>Enter the log file name or browse for an existing log file.</td>
<td>CAD (SDNF)</td>
</tr>
<tr>
<td>Position number type</td>
<td>The SDNF file contains identifiers that can be included in a part's user-defined attributes, or used as part position numbers. Select Part position if you want the identifier to become the part's position number. Do not use the Pos_No option with this option. Select Universal ID if you want the identifier to become a user-defined attribute for the part.</td>
<td>CAD (SDNF)</td>
</tr>
</tbody>
</table>
### Plantview Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material</strong></td>
<td>Select the material grade.</td>
<td><strong>CAD</strong> (Plantview) <strong>FEM</strong> (Staad)</td>
</tr>
</tbody>
</table>

### DSTV Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
<td>Select the DSTV version.</td>
<td><strong>FEM</strong> (DSTV)</td>
</tr>
<tr>
<td><strong>Import static elements</strong></td>
<td>If the DSTV file to be imported contains a static and a CAD model, you can choose which one to import.</td>
<td><strong>FEM</strong> (DSTV)</td>
</tr>
<tr>
<td><strong>Import other elements</strong></td>
<td>Answering Yes to <strong>Import static elements</strong> imports the static model.</td>
<td><strong>FEM</strong> (DSTV)</td>
</tr>
<tr>
<td></td>
<td>Answering Yes to <strong>Import other elements</strong> imports the CAD model.</td>
<td></td>
</tr>
</tbody>
</table>

### Stan 3d

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scale</strong></td>
<td>Specify the scale of the import model. You can import Stan 3d without specifying the scale as long as both the Tekla Structures model and the import model are in millimeters. If the Stan 3d file is in millimeters, use the scale 1. If the Stan 3d file is in meters, use the scale 1000.</td>
<td><strong>FEM</strong> (Stan 3d)</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Enter the material for the parts to import.</td>
<td><strong>FEM</strong> (Stan 3d)</td>
</tr>
</tbody>
</table>

### Bus Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pos_No</strong></td>
<td>Indicate the <strong>Pos_No</strong> of the girders, columns, braces and cantilevers you import.</td>
<td><strong>FEM</strong> (Bus)</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Enter the material for the parts to import.</td>
<td><strong>FEM</strong> (Bus)</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Enter the name of the parts to import.</td>
<td><strong>FEM</strong> (Bus)</td>
</tr>
<tr>
<td><strong>Class</strong></td>
<td>Enter the class of the parts to import.</td>
<td><strong>FEM</strong> (Bus)</td>
</tr>
</tbody>
</table>
### Option Table

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beams behind plane</td>
<td>The value Yes aligns the tops of all beams at the floor level.</td>
<td>FEM (Bus)</td>
</tr>
</tbody>
</table>

### Advanced tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Import type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action when object status is (compared to)</td>
<td>Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be New, Modified, Deleted, or Same. Tekla Structures compares the state of imported objects with those in your model. They can be Not in model, Different, or Same. Use the options under Not in model, Different, and Same to specify the actions when importing changed objects. The options are No action, Copy, Modify, or Delete.</td>
<td>CAD, FEM, MicasPlus, Eureka LMP, CIS Model/ CIMSteel</td>
</tr>
</tbody>
</table>

### See also

- Importing an SDNF model on page 124
- Importing a Plantview model on page 126
- Importing a SteelFab/SCIA model on page 128

### 15.6 Exporting to CAD

You can export a CAD model in several formats.

**NOTE** Before you start an SDNF export, check that the advanced option X5_SDNF_CONVERT_PL_PROFILE_TO_PLATE has not been set on the Export page of the Advanced Options dialog box.

To export a CAD model:

1. Open a Tekla Structures model.
2. Click File --> Export --> CAD... to open the CAD export dialog box.
3. Enter the paths to the required conversion files on the Conversion tab.
4. Go to the Parameters tab, and give a name to the export file in the Output file box. You can also browse for the file.
5. Select the export format from the Type list.
6. Use the Origin X, Y, Z boxes to specify the origin of the exported model.

7. In PML export, define PML-specific information on the PML tab.

8. In SDNF, SDNF (PDMS) and PDMS export, go to the SDNF tab, and define the necessary information.

9. Select the parts in the model to export.

10. Click Apply and Create.

    Tekla Structures creates the export file in your current model folder.

See also

CAD model export settings on page 135
CAD import and export formats on page 123

15.7 CAD model export settings

Settings related to exporting various types of models through the Export CAD dialog box are listed below. FEM export settings are also described. All of the tabs and settings are not available for all export types. The export types are listed next to the settings, so that you can see which export type the setting belongs to. The Export CAD dialog box is displayed when you select File --> Export --> CAD...

Conversion tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile conversion file</td>
<td>Set the conversion files you want to use.</td>
<td>All</td>
</tr>
<tr>
<td>Material conversion file</td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
<td>All</td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td></td>
<td>All</td>
</tr>
</tbody>
</table>

Parameters tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output file</td>
<td>The file name of the exported file. You can also browse for the file.</td>
<td>All</td>
</tr>
<tr>
<td>Type</td>
<td>Select the export format.</td>
<td>All</td>
</tr>
<tr>
<td>Origin X, Y, Z</td>
<td>Set the origin coordinates to place the exported model in a specific location.</td>
<td>PML, SDNF, XML</td>
</tr>
<tr>
<td>Split members</td>
<td>Splits a part in the Tekla Structures model into several elements in the STAAD or DSTV model.</td>
<td>FEM</td>
</tr>
</tbody>
</table>
### Combine segmented members (MicroSAS)

Gives you the option to combine multiple parts to form one part in the exported model.

For example, if you have divided a beam into several elements and select the Yes option, Tekla Structures combines the elements so that they form one beam in the exported model. With the option No every element of the beam in the model forms individual beams.

### PML tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units (for PML only)</td>
<td>Select the units for the export model.</td>
<td>PML</td>
</tr>
<tr>
<td>Export cut parts</td>
<td>Controls whether cuts are included in the export. Yes exports part cuts.</td>
<td>PML</td>
</tr>
<tr>
<td></td>
<td>When you use PML, enter the Tekla Structures profile names in the conversion file. This makes the other software consider parts as beams and columns, not as plates, and reduces the export file size.</td>
<td></td>
</tr>
</tbody>
</table>

### SDNF tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF version number</td>
<td>Select the SDNF version to be used in the export. With StruCAD, use SDNF version 2.0.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Apply cuts and fittings</td>
<td>Select Yes (default) applies cuts and fittings in the export.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
</tbody>
</table>
| Position number type    | The SDNF file contains identifiers, which can be included in a part's user-defined attributes, or as position numbers. You have the following options:  
  - Part position  
    The identifier becomes the part's position number. Do not use the Part Pos_No fields with this option.  
  - Assembly position  
    The identifier becomes the assembly's position number. | SDNF, SDNF(PDMS), PDMS |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal ID</td>
<td>The identifier becomes a user-defined attribute for the part. To make user-defined attributes visible, you need to add them to the objects.inp file.</td>
<td></td>
</tr>
<tr>
<td>Consider offsets</td>
<td>To ignore the offset records during export, select <strong>No</strong>, and to take them into account, select <strong>Yes</strong>. This setting does not affect the actual start and end point information, only the offset. Tekla Structures writes the start and end points based on the actual solid object, not on the reference line.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>PDMS phase offset</td>
<td>PDMS phase offset defines phase offset for exported parts. For example, if the first phase in Tekla Structures model is 1 and you enter 10 for phase offset, Tekla Structures parts in another software get the phase from 11 and up.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Engineering firm</td>
<td>Enter the name of the engineering company.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Client</td>
<td>Enter the name of the client.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Structure ID</td>
<td>Enter a unique identification number for the exported model.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Project ID</td>
<td>Enter a unique identification number for the exported project.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Revision number</td>
<td>Enter an optional revision number. Tekla Structures takes the revision number from the user-defined attributes (REVISION_NUMBER) of the model. If this field is blank, Tekla Structures uses a revision number from the CAD export dialog box (Revision Number).</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Issue code</td>
<td>Tekla Structures writes an issue code in the header section of the output file. For PDMS, this value should always be &quot;Tekla Structures&quot;.</td>
<td>SDNF, SDNF(PDMS), PDMS</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Export type</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Design code</td>
<td>Define the design code to be used in structural design.</td>
<td>SDNF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDNF(PDMS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDMS</td>
</tr>
</tbody>
</table>

**XML tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Specify unit conversions (MM, M, IN, FT). For example, for a Tekla Structures model created using millimeters, select IN to convert all part dimensions to inches in the output file.</td>
<td>XML</td>
</tr>
<tr>
<td>XML structure ID</td>
<td>Unique identification number for the exported model. You must always enter the identification ID. Tekla Structures uses this value to identify the model if you re-export it.</td>
<td>XML</td>
</tr>
<tr>
<td>XML structure name</td>
<td>Unique name of the exported model.</td>
<td>XML</td>
</tr>
</tbody>
</table>

**Staad tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile table</td>
<td>Select the profile type.</td>
<td>FEM (STAAD)</td>
</tr>
<tr>
<td>Parametric shapes when possible</td>
<td>Use to define how Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad.</td>
<td>FEM (STAAD)</td>
</tr>
<tr>
<td></td>
<td>Yes exports the profiles as parametric shapes so that STAAD can identify them correctly.</td>
<td>FEM (STAAD)</td>
</tr>
<tr>
<td></td>
<td>No exports all profiles as standard STAAD shapes.</td>
<td>FEM (STAAD)</td>
</tr>
</tbody>
</table>

**DSTV tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Export type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Select the DSTV version to export.</td>
<td>FEM (DSTV)</td>
</tr>
<tr>
<td>Element reference with</td>
<td>Select CROSS-SECTION to export a static model or MEMBER_LOCATION to export a CAD model.</td>
<td>FEM (DSTV)</td>
</tr>
</tbody>
</table>

**See also**

- Exporting to CAD on page 134
- Exporting to a CIMSteel analysis model on page 162
- Exporting to a CIMSteel design/manufacturing model on page 163
- Exporting to STAAD on page 147
- Exporting to DSTV on page 148
15.8 Re-importing a CAD model

Sometimes you have already imported a model, but because of some changes, you need to re-import it.

The profile and material conversion files need to be the same as adopted in the original model import.

The following instructions also apply to CIMsteel (cis/2) models.

To re-import a model:

1. Open Tekla Structures and a model where you have already imported an existing CAD model.

2. Click File --> Import --> CAD.

3. Select the import type in the Type list.

   For CAD models, this will generally be for SDNF format files only.

4. Enter a new name for the imported model in the Name box.

   The total path and filename cannot be longer than 80 characters. If the total path is too long, a message is displayed saying "File name and path is too long. Please, place the file into another directory." Also, if you use the same name as in the original import, Tekla Structures gives the warning message "Illegal name for import model."

5. Click the Properties button and ensure that the Profile material conversion files on the Conversion tab are the same as adopted in the original model import.

6. Go to the Advanced tab and define the actions Tekla Structures takes when importing changed objects:

   - The left-hand column, Previous plan, lists the state of the objects in your model, compared with the state of objects in the file to be imported. They can be New, Modified, Deleted, or Same.

   - The objects can be Not in model, Different, or Same.

   - Use the list boxes in the rows under Not in model, Different, or Same to specify the actions to take when importing changed objects. The options are No action, Copy, Modify, or Delete.

     You can select Delete only for Deleted objects. You can only use Delete to delete objects that have been deleted from your model, not from the imported model.

   - Normally, default settings would be used by most users.

7. Click OK or Apply.

8. Click OK in the Import Model dialog box to import the updated model.

9. Create reports on the Report tab to compare the various imports.
15.9 Creating import reports

Some of the import tools give you the option to create a report of the import. By default, Tekla Structures does not create reports when you import files.

With this import report you can compare different revisions from previous imports. You can list the differences in profiles, material, part rotation, part position, paint, start connection codes, end connection codes, phase, for example.

To create an import report:
1. Open the import tool, for example, CAD (File --> Import --> CAD...).
2. Go to the Report tab of the import dialog box.
3. In Create report, select Yes.
4. In Display report, select Yes to display the report file.
5. In Report template, enter the path of the report template, or use the browse button to locate it.
   You can also leave the template name out, in which case the default import template is used.
6. In Report file name, enter the path for the report file, or use the browse button to locate it.
   You can also leave the report file name out, in which case the default import report file is used.
7. Import the model.
   The model is imported and the report is displayed on the screen.
   If you have not given the report any other name, the report is saved with the name import_revision_report.rpt in the model folder.
FEM (Finite Element Method) is an analysis and calculation method used in structural engineering. In this element method, the target is divided into appropriate finite elements interconnected at points called nodes.

Tekla Structures FEM import and export tool support several formats and provide several options for importing and exporting models.

See also
FEM import and export file types on page 141

### 16.1 FEM import and export file types

You can import the following file types into Tekla Structures using the FEM import tool.

<table>
<thead>
<tr>
<th>Option</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSTV</td>
<td>DSTV format data (Deutsche Stahlbau-Verband). Several different systems, for example, RSTAB static software and Masterseries Analysis &amp; Design system.</td>
</tr>
<tr>
<td>SACS</td>
<td>SACS modeling and analysis software</td>
</tr>
<tr>
<td>S-Frame</td>
<td>Analysis software, for example, FASTSOLVE.</td>
</tr>
<tr>
<td>Monorail</td>
<td>Monorail system</td>
</tr>
<tr>
<td>STAAD</td>
<td>STAAD format data (Structural Analysis And Design). STAAD modeling and analysis system.</td>
</tr>
<tr>
<td>Stan 3d</td>
<td>Stan 3d analysis software</td>
</tr>
<tr>
<td>Bus</td>
<td>BUS 2.5 analysis software</td>
</tr>
</tbody>
</table>

You can export to the following formats: DSTV, MicroSAS, and STAAD.

See also
16.2 DSTV

DSTV (Deutscher Stahlbau-Verband) manufacturing format is the standard format used for manufacturing steel components on numerically controlled (NC) machines. It also has an Analysis & Design format that is used for transferring Analysis & Design models to the physical 3D model.

Different programs produce different DSTV files. For example, the DSTV file produced by RSTAB static software only contains a static model. Tekla Structures exports either the static model (CROSS_SECTION), or the CAD model (MEMBER_LOCATION).

See also
Importing a DSTV model on page 142

16.3 Importing a DSTV model

To import a DSTV model:

1. Select File --> Import --> FEM...

   The New Import Model dialog box is displayed.

2. Select Import FEM...

3. Select import model (default) from the list or enter a new name.

4. Click OK.

5. Click Properties... to open a dialog box where you can define the settings for the import file:
   - On the Conversion tab, enter the conversion file names or browse for the files.
   - On the Parts tab, enter a prefix and a start position number for the imported parts in the Part Pos_No and Assembly Pos_No boxes.
   - On the Parameters tab, enter the name of the DSTV file you want to import in the Input file box, or use the default name.
   - On the Parameters tab, set the file type to DSTV in the Type box, and set the origin coordinates in the Origin boxes if you want the file in a specific location.
   - If you wish to create a report of the import, enter the required information on the Report tab.
   - Select the DSTV version on the DSTV tab.

     For Masterseries, the DSTV99 format must be selected.

   - Still on the DSTV tab, set Import static elements to Yes to import a static model. If you set Import other elements to Yes, a CAD model is imported.
6. Click **OK** to go to the **Import Model** dialog box.

7. Select the model to import.

8. Click **Import**.
   Tekla Structures displays the **Import model info** dialog box.

9. Select which version of parts to import.

10. Click **Accept all**.
   If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.
    Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

See also

CAD model import settings on page 129

---

16.4 **Importing a STAAD model**

This FEM import tool imports steel structures from the STAAD modeling and analysis system.

**NOTE** To make a STAAD input file compatible with the Tekla Structures STAAD import, use the option **Joint coordinate format (Single)** to save the input file in STAAD. This creates a line for each coordinate in the input file.

To import a STAAD model:

1. Select File --> Import --> FEM...

   The **New Import Model** dialog box is displayed.

2. Select **Import FEM**.

3. Use the default name *import model* or enter a name for the import model.

4. Click **OK**.

5. Select the model.

6. Click **Properties...** to open a dialog box where you can define the settings for the import file type you selected:
• On the **Conversion** tab, enter the conversion file names or browse for the conversion files.

• On the **Parameters** tab, enter the name of the STAAD file you want to import in the **Input file** box.

• Set the file type to **STAAD** in the **Type** box, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.

• Set the material grade in the **Material** box on the **Staad** tab.
  
  You can also click ... next to the box, and browse for the material grade in the **Select Material** dialog box.

• If you wish to create a report of the import, enter the required information on the **Report** tab.

• If you are importing the model for the first time, you do not need to change the default values on the **Advanced** tab.

7. Click **OK** to go to the **Import Model** dialog box.

8. Click **Import**.

   Tekla Structures displays the **Import model info** dialog box.

9. Select which version of parts to import.

10. Click **Accept all**.

   If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**...

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.

   Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

---

**NOTE**  
FEM import is one way to import STAAD data. Direct link to STAAD.Pro analysis and design application is another, more versatile way to import.

---

**See also**

- **STAAD table type specifications on page 144**
- **CAD model import settings on page 129**
- **STAAD.Pro on page 267**
**STAAD table type specifications**

Tekla Structures supports the following STAAD table type specifications:

- ST (single section from the standard built-in tables)
- ST PIPE (parametric)
- ST TUBE (parametric)
- RA (single angle with reverse Y_Z axes)
- D (double channel)
- LD (long leg, double angle)
- SD (short leg, double angle)
- TC (beams with top cover plates)
- BC (beams with bottom cover plates)
- TB (beams with top and bottom cover plates)

You can import the types CM and T, user-provided steel table types (UPT), and other non-standard profiles, if you have defined them in the profile conversion file. You must use the underscore character in the STAAD name, for example, UPT_1_W10X49. Tekla Structures automatically converts twin profiles in this import routine.

See also

Importing a STAAD model on page 143

---

### 16.5 Importing a Stan 3d model

To import a Stan 3d model:

1. Select **File** --&gt; **Import** --&gt; **FEM...**.

   The **Import Model** dialog box is displayed.

2. Select **Import FEM**.

3. Use the default import file name `import model` or enter another name.

4. Click **OK**.

5. Select the model to import.

6. Click **Properties...** to open a dialog box where you can define the settings for the import file type you selected:

   - On the **Conversion** tab, enter the conversion file names or browse for the conversion files.

   - On the **Parameters** tab, enter the name of the file you want to import in the **Input file** box.
• Set the file type to Stan 3d in the Type box, and set the origin coordinates in the Origin boxes if you want the file in a specific location.

• If you wish to create a report of the import, enter the required information on the Report tab.

• If you are importing the model for the first time, you do not need to change the default values on the Advanced tab.

7. Click OK to go to the Import Model dialog box.

8. Click Import.

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all.

If you have changed the model and want to re-import it, you can also reject all changes by clicking Reject all, or accept or reject individual changes by clicking Select individual....

11. Tekla Structures displays the message Do you want to save the import model for subsequent imports? Click Yes.

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties dialog box and change them if necessary.

See also

CAD model import settings on page 129

16.6 Importing a Bus model

The Bus import tool imports basic steel structures from the BUS 2.5 analysis software input file.

To import a Bus model:

1. Select File --> Import --> FEM... .

   The Import Model dialog box is displayed.

2. Select Import FEM.

3. Use the default name import model or enter another name.

4. Click OK.

5. Select the model.
6. Click **Properties**... to open a dialog box where you can define the settings for the import file type you selected:

- On the **Conversion** tab, enter the conversion file names or browse for the conversion files.
- On the **Parameters** tab, enter the name of the Bus file you want to import in the **Input file** box.
- Set the file type to **Bus** in the **Type** box, and set the origin coordinates in the **Origin** boxes if you want the file in a specific location.
- On the **Bus** tab, enter the position number, material, name, and class of the parts to import. Use **Beams behind plane** to indicate the position of girders and cantilevers. The option **Yes** aligns the tops of all beams at the floor level.
- If you wish to create a report of the import, enter the required information on the **Report** tab.
- If you are importing the model for the first time, you do not need to change the default values on the **Advanced** tab.

7. Click **OK** to go to the **Import Model** dialog box.

8. Click **Import**.

   Tekla Structures displays the **Import model info** dialog box.

9. Select which version of parts to import.

10. Click **Accept all**.

    If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**....

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports?** Click **Yes**.

    Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**See also**

   [CAD model import settings on page 129](#)
16.7 Exporting to STAAD

To export to STAAD:
1. Open a Tekla Structures model.
2. Click File --> Export --> FEM...
   The FEM export dialog box is displayed.
3. Go to the Conversion tab and enter the names of the conversion files, or browse for the files.
4. Go to the Parameters tab, and enter the name of the output file, or browse for the file.
5. Select Staad in the Type list.
6. Set Split members to Yes to split a part in the Tekla Structures model into several elements in the STAAD model.
7. Go to the Staad tab and select an option from Profile type list.
8. Use the setting Parametric shapes when possible to define how Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad.
   • Yes exports the profiles as parametric shapes so that STAAD can identify them correctly.
   • No exports all profiles as standard STAAD shapes.

Tekla Structures creates the export file in the current model folder.

Example
Example of a plate PL10*200 when exported as parametric shape (Yes):
13 PRI YD 200.000000 ZD 10.000000.
Example of the same plate exported as a standard shape (No):
13 TABLE ST PL10*200

NOTE FEM export is one way to export STAAD data. Direct link to STAAD.Pro analysis and design application is another, more versatile way to export.

See also
STAAD.Pro on page 267

16.8 Exporting to DSTV

NOTE The FEM DSTV export is not the same as DSTV export (File --> Export --> Create NC files), which produces DSTV files to be used as instruction files for NC machines.
The FEM DSTV export is intended to be used for transferring the model in the DSTV format. The DSTV file (*.stp) saves the data elements (end points, material, cross sections, references) as a standard DSTV file for importing and exporting models. For more information about creating NC files in DSTV format, see Creating NC files in DSTV format on page 97.

To export to DSTV:
1. Open a Tekla Structures model.
2. Click File --> Export --> FEM.
   The FEM export dialog box is displayed.
3. Go to the Conversion tab and enter the names of the conversion files, or browse for the files.
4. Go to the Parameters tab, and enter the name of the output file, or browse for the file.
5. Select DSTV in the Type list.
6. Set Split members to Yes to split a part in the Tekla Structures model into several elements in the DSTV model.
7. Go to the DSTV tab and select the DSTV version from the Version list.
8. In Element reference with, select whether you want to export into a static model CROSS_SECTION, or into a CAD model MEMBER_LOCATION.

See also
Supported DSTV entities on page 149

Supported DSTV entities

The DSTV entities are listed below. Tekla Structures supports those marked with an asterisk (*). See the DSTV standard “Stahlbau – Teil 1. März 2000” for more information.

Static data:
vertex (*)
polyline
substructure (*)
node (*)
element (*)
element_eccentricity (*)
raster
boundary_condition
elastic_support
nodal_reaction
element_reaction

**General data:**
material (*)
cross_section (*)

**CAD data:**
member (*)
member_location (*)
construction-data
cutout
hole

**See also**
Exporting to DSTV on page 148
ASCII stands for American Standard Code for Information Interchange. Some plant design systems export ASCII files, for example, ModelDraft, PDS and PDMS.
You can import and export profiles and plates created as beams using the ASCII format.

See also
Importing in the ASCII format on page 151
Exporting to the ASCII format on page 151
ASCII file description on page 152

17.1 Importing in the ASCII format

To import a Tekla Structures model in ASCII format:
2. Create a new 3D view.
3. Copy the ASCII file to the model folder.
4. Name the file import.asc.
5. Click File --> Import --> ASCII.
Tekla Structures displays the main parts created from the ASCII file in the model.

See also
ASCII on page 151
Exporting to the ASCII format on page 151
ASCII file description on page 152
17.2 Exporting to the ASCII format

To export a Tekla Structures model to the ASCII format:

1. Open the Tekla Structures model you want to export.
2. Select the parts in the model you want to export.
3. Click File --> Export --> ASCII.

Tekla Structures creates a model.asc file in the current model folder.

See also
ASCII on page 151
Importing in the ASCII format on page 151
ASCII file description on page 152

17.3 ASCII file description

In an import.asc file each part is described by 8 lines. These lines are repeated for each part to be transferred. Units are always in millimeters, blanks are used as separators.

Below is an example of a beam part description:

```
import.asc
4169 HEA300 1
290.000000 8.500000 300.000000 14.000000 300.000000 14.000000
A/6 BEAM
S235JR S235JR
0.000000
16.500000 24000.000000 4855.000000
6000.000000 24000.000000 4855.000000
16.500000 24000.000000 5855.000000
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>4169 HEA300 1 = ID profile type</td>
</tr>
<tr>
<td></td>
<td>- ID 4169: Unique ID (integer).</td>
</tr>
<tr>
<td></td>
<td>- PROFILE HEA300: Profile name (string).</td>
</tr>
<tr>
<td></td>
<td>- TYPE 1: Profile type (integer)</td>
</tr>
</tbody>
</table>

The available profile types are:

0 = free cross section (can be used for special profiles which are not in the database)

1 = I profiles
<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Welded hollow core profiles (HK, HQ)</td>
</tr>
<tr>
<td>3</td>
<td>U profiles</td>
</tr>
<tr>
<td>4</td>
<td>L profiles</td>
</tr>
<tr>
<td>5</td>
<td>Round bars</td>
</tr>
<tr>
<td>6</td>
<td>Round tubes</td>
</tr>
<tr>
<td>7</td>
<td>Rectangular hollow core sections (RHS, P)</td>
</tr>
<tr>
<td>8</td>
<td>T profiles</td>
</tr>
<tr>
<td>9</td>
<td>Rectangular bars (FL, PL)</td>
</tr>
<tr>
<td>10</td>
<td>Z profiles</td>
</tr>
<tr>
<td>11</td>
<td>C profiles</td>
</tr>
<tr>
<td>12</td>
<td>Omega profiles</td>
</tr>
<tr>
<td>13</td>
<td>Sigma profiles</td>
</tr>
<tr>
<td>14</td>
<td>Rail profile</td>
</tr>
<tr>
<td>16</td>
<td>Reinforcement bars (DH)</td>
</tr>
</tbody>
</table>

Line 2
The contents of line 2 depend on the part profile.

- Polygon plates:
  
  N_POINTS COORDINATES

  N_POINTS: For profiles of type 0.

  COORDINATES: Number of the corner points (integer).

  The X and Y coordinates of the plate corners (floating). Rotation direction is clockwise. Coordinates follow the global coordinate system. Z coordinates are taken from the center line in the plate thickness direction.

  Note that the line 2 can be divided into several rows in the file.

- Profiles:

  For profile types 1–16, the line includes the physical dimensions of the cross section.

  HEIGHT S W1 T1 W2 T2: 290.000000 8.500000 300.000000 14.000000 300.000000 14.000000

  - HEIGHT 290.000000: Height of the cross section
  - S 8.500000: Web thickness.
  - W1 300.000000: Width of the upper flange.
  - T1 14.000000: Thickness of the upper flange.
  - W2 300.000000: Width of the lower flange.
<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• T2 14.000000</td>
<td>Thickness of the lower flange.</td>
</tr>
<tr>
<td>A/6 BEAM</td>
<td>mark name</td>
</tr>
<tr>
<td>• MARK A/6: Position mark of the part (string).</td>
<td></td>
</tr>
<tr>
<td>• NAME BEAM: Part name (string).</td>
<td></td>
</tr>
<tr>
<td>S235JR S235JR</td>
<td>material</td>
</tr>
<tr>
<td>Material of the part (string).</td>
<td></td>
</tr>
<tr>
<td>0.000000</td>
<td>rotation</td>
</tr>
<tr>
<td>Rotation angle (in degrees) around the local x-axis of the beam.</td>
<td></td>
</tr>
<tr>
<td>16.500000 24000.000000 4855.000000</td>
<td>X1 Y1 Z1</td>
</tr>
<tr>
<td>Coordinates of the beam start point. Z coordinates are center-line coordinates.</td>
<td></td>
</tr>
<tr>
<td>6000.000000 24000.000000 4855.000000</td>
<td>X2 Y2 Z2</td>
</tr>
<tr>
<td>Coordinates of the beam end point. Z-coordinates are center-line coordinates.</td>
<td></td>
</tr>
<tr>
<td>16.500000 24000.000000 5855.000000</td>
<td>X3 Y3 Z3</td>
</tr>
<tr>
<td>Direction vector showing the direction of the local z-axis.</td>
<td></td>
</tr>
</tbody>
</table>

See also

ASCII on page 151
Importing in the ASCII format on page 151
Exporting to the ASCII format on page 151
18 Attribute import

You can import user-defined attribute (UDA) values to a model from a text file. For example, you can import a list of manufactured or checked assemblies.

You can import the attribute values to Tekla Structures model objects, drawings or some reference model objects by selecting an area in the model, or the whole model.

The imported file can be:
• Exported from other software.
• Created manually using any standard text editor, for example, Microsoft Notepad.
• A simple Tekla Structures report containing the part IDs and user-defined attributes.

See also
Importing attributes on page 155
Input files in attribute import on page 156
Examples of input files used in attribute import on page 157
Data file used in attribute import on page 158
Attribute import settings on page 159

18.1 Importing attributes

To import user-defined attribute (UDA) values from a text file:
1. Copy the text file that you want to import to the current model folder.
2. If you want to import user-defined attributes to a selected area in the Tekla Structures model, select an area in the model.
3. Click File --> Import --> Attributes... to open the Import Attribute dialog box.
4. Click the browse button next to the Input file box to locate the file to be imported.
5. Select the delimiter used in the text file.
6. Select an option in the Input scope, Create log file and Display log file boxes.
7. Click Create to import the file.

See also
Attribute import on page 155
Input files in attribute import on page 156
Examples of input files used in attribute import on page 157
Data file used in attribute import on page 158
Attribute import settings on page 159

18.2 Input files in attribute import

Input files used in the import of user-defined attribute (UDA) values are text files, which are delimited by a comma, tab, semi-colon, space or a user-defined delimiter. The input files contain the names and values of the user-defined attributes to be imported to the Tekla Structures model.

In the input file, the column headings must contain the names of properties and user-defined attributes in model objects and drawings. The remaining lines contain the values of the properties and user-defined attributes.

You must include at least one key field as a column heading. Key fields are drawing or model object properties. Tekla Structures uses the key fields to identify the model objects or drawings to which the user-defined attributes are assigned.

The key fields for model objects are:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Example</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUID</td>
<td>ID4FEAFC88-0000-0004-3133-343038303331</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the model object that has a GUID value of ID4FEAFC88-0000-0004-3133-34303830331.</td>
</tr>
<tr>
<td>ASSEMBLY_POS</td>
<td>A3</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the assembly that has an ASSEMBLY_POS value of A3. Repeat this line for each assembly you want to include.</td>
</tr>
<tr>
<td></td>
<td>or MARK</td>
<td></td>
</tr>
<tr>
<td>PHASE</td>
<td>2</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the assembly that has a PHASE value of 2. You must also use ASSEMBLY_POS as a key field with this option.</td>
</tr>
</tbody>
</table>
The key fields for drawing objects are:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Example</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE NAME</td>
<td>A  D4</td>
<td>Tekla Structures assigns the user-defined attributes on this line in the input file to the drawing that has a TYPE value of A and a MARK value of D4. Use both key fields in the input file.</td>
</tr>
<tr>
<td>ID</td>
<td>134</td>
<td>Tekla Structures assigns the user-defined attributes in this line in the input file to the drawing object that has an ID value of 134.</td>
</tr>
</tbody>
</table>

If you want to use user-defined attributes of other value types than the string in the input file, you need to define them in the `import_macro_data_types.dat` file, located in the ..\Tekla Structures\<version>\environments\common\system folder.

**TIP** If you use Microsoft Excel to create the input file, save the file with the *Save as* command to Text (Tab-delimited) (*.txt) format.

See also
- Attribute import on page 155
- Importing attributes on page 155
- Examples of input files used in attribute import on page 157
- Data file used in attribute import on page 158
- Attribute import settings on page 159

**Examples of input files used in attribute import**

**Example input file for parts**

`ASSEMBLY_POS` and `PHASE` are the key fields. Tekla Structures adds several user-defined attributes to the assemblies with values that match those listed in the `ASSEMBLY_POS` and `PHASE` columns.

For example, an assembly with the `ASSEMBLY_POS` (assembly number) of B5 in phase 1 gets the following user-defined attributes:

**STATUS:** 3

**USER_PHASE:** 6

**USER_ISSUE:** 3/25/2012
The input file contains several entries for B1. In this case, Tekla Structures writes the message **Duplicate entry in input file** in the log file and does not overwrite the user-defined attributes that are listed earlier in the file with those that are listed later. For example, at the end of the attribute import, B1 will have the following user-defined attributes:

- **STATUS**: 7
- **USER_PHASE**: 3
- **USER_ISSUE**: 3/25/2012

This input file is tab-delimited. You can also use a comma, semi-colon, space or a user-defined delimiter.

**Example input file for drawings**

**TYPE** and **NAME** are the key fields. Tekla Structures adds a value for the user-defined attribute **User field 4** to drawings with values that match those listed in the **TYPE** and **NAME** columns.

For example, a drawing with the **TYPE** A (assembly drawing) and **NAME** B.2 gets the value 4 in the **User field 4**.

```
attributes.txt

<table>
<thead>
<tr>
<th>ASSEMBLY_POS</th>
<th>PHASE</th>
<th>STATUS</th>
<th>USER_PHASE</th>
<th>USER_ISSUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1</td>
<td>1</td>
<td>7</td>
<td>3</td>
<td>3/25/2012</td>
</tr>
<tr>
<td>B2</td>
<td>1</td>
<td>7</td>
<td>3</td>
<td>3/25/2012</td>
</tr>
<tr>
<td>B3</td>
<td>1</td>
<td>7</td>
<td>3</td>
<td>3/25/2012</td>
</tr>
<tr>
<td>B4</td>
<td>1</td>
<td>7</td>
<td>3</td>
<td>3/25/2012</td>
</tr>
<tr>
<td>B5</td>
<td>1</td>
<td>3</td>
<td>5</td>
<td>3/26/2012</td>
</tr>
<tr>
<td>B1</td>
<td>1</td>
<td>3</td>
<td>5</td>
<td>3/26/2012</td>
</tr>
<tr>
<td>B2</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>3/26/2012</td>
</tr>
</tbody>
</table>
```

See also

- Attribute import on page 155
- Importing attributes on page 155
- Input files in attribute import on page 156
- Data file used in attribute import on page 158
- Attribute import settings on page 159
Data file used in attribute import

If you want to use user-defined attributes of other value types besides string in the attribute import input file, you need to define them in the import_macro_data_types.dat file, located in the ..\Tekla Structures\<version>\environments \common\system folder.

The import_macro_data_types.dat file is a simple text file listing the user-defined attributes that you can include in an input file.

You can modify the file using any standard text editor, for example, Microsoft Notepad.

You can:

• Change any of the user-defined attributes that are not key fields.
• Add user-defined attributes as INT, STRING, FLOAT, or DATE value types.

The file contains the following columns:

VARIABLE_NAME, VARIABLE_TYPE, CONVERSION_FACTOR, COMMENT

NOTE Tekla Structures uses CONVERSION_FACTOR to convert imperial values to metric values.
Tekla Structures only uses this value in Imperial environments. We recommend that you check the FLOAT values to avoid conversion factor errors.

Tekla Structures treats lines starting with double forward slash characters // as comments and ignores them when reading the file.

See also

Attribute import on page 155
Importing attributes on page 155
Input files in attribute import on page 156
Examples of input files used in attribute import on page 157
Attribute import settings on page 159

18.3 Attribute import settings

Use the options in the Import Attribute dialog box to define the input scope and log file properties when importing user-defined attribute (UDA) values from a text file to a model.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input file delimiters</td>
<td>Select the delimiter used in the input file.</td>
</tr>
</tbody>
</table>
| Input scope             | • Default, Entire model
Tekla Structures assigns the user-defined attribute values of objects in the input file to matching objects in the model. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection only</td>
<td>Tekla Structures only assigns the user-defined attribute values of objects in the input file to matching objects in the selected area of the model. Use this option to import user-defined attributes to models. Do not use it for drawings.</td>
</tr>
<tr>
<td>Reference models</td>
<td>Tekla Structures assigns the user-defined attribute values of objects in the input file to matching objects in reference models.</td>
</tr>
<tr>
<td>Create log file</td>
<td>• Create</td>
</tr>
<tr>
<td></td>
<td>Creates a new log file named <code>attribute_import.log</code> in the current model folder each time you import the user-defined attributes. Any previous attribute import log files are overwritten.</td>
</tr>
<tr>
<td></td>
<td>• Append</td>
</tr>
<tr>
<td></td>
<td>Adds log entries to the <code>attribute_import.log</code> file in the current model folder each time you import the user-defined attributes. If the log file does not exist, Tekla Structures creates it.</td>
</tr>
<tr>
<td></td>
<td>• No</td>
</tr>
<tr>
<td></td>
<td>Does not create a log file.</td>
</tr>
<tr>
<td>Display log file</td>
<td>• No</td>
</tr>
<tr>
<td></td>
<td>The log file is not displayed.</td>
</tr>
<tr>
<td></td>
<td>• On dialog</td>
</tr>
<tr>
<td></td>
<td>Tekla Structures displays the log file in a separate window. Click an object ID in the log file to highlight the part in the model.</td>
</tr>
</tbody>
</table>

See also

- Attribute import on page 155
- Importing attributes on page 155
- Input files in attribute import on page 156
- Examples of input files used in attribute import on page 157
- Data file used in attribute import on page 158
The CIS (CIMsteel Integration Standards) is one of the results of the Eureka CIMsteel project. The current version CIS/2 is an extended and enhanced second-generation release of the CIS. It was developed to facilitate a more integrated method of working through the sharing and management of information within, and between, companies involved in the planning, design, analysis and construction of steel framed buildings and structures.

There is one limitation: multi-material objects cannot be defined, because the standard concentrates on steel objects.

See also
CAD model import settings on page 129

19.1 Importing a CIMSteel model

To import a CIS (CIMSteel) model:
1. Select File --> Import --> CIMSteel... .
   The Import Model dialog box is displayed.
2. Select Import CIS model from the Type list.
3. Use the default name import model or enter a new name.
4. Click OK.
5. Select the model from the list.
6. Click Properties... to open a dialog box where you can define the settings for the import file type you selected.
7. On the Parameters tab, enter the following information:
   • Select the Model type, which can be Analysis, Design or SP3D.
   • Select CIS/1 or CIS/2 from the CIS version list.
   • Enter the name of the model file in the Input file box.
     You can also browse for the file.
- Set the origin coordinates to place the file in a specific location.
- To combine several elements in the CIS model into one part in Tekla Structures, set Combine members to Yes.
- Use Max length for combining to define the maximum length for combining parts (the maximum length of the combined parts together).
- Set Ignore offsets Yes if you want Tekla Structures to use member offsets to locate the physical members.
- In Ignore forces, indicate how forces are imported.
- To also import part GUIDS, set Import GUID (design model) to Yes.

8. On the Conversion tab, enter the conversion file names or browse for the conversion files.
9. Click OK to go to the Import Model dialog box.
10. Click Import.
   Tekla Structures displays the Import model info dialog box.
11. Select which version of parts to import.
12. Click Accept all.
   If you have changed the model and want to re-import it, you can also reject all changes by clicking Reject all, or accept or reject individual changes by clicking Select individual....
13. Tekla Structures displays the message Do you want to save the import model for subsequent imports? Click Yes.
   Tekla Structures displays the import model in a model view.
14. Right-click the model view and select Fit work area to entire model to ensure that the imported model is completely visible.
15. If parts are missing, check the View depth Up and Down values in the View Properties dialog box and change them if necessary.

See also
CAD model import settings on page 129

### 19.2 Exporting to a CIMSteel analysis model

To export to a CIMsteel analysis model:

1. Open a Tekla Structures model that you want to export.
2. Select the objects to export using the appropriate selection switches or filters.
3. Click File -- Export -- CIMSteel -- Analysis model... .
4. Select the CIS version from the CIS version list.
• **CIS/1** generates a file that is compatible with the CIMsteel LPM4DEP1 schema declaration.

• **CIS/2** generates a file compatible with the CIMSteel CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema declaration.

5. Enter a name for the export file in the **Step file** box or accept the default.
   
   You can enter the path or browse for it. If you do not enter a path, Tekla Structures creates the export file in the current model folder.

6. If required, enter the a name and organization to identify who created the export file.

7. From the **Flavor** list, select one of the following standards to apply to the export: UK, EUROPEAN, or US.

8. Set units to **metric** or **imperial** in the **Linear units (CIS/2 only)** box.

   Imperial is only available for CIS/2. CIS/1 is always exported in metric units.

9. Enter coordinate values in **Origin X**, **Y**, and **Z** boxes if you want to export the model to a specific location.

   The origin comes from the origin in Tekla Structures.

10. To split a part in the Tekla Structures model into several elements in the CIMsteel model, set **Split members** to **Yes**.

    For example, three columns may be connected to a beam in a model, so that one column is in the middle and the others are at each end of the beam. With the **Yes** option the beam is split into two equal elements in the CIMsteel model. With the **No** option there will be one beam, a single linear element, and two nodes (a node at each end) in the CIMsteel model.

11. Click **Apply** and **Create**.

    Tekla Structures exports the CIMSteel analysis model to the current model folder, or to another folder you specified, using the name you specified.

### 19.3 Exporting to a CIMSteel design/manufacturing model

To export to a CIS/2 CIMsteel design/manufacturing model:

1. Open a Tekla Structures model that you want to export.

2. Select the parts that you want to export.

3. Click **File --> Export --> CIMSteel --> Design/manufacturing Model...**.

4. Go to the **Parameters** tab and specify the required information:

   • **Select the LPM version:** LPM4 or LPM5.
• Enter name for the export file in the **Output file** box or accept the default.
  
  You can enter the path or browse for it. If you do not enter a path, Tekla Structures creates the export file in the current model folder.

• Select the model type from the **CIS/2 model type** list. The options are **manufacturing**, **design**, and **SP3D**.

• Set units to **metric** or **imperial** in the **Linear units (CIS/2 only)** box.
  
  With Imperial units Tekla Structures writes all of the designations for nuts, bolts, and washers in fractional inches.

• Enter a name for the structure in the **Structure name** field.

• Enter the path to the **profile** and **material conversion** files or browse for them.
  
  If you leave the profile and material conversion file paths empty, Tekla Structures uses the conversion files in the current profile folder for the conversion.

• To export globally unique IDs instead of internal ID numbers, set **Export Globally unique ID** to **Yes**.

• If you want to export concrete parts, set **Export concrete** to **Yes**.

5. Go to the **Standards** tab, and select the appropriate profile, material, and bolt standard organization, name and year.

  If you do not enter the standard organization or the name, Tekla Structures places an empty entry (""") in the export file. If you do not give the year, Tekla Structures uses 1999 as the default value.

6. If you are exporting to a manufacturing model, go to the **Manufacturing** tab, and specify the required information:

   • Set **Include NC files** to **Yes** to include information on NC files in the export.

   • In **NC file directory**, specify the path (relative to the current model folder) to the folder where the NC files are located.

7. If you are exporting to a design model, go to the **Design model** tab, and set **Export design connections** to **Yes** to export design connections.

8. Click **Apply** and **Create**.

  Tekla Structures exports the CIMSteel design or manufacturing model to the current model folder, or to another folder you specified, using the name you specified.

**See also**

[CIMSteel conversion files on page 164](#)
CIMSteel conversion files

Here are examples of the contents of the conversion files used in CIMSteel conversion.

Example 1

This example shows part of the profile conversion file prfexp_cis.cnv:

```plaintext
! US Imperial Flavor
! Profile name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name
!
!American Sections - Imperial
!W - Wide Flange Beams
W44X335 S\SECT\US\W44X335\ASTM_A6\1994
W44X290 S\SECT\US\W44X290\ASTM_A6\1994
W44X262 S\SECT\US\W44X262\ASTM_A6\1994
```

Converted-name contains the following information, and items are separated by a backslash (\):

- S (fixed value)
- SECT (fixed value)
- Name of the standardization organization
- Standard name of the profile shape
- Name of the standard
- Year of the standard

If the conversion file does not contain the relevant profile type, the Tekla Structures name of the profile is used. Tekla Structures also uses the standardization organization, standard name and year of standard defaults given on the Standards tab.

Example 2

This example shows part of the material conversion file matexp_cis.cnv:

```plaintext
! US Imperial Flavor
! Material name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
```
# Carbon Structural Steel (ASTM_A36\1994)
GRADE32 S\MAT\US\GRADE32\ASTM_A36-94\1994
GRADE36 S\MAT\US\GRADE36\ASTM_A36-94\1994

# High Strength Carbon Manganese Steel (ASTM_A529\1994)
GRADE42 S\MAT\US\GRADE42\ASTM_A529-94A\1994

`Converted-name` contains the following information, and items are separated by a backslash (`\`):

- S (fixed value)
- MAT (fixed value)
- Name of the standardization organization
- Standard name of the material
- Name of the standard
- Year of the standard

`Converted-name` contains the following information about bolts, nuts, and washers, separated by two colon characters (`::`):

- Name of the standards organization
- Name of the standard
- Year of the standard
- Standard name of the bolt, washer, or nut

Tekla Structures names for bolts, washers, and nuts are constructed from their fastener standard, fastener type and size.

If the conversion file does not contain an equivalent profile name, Tekla Structures uses the name of the material.

**See also**

- Exporting to a CIMSteel design/manufacturing model on page 163
- Conversion files on page 28
You can export model data to Manufacturing Information Systems (MIS). The MIS export supports the following formats:

- DSTV
- FabTrol / KISS
- EJE
- EPC
- Steel 2000

**NOTE** We recommend using the FabTrol reports instead of the MIS export for exporting FabTrol data. The FabTrol reports are available for the Steel Detailing role in the US imperial and US metric environments. If you do not use a suitable environment you may also contact your local support for the FabTrol files.

See also

Exporting a MIS list on page 167

Information on MIS file types on page 168

### 20.1 Exporting a MIS list

To export an MIS list to a file:

1. Click **File --> Export --> MIS**.

   The **Export MIS** dialog box opens.

2. Select the file type from the **MIS type** list.

3. If you selected **Fabtrol/KISS** or **Steel 2000**, define the additional options:
• Fabtrol/KISS
  Enter the customer name in the Customer name box.
  Select the Full material list check box to add labor-related information to the list (for example, holes, welds, cambers, preliminary marks).

• Steel 2000
  Select the Export only shop bolts check box to include only workshop bolts in the list file.

4. Enter a name for the list file in the MIS list file box.
   By default, the list file is saved in the model folder.
   You can select the folder where you want to save the list file by clicking Browse.

5. Ensure that you have the selection switch Select objects in components selected. If you have the switch Select assemblies selected, Tekla Structures will create empty files

6. Click Create all or Create selected to export the MIS list file.

See also

Information on MIS file types on page 168

20.2 Information on MIS file types

See below for information on MIS file types.

• DSTV
  The exported file contains the MIS information written in the DSTV format.

• EJE
  US Imperial version only.
  Structural Material Manager internally stores all dimensions in sixteenths. Its External Data Interface writes all dimensions, such as widths and lengths, except for Beam and Channel descriptions, in sixteenths of an inch.
  As an example the length 12’-8 7/8 is equivalent to 2446 sixteenths, which is calculated as (feet * 192) + (inches * 16) + (eighths * 2) = (12 * 192 + 8 * 16 + 7 *2).

• EPC
  The EPC (Estimating and Production Control) module of SDS/2 requires multinumbering to be active.
You can import fabrication status information for parts to a Tekla Structures model from an XML file written by FabTrol.

FabTrol is a Material Resource and Planning (MRP) system commonly used by steel fabricators to manage estimating, inventory and production. Data can be written to FabTrol via a KISS format export or directly via the text based reports from Tekla Structures for tracking of the assembly status through the project lifecycle. The tracking information entered in FabTrol can then be re-imported back to Tekla Structures via the FabTrol XML import for colorization of the model. This is performed by storing the data in a preset collection of user-defined attributes (UDAs). Import of the FabTrol XML is possible in all configurations of Tekla Structures (including Project Viewer) but data can only be saved into the UDAs in modeling or management configurations.

You need to have the XMLTrans.trn file in the ..\ProgramData\Tekla Structures\<version>\environments\<environment>\system folder. This file maps the FabTrol XML names to Tekla Structures UDA names.

See also
Importing a FabTrol XML file on page 169

21.1 Importing a FabTrol XML file

To import a FabTrol XML file:
1. Click File --> Import --> FabTrol XML...
2. Click the browse button next to the Input file box to locate the XML file.
3. Select an appropriate option from the Create log file list:
   - Select Create to write a new log file and delete the previous log file each time you import the XML file.
   - Select Append to add the log file information is at the end of the existing log file.
   - If you do not need a log file, select No.
4. Select an appropriate option from the **Display log file** list:
   - If you do not want to display the log file, select **No**.
   - To display the log file, select **On** dialog.

5. Click **Create** to import the status information.

**See also**

*FabTrol XML on page 169*
HMS stands for Hollowcore Manufacturing System and it is developed in the Netherlands. You can export data of hollow core slabs from Tekla Structures to HMS. HMS uses the data in manufacturing processes.

See also
Exporting to the HMS format on page 171
HMS Export: Project data tab on page 172
HMS Export: Slab scope tab on page 173
HMS Export: Slab data tab on page 172

22.1 Exporting to the HMS format
You can export model data of hollow core slabs to a HMS format. The result is a .sot file.

To export to the HMS format:
1. Select the model objects that you want to include in the export.
2. Click File --> Export --> HMS...
   The HMS Export dialog box opens.
3. Define the export properties as required.
4. Click the browse button.
5. Browse to the folder where you want to save the file.
6. Enter a name for the file.
7. Click Save.
8. Select the Add revision to file name check box and select the revision number if required.
   The revision number is added to the HMS export file as follows:
   hms_export_file{revision}.sot
9. Select the **Open log file after export** check box if you want to see the log after export.

   HMS Export creates the log file in the file export folder.

10. Click **Export** to create the HMS export file.

    **See also**

    HMS Export: Project data tab on page 172
    HMS Export: Slab scope tab on page 173
    HMS Export: Slab data tab on page 172

---

### 22.2 HMS Export: Project data tab

You can include project data, such as customer name and site address, in the HMS export file.

The **Project data** tab contains the following options for determining how to export project data:

- **Empty**
  - The item is not included in the HMS export file.

- **Text**
  - Enter the text in the box next to the item.

- **Project UDA**
  - The data comes from the project's user-defined attributes.

- **Project Object, Project Address, Project Info**
  - The data comes from the project information.

    **See also**

    Exporting to the HMS format on page 171

---

### 22.3 HMS Export: Slab data tab

You can include information on slabs in the HMS export file.

The following options are available in the **Slab data** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Number</td>
<td>Assigned Control Number (ACN) is the only option.</td>
</tr>
</tbody>
</table>

---
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Slab Remarks, Element Type & End Label** | The options are:  
- **Empty**  
The item is not included in the HMS export file.  
- **Text**  
Enter the text in the box next to the item.  
- **UDA**  
The data comes from the project’s user-defined attributes |
| **Slab Name** | The options are:  
- **Profile**  
Select to export the whole profile name.  
- **Thickness**  
Select to export only the profile height. |
| **Slab Mark** | The options are:  
- **Assembly position**  
Select to export the complete cast unit position.  
- **Assembly serial number**  
Select to export the cast unit serial number only. |
| **Slab Weight Units** | Select the weight unit. |
| **Live/dead load** | Enter the default live/dead load to be exported.  
For hollow core slab calculation, you can define a default live load/ dead load (KN/m2) for slabs.  
If you do not define this data here, you must enter the default values for each slab in HMS software later. |

**See also**

[Exporting to the HMS format on page 171](#)

### 22.4 HMS Export: Slab scope tab

You can include information on steel parts in the HMS export file.

The following options are available in the **Steel parts** tab:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude parts</td>
<td>Enter the class of the model object in the <strong>Class list</strong> box to exclude the data.</td>
</tr>
<tr>
<td>Hook Points, Electric boxes, Weld plate and Solid fill</td>
<td>Enter the class of the model object in the <strong>Class list</strong> box to include the data.</td>
</tr>
<tr>
<td>Filled area</td>
<td>Enter the class of the model object in the <strong>Class list</strong> to export as filled area.</td>
</tr>
<tr>
<td>Export Hook Box</td>
<td>Select to include hook data.</td>
</tr>
<tr>
<td>Exclude strands from export</td>
<td>Select to exclude strands from export.</td>
</tr>
<tr>
<td>Export inner cores</td>
<td>Select to include detailed information on hollow cores.</td>
</tr>
<tr>
<td>Include full cut to contour</td>
<td>Select to include full cut in the contour block (<strong>CO</strong>). If not selected, the full cut is written as an individual cut (<strong>SP</strong>).</td>
</tr>
<tr>
<td>Export HP name</td>
<td>Select to export hook point names. If you do not select this option, only the XY coordinates are exported.</td>
</tr>
</tbody>
</table>

**Example**

The hollow core slab in the model. It will be exported to HMS.

Include full cut to contour check box is selected:
Include full cut to contour check box is not selected:

See also
Exporting to the HMS format on page 171
Elematic ELiPLAN is a software for resource planning, scheduling, and management for precast concrete fabricators.

ELiPLAN import and export automates the data transfer between Tekla Structures and ELiPLAN. The data transfer consists of four parts:

1. Exporting ELiPLAN data file from Tekla Structures.
2. Importing ELiPLAN data file into ELiPLAN.
3. Exporting ELiPLAN status data file from ELiPLAN.
4. Importing ELiPLAN status data file into Tekla Structures.

The import of an ELiPLAN data file into ELiPLAN supports the incremental approach, which means that ELiPLAN is able to create, update, and delete parts in its database. This means that precast detailers can export the most up-to-date data files whenever the Tekla Structures model has been changed.

Similar incremental support is included in the import of an ELiPLAN status data file to Tekla Structures. To keep the status and schedule data up to date in a Tekla Structures model, we recommend you update the status data regularly.

**NOTE**  The format and contents of the ELiPLAN status data file imported to Tekla Structures differs from the data file that is exported from Tekla Structures to ELiPLAN.

**See also**

- Importing an ELiPLAN status data file on page 176
- Exporting an ELiPLAN data file on page 177
23.1 Importing an ELiPLAN status data file

If you have a status data file that has been created in ELiPLAN, you can import it to your Tekla Structures model.

To import status and scheduling information from ELiPLAN to Tekla Structures:
1. Click File --> Import --> EliPlan... to open the Import Eliplan status data dialog box.
2. Click the browse button next to the Import file name box to locate the file to be imported.
3. Click Create.

Tekla Structures updates the status and schedule data for parts in the Tekla Structures model. When the data is read, a log file is displayed.

The log file shows the parts whose data is updated correctly. It also provides information on possible problems that may have occurred. When you select a row in the log file, Tekla Structures automatically selects the corresponding part in the model. The overall status information is shown at the end of the log file.

Tekla Structures stores the actual status data in the user-defined attributes of the parts. To view the data, open the part properties dialog box, click the User-defined attributes... button and go to the EliPlan tab.

See also
ELiPLAN on page 176
Exporting an ELiPLAN data file on page 177

23.2 Exporting an ELiPLAN data file

To export ELiPLAN data from Tekla Structures:
1. If needed, add ELiPLAN information to the parts' ELiPLAN user-defined attributes.
2. Click File --> Export --> EliPlan... to open the Export EliPlan file dialog box.
3. Define the ELiPLAN export properties on the Parameters, Plotter data and Data content tabs.
4. Set Scope of export to All.
5. Click Create.

By default, a file called eliplan.eli is created in the current model folder, in a .EP_files subfolder.

See also
ELiPLAN user-defined attributes on page 178
**ELiPLAN user-defined attributes**

In addition to normal model data, you can add additional information in the user-defined attributes of the parts. The additional information can be transferred from Tekla Structures and used in ELiPLAN.

![ELiPLAN Export Parameters Tab](image)

**Product type**

The product type affects how ELiPLAN considers the part dimensions length, length2, deltaL, width, height, and thickness.

To set the product type, select a suitable product type option from the list. If needed, you can override the product type value set in the dialog box:

- You can enter a value for the user-defined attribute EP_TYPE in the objects.inp file.
- You can enter a value for the user attribute EP_TYPE in the Profile Catalog.

In the Profile Catalog the attribute value is given as a number. The values are as follows:

- Slab = 1
- Beam = 2
- Column = 3
- Wall = 4
- Sandwich wall = 5
• Stair = 6

Product code
You have alternative ways to give the product code. The ELiPLAN export tries to define the product code in the following order:

1. You can enter a value for the product code in the ELiPLAN user-defined attributes dialog box.
2. You can enter a value for the user-defined attribute EP_CODE of the cast unit main part in the objects.inp file.
3. You can enter a value for user attribute EP_CODE in the Profile Catalog.
4. You can use the data conversion file to convert parametric profile names to a product code.
5. You can use the main part name as a product code.

Erection sequence
Precast parts are erected in a certain sequence. Use the sequence to help the scheduling of the production in ELiPLAN. You can give the estimated erection sequence by giving the sequence number for parts.

Ready for production
Set this option to Yes when the designer or detailer has finished the part and the part is ready for production. The default is No, which means that the data is transferred to ELiPLAN for preliminary planning only, and the part is not sent for production until the attribute is set to Yes and a new file is transferred to ELiPLAN.

Eliplan status data
The Eliplan status data is meant to be read-only information and used to visualize the data in a Tekla Structures model.

See also
Exporting an ELiPLAN data file on page 177
ELiPLAN export: Parameters tab on page 179
ELiPLAN export: Plotter data tab on page 181
ELiPLAN export: Data content tab on page 182

ELiPLAN export: Parameters tab
Use the Parameters tab to control the ELiPLAN export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope of export</td>
<td>Select whether all parts or only selected parts are exported. Because of the incremental import of ELiPLAN, you need to select</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option</td>
<td>the same parts, and some additional parts again, if needed, when exporting the next time. Otherwise ELiPLAN assumes that the parts missing from the subsequent file have been deleted in the Tekla Structures model. We recommend you to always use the All option. Use the Selected option only in special cases or when you are exporting parts for the first time.</td>
</tr>
<tr>
<td>Export version number</td>
<td>Select whether IDs or GUIDs are used in the export. The use of GUID depends on the ELiPLAN version. You need to check with Elematic that the latest version of ELiPLAN is in use to benefit from the GUID transfer capabilities. The default is ID. All versions of ELiPLAN support the use of ID.</td>
</tr>
</tbody>
</table>
| Output file name              | The name and location of the export file created. The default name is eliplan.eli. You can import this file into ELiPLAN. The eliplan.eli file includes, among other things, material information. The accessory code, which is the material description, is in the #Materials section. The accessory code is based on the material type as follows:  
  • For concrete material the default accessory code is same as the material name.  
  • For mesh, reinforcing bars, or strands the default accessory code is grade|size.  
  • For embedded material the default accessory code is name|size|material. |
<p>| Data conversion file          | With this file you can convert the parametric profile names into the ELiPLAN product codes, and the material descriptions into the ELiPLAN accessory codes. The default file name is eliplan_export.dat and this file can be located in your model, XS_FIRM or XS_PROJECT folder. The data conversion file eliplan_export.dat contains string pairs separated with one or more tabs. The string on the left side is the profile name or Tekla Structures material description and the string on the right side is the corresponding ELiPLAN data. Note that the ELiPLAN codes depend on the fabricator and the codes that are valid for one fabricator are likely not valid for other fabricators. |
| List of classes to be ignored | A list of classes to be excluded from the export. This contains the class numbers used for concrete parts. Separate the classes with a space. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of classes to be ignored (Material)</td>
<td>A list of classes to be excluded from the export. This contains the class numbers used for materials. Separate the classes with a space.</td>
</tr>
<tr>
<td>List of classes to be ignored (Concrete)</td>
<td>A list of classes to be excluded from the export. This contains the class numbers used for secondary concrete parts. Separate the classes with a space.</td>
</tr>
<tr>
<td>Create log file</td>
<td>Select whether a log file is created.</td>
</tr>
<tr>
<td>Log file name</td>
<td>The name and location of the created log file.</td>
</tr>
</tbody>
</table>

See also

Exporting an ELiPLAN data file on page 177
ELiPLAN user-defined attributes on page 178
ELiPLAN export: Plotter data tab on page 181
ELiPLAN export: Data content tab on page 182

### ELiPLAN export: Plotter data tab

Use the Plotter data tab to control the ELiPLAN export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export of cutout data</td>
<td>Select how to export cutout data. The options are:</td>
</tr>
<tr>
<td></td>
<td>• All: Exports all data.</td>
</tr>
<tr>
<td></td>
<td>• Full depth cuts only: Exports data only on the cuts that go through the whole part.</td>
</tr>
<tr>
<td></td>
<td>• None: Does not export any cutout data.</td>
</tr>
<tr>
<td></td>
<td>Overlapping cutouts are combined in the export file.</td>
</tr>
<tr>
<td>Export of embed data</td>
<td>Select how to export data of embeds. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Yes: Exports data on embeds.</td>
</tr>
<tr>
<td></td>
<td>• No: Does not export any data on embeds.</td>
</tr>
<tr>
<td>Exclude cut parts by</td>
<td>Use to exclude cut parts from export based on the cut part properties.</td>
</tr>
<tr>
<td></td>
<td>You can define one or more values for the selected property.</td>
</tr>
</tbody>
</table>

See also

Exporting an ELiPLAN data file on page 177
ELiPLAN user-defined attributes on page 178
ELiPLAN export: Parameters tab on page 179
ELiPLAN export: Data content tab on page 182

ELiPLAN export: Data content tab

Use the Data content tab to control the ELiPLAN export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export material data</td>
<td>Select whether to include or exclude the detailed material data (receipt) of parts. If you have no use for material data in ELiPLAN (you have no material handling module in ELiPLAN), select No to exclude the data from the file and to reduce the file size. Note that once you have transferred the file with the material data (Yes) you should never switch off (No) the export of material data in subsequent exports. If you do this, the receipt is also cleared in the ELiPLAN database and all modifications are lost.</td>
</tr>
<tr>
<td>Export rebar bending data</td>
<td>Select whether to include or exclude the detailed rebar bending information. If you do not need this data in ELiPLAN, select No to exclude the data from the file and to reduce the file size. Note that once you have transferred the file with the rebar bending data (Yes) you should never switch off (No) the export of rebar bending data in subsequent exports.</td>
</tr>
<tr>
<td>Unit for rebar length</td>
<td>Select the unit for the length of reinforcing bars.</td>
</tr>
<tr>
<td>No. of digits after decimal point</td>
<td>Select the number of digits after the decimal point. The default is 2 digits after the decimal point.</td>
</tr>
<tr>
<td>Tag for lifters</td>
<td>Use to identify lifting loops by their name. Enter the name of the lifting loop. When lifting loops are identified, the plotter instruction type is changed from WPL to LL.</td>
</tr>
<tr>
<td>Position number type</td>
<td>Select whether to export the cast unit position number, or the assigned control number (ACN).</td>
</tr>
<tr>
<td>Remove numbering separator</td>
<td>Select whether a position number separator is used in numbering. The default is No.</td>
</tr>
</tbody>
</table>

See also

Exporting an ELiPLAN data file on page 177
ELiPLAN user-defined attributes on page 178
You can export reinforcement geometry to BVBS (Bundesvereinigung Bausoftware) format. The result is a text file in ASCII format. The supported version of the BVBS format is 2.0 year 2000.

You can export bent reinforcing bars, reinforcing bar groups and reinforcement meshes, which can be rectangular, polygonal, non-bent or bent, and may include cuts. The export of hooks is also supported.

Reinforcing bars that have bendings with two or more variable radius values are exported fully conforming with the BVBS specification so that radius element and leg elements are written separately. If this causes compatibility issues within your own environment and other tools using the BVBS files, you can still go back to the older way of exporting by setting the advanced option \texttt{XS\_BVBS\_EXPORT\_ARC\_COMPATIBLE\_TO\_OLDER\_METHOD} to \texttt{TRUE}.

See also
Exporting to the BVBS format on page 184

24.1 Exporting to the BVBS format

You can export reinforcement geometry to the BVBS format. The result is an ASCII file.

\textbf{NOTE} Before you start, make sure that numbering is up to date.

To export reinforcement to BVBS format:

1. Click \texttt{File} \texttt{--> Export} \texttt{--> BVBS}...

2. On the Parameters tab:
   a. Use the Model objects to be exported list to select which reinforcement you want to export.
   b. Select how to export drawing data.
      - Select a source for the drawing name in Drawing name source.
• To use a fixed drawing name in the export, select **Fixed text** in **Drawing name source** and enter the required name in the **Fixed drawing name** box. Enter the drawing revision number in the **Rev** box.

c. Select how the reinforcement is exported.

• To export information on all reinforcement in one file, select **Single file**. To browse for the file, click the button.

• To export information on reinforcement in each cast unit in a separate file, select **One file per each cast unit**.

d. Select the BVBS elements to be exported by selecting the appropriate check boxes in **BVBS elements to be exported**.

3. On the **Advanced** tab:

a. Select an option in the **Try to make meshes of rebars** list to define if the export tries to automatically form meshes of single reinforcing bars or bars of a reinforcing bar group and export them as a mesh instead of separate 2D bars.

   In order to form a mesh the reinforcing bars need to belong to same part, be straight, be in same plane, and to have equal filtering attribute values.

b. If you selected **Yes, group rebars by UDA**, enter **UDA name for grouping**.

c. In **Exporting of mesh bar data (@X.@Y..)**, select an option to control whether the detailed data of mesh bars is included in the exported data of the mesh.

d. If you select **Yes** in **Export stepped bars as separate items**, all tapered reinforcing bar groups are exported as multiple separate bar items even when they have regular spacing and could be exported as one single stepped bar item.

e. Use **Sort items** to define the order of the items in the output file.

f. With **Private data block** you can control whether the private data block is exported and select the data items for this additional block.

   Data fields can be any report properties, user-defined attributes, or object properties.

   Click the **New** button to add new predefined items to the list. Enter information about the data item.

4. On the **Checking** tab:

a. Select whether you want to enter the required minimum and maximum cutting length of the reinforcing bars.

5. Click **Export**.

**See also**

- BVBS Export: Parameters tab on page 188
- BVBS Export: Advanced tab on page 186
- BVBS Export: Checking tab on page 189
Reinforcing bar length calculation in BVBS

The length of the reinforcing bar is calculated according to the BVBS specification. The length also depends on the bending angle. Lengths L1 and L2 are exported.

If you set the advanced option XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT to TRUE, the user-defined length value is exported as the overall length for the reinforcing bar.

Note that the BVBS format specifications define that the overall length of the bar is ignored if the data contains actual geometry data. Some other software applications may still use the overall length values in the BVBS file for calculating quantities. The exported overall length in Tekla Structures is the same length as shown in reports.

See also

BVBS on page 184
Exporting to the BVBS format on page 184

24.2 BVBS Export: Advanced tab

Use the Advanced tab to control the BVBS export properties.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Try to make meshes of rebars</td>
<td>Select whether the export tries to automatically form meshes of a single reinforcing bar or of a group reinforcing bars and export them as a mesh instead of separate 2D bars. In order to form a mesh the reinforcing bars need to belong to the same part, be straight, be on the same plane, and have equal filtering attribute values.</td>
</tr>
<tr>
<td>UDA name for grouping</td>
<td>If you selected Yes, group rebars by UDA, enter the UDA name for grouping.</td>
</tr>
<tr>
<td>Exporting of mesh bar data (@X..@Y..)</td>
<td>Use this option to control whether the detailed data on mesh bars is included in the exported data of the mesh. The appropriate option depends on the needs and capabilities of the receiving system. The data is needed if it will be used, for example, for mesh fabrication.</td>
</tr>
<tr>
<td></td>
<td>• Custom and cut catalog meshes only</td>
</tr>
<tr>
<td></td>
<td>Detailed bar data is included only for custom meshes and catalog meshes that have additional cuts, openings or skewed edges.</td>
</tr>
<tr>
<td></td>
<td>• All meshes</td>
</tr>
<tr>
<td></td>
<td>Detailed bar data is written for all meshes.</td>
</tr>
<tr>
<td></td>
<td>• None meshes</td>
</tr>
<tr>
<td></td>
<td>Detailed bar data is not written to any of the meshes.</td>
</tr>
<tr>
<td>Export stepped bars as separate items</td>
<td>If you select Yes, all tapered reinforcing bar groups are exported as multiple separate reinforcing bar items even if they have regular spacing and could be exported as one single stepped reinforcing bar item.</td>
</tr>
<tr>
<td>Sort items</td>
<td>Use this option to define the order of the items in the output file(s).</td>
</tr>
<tr>
<td>Private data block</td>
<td>With Private data block you can control whether the private data block is exported and select the data items for this additional block. Data fields can be any report properties, user-defined attributes, or object properties.</td>
</tr>
<tr>
<td></td>
<td>Click the New button to add new predefined items to the list. Enter information about the data item.</td>
</tr>
<tr>
<td></td>
<td>• Name in list</td>
</tr>
<tr>
<td></td>
<td>The text shown in the Private data block list.</td>
</tr>
<tr>
<td></td>
<td>• Field identifier</td>
</tr>
<tr>
<td></td>
<td>The field code which separates the individual data fields in the private data block. It can be any lower case letter. Typically, it is a good practice to use a different value for...</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>each data item but this is not required. The receiving system may also be able to read only certain data fields.</td>
<td></td>
</tr>
<tr>
<td>Property or UDA name</td>
<td>The value defines which data will be inquired from the reinforcement object. Note that a non-existing property will be not exported.</td>
</tr>
<tr>
<td>Property data type</td>
<td>The value has to match the actual selected property.</td>
</tr>
</tbody>
</table>

See also

Exporting to the BVBS format on page 184
BVBS Export: Parameters tab on page 188
BVBS Export: Checking tab on page 189

### 24.3 BVBS Export: Parameters tab

Use the Parameters tab to control the BVBS export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model objects to be exported</td>
<td>Select which reinforcing bars or meshes are exported.</td>
</tr>
<tr>
<td>• Reinforcement of all cast units in the model</td>
<td>Exports reinforcing bars or meshes in all cast units in the model. If there are cast units that do not have reinforcing bars or meshes, no empty files are created.</td>
</tr>
<tr>
<td>• Reinforcement of selected cast units</td>
<td>Exports reinforcing bars or meshes in the cast units you have selected in the model.</td>
</tr>
<tr>
<td>• Selected reinforcement only</td>
<td>Exports the reinforcing bars or meshes you have selected in the model. When you select this option, you can export only to a single file.</td>
</tr>
</tbody>
</table>
| • Reinforcement of all cast units in the model (totals by all positions) | Exports reinforcing bars or meshes in all the cast units that have the same cast unit position as any of the selected cast unit positions.  
For example, if a cast unit with the cast unit position W-120 is selected, the reinforcing bars or meshes in all the |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Excluding reinforcement by</strong></td>
<td>Exclude reinforcing bars or meshes by selecting any of the selection filters. Reinforcing bars or meshes that match the filter are excluded.</td>
</tr>
<tr>
<td><strong>filter</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Drawing name source</strong></td>
<td>Define the drawing name used in the export.</td>
</tr>
<tr>
<td><strong>Fixed drawing name</strong></td>
<td>Enter a name to be used for the drawing in the export. This option is available only when you have selected the option Fixed text in Drawing name source.</td>
</tr>
<tr>
<td><strong>Rev</strong></td>
<td>Drawing revision (index). This option is available only when you have selected the option Fixed text in Drawing name source.</td>
</tr>
<tr>
<td><strong>Single file</strong></td>
<td>Export all BVBS information into one file. Enter the file name in the box or click the ... button to browse for the file.</td>
</tr>
<tr>
<td><strong>One file per each cast unit</strong></td>
<td>Export each cast unit to its own file. The files are created under the folder that you define in the Folder name box, or you can browse for the folder using the ... button. Use the File naming template list to select how the created files are named.</td>
</tr>
<tr>
<td><strong>BVBS elements to be exported</strong></td>
<td>Select which item types are exported. If you select Lattice girders (BFGT), enter the class numbers used in the model for the lattice girder bars in the Class numbers for girder box. The lattice girder may contain two or three chord bars and one or two diagonal zig-zag bars. The lattice girder is exported as one item in the BVBS file.</td>
</tr>
</tbody>
</table>

**See also**
- Exporting to the BVBS format on page 184
- BVBS Export: Advanced tab on page 186
- BVBS Export: Checking tab on page 189

### 24.4 BVBS Export: Checking tab

Use the **Checking** tab to control the BVBS export properties.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check cutting length</td>
<td>Select whether you want to run an additional check for the minimum and maximum cutting length of the reinforcing bars. When you select the Check cutting length check box, and the cutting length of the exported reinforcing bar is less than the minimum cutting length or greater than the maximum cutting length, a warning is written to the export log file. The log file entry contains the ID number of the reinforcing bar. You can locate the reinforcing bar in the model by selecting the appropriate row in the log file. Note that the reinforcing bar is still exported normally and only the additional warning is given.</td>
</tr>
</tbody>
</table>

See also

Exporting to the BVBS format on page 184
BVBS Export: Parameters tab on page 188
BVBS Export: Advanced tab on page 186
You can export the 3D geometry of the cast units to the Unitechnik format. The result is a text file in ASCII format. Supported versions of the Unitechnik format are:

- 6.1.0 beta
- 6.0.0 14.6.2005
- 5.2b 11.9.2000
- 5.0c 30.10.1997

You can export cast units consisting of concrete, steel and surface materials. Exporting of reinforcing bars (bent and not-bent), reinforcing bar groups and meshes with hooks is also supported. You can also export braced girders, solid, sandwich and double walls.

**Example**

Exported cast unit:
Hole
Steel embed
Reinforcing bars
Insulation plate (green)

See also
Exporting to the Unitechnik format on page 193
Unitechnik export: Main tab on page 194
Unitechnik export: TS configuration tab on page 198
Unitechnik export: Embeds tab on page 207
Unitechnik export: Reinforcement tab on page 212
Unitechnik export: Reinf. checking tab on page 219
Unitechnik export: Reinf. data specification tab on page 220
Unitechnik export: Data specification tab on page 221
Unitechnik export: Line attributes tab on page 222
25.1 Exporting to the Unitechnik format

You can export the 3D geometry of the cast units to the Unitechnik format. The result is a text file in ASCII format.

To export to the Unitechnik format:

1. Update numbering.
   - **Export Unitechnik** reads and exports data from the numbering series of parts. It is important that all exported parts are numbered correctly. Incorrectly numbered parts are not exported.

2. Click **File --> Export --> Unitechnik...** to open the **Export Unitechnik** dialog box.

3. Define the Unitechnik export properties on the different tabs.

4. Click **Create**.
   - By default, output files are created in the current model folder. The number of output files depends on the options selected in the **Create from** list on the **Main** tab, and the total number of selected parts, cast units, or assemblies.

**Limitations**

Cast units whose cast unit type is cast-in-place are not exported.

**See also**

*Unitechnik on page 191*
*Unitechnik export: Main tab on page 194*
*Unitechnik export: TS configuration tab on page 198*
*Unitechnik export: Embeds tab on page 207*
*Unitechnik export: Reinforcement tab on page 212*
*Unitechnik export: Reinf. checking tab on page 219*
*Unitechnik export: Reinf. data specification tab on page 220*
*Unitechnik export: Data specification tab on page 221*
*Unitechnik export: Line attributes tab on page 222*
*Unitechnik export: Pallet tab on page 226*
*Unitechnik export: Log files tab on page 227*
### 25.2 Unitechnik export: Main tab

Use the **Main** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unitechnik version</strong></td>
<td>Select the Unitechnik version.</td>
</tr>
<tr>
<td><strong>Create from</strong></td>
<td>Select which parts or cast units are exported.</td>
</tr>
<tr>
<td>• Selected cast units</td>
<td>Only cast units that have one or more parts selected in the model are exported. Each cast unit has one output file.</td>
</tr>
<tr>
<td>• All parts</td>
<td>All cast units are exported. Each cast unit has one output file.</td>
</tr>
<tr>
<td>• Selected parts (separately)</td>
<td>Only the selected concrete parts (also embeds and insulation parts belonging to the selected part) are exported. Each part has one output file.</td>
</tr>
<tr>
<td>• Selected parts (cast united)</td>
<td>Selected parts belonging to one cast unit are grouped and exported together in one output file.</td>
</tr>
<tr>
<td>• Selected assemblies</td>
<td>All selected assemblies are exported. One assembly equals one cast unit and has one output file. Selection of subassemblies is also allowed.</td>
</tr>
<tr>
<td>• Cast units in list</td>
<td>Select the cast units for export from the <em>Cast unit position list</em>.</td>
</tr>
<tr>
<td>• By cast unit Id</td>
<td>Each cast unit has its own output file.</td>
</tr>
<tr>
<td>• By cast unit position</td>
<td>Identical cast units share an output file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parts excluded from export (classes)</th>
<th>If you do not want to export some parts, enter the classes of the parts. Parts with classes in this list will not be exported.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Directory path</strong></td>
<td>Define where the export files are saved. The default folder is . \UT_Files under the current model folder.</td>
</tr>
<tr>
<td><strong>File name</strong></td>
<td>Select the name of the output file from the lists and file name extension.</td>
</tr>
<tr>
<td>• Proj. nr</td>
<td>is the number of the project.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Proj. name</td>
<td>is the name of the project.</td>
</tr>
<tr>
<td>CU nr</td>
<td>is the assembly position number of the main part of the cast unit.</td>
</tr>
<tr>
<td>Phase</td>
<td>is the current phase.</td>
</tr>
<tr>
<td>CU pos</td>
<td>is the assembly position of the main part of the cast unit.</td>
</tr>
<tr>
<td>ACN</td>
<td>is the assembly control number. To generate the assembly control numbers, click Drawings &amp; Reports --&gt; Numbering --&gt; Assign Control Numbers.</td>
</tr>
<tr>
<td>Part ID</td>
<td>is the ID number, which is 10 characters long. If the ID number is not 10 characters long, zeros are added in front of the ID number to make it 10 characters long. For example, id number 456999 will be 0000456999.</td>
</tr>
<tr>
<td>Counter</td>
<td>is the amount of characters that the property can contain. For example, (5) means that the property can contain only 5 characters. If there are less than 5 characters, zeros are added in front of the property. If there are more than 5 characters, characters at the beginning of the number series are deleted.</td>
</tr>
<tr>
<td>Date, Time, Date-Time, UDA, Text, Template, and Project UDA</td>
<td>Other options are Date, Time, Date-Time, UDA, Text, Template, and Project UDA.</td>
</tr>
</tbody>
</table>

**Extension**

The file name extension. By default it is Text and uni. You can select another option from the list.

**File name mask**

The format (length) of the output file name and file name extension. Numbers represent the length of the output string. If the name is longer than the selected option, it is cut.

**Open folder after export**

Select whether the folder where the output file is saved is opened after the export.

**Output file structure**

Structure of the exported file (slab date and layer part).

- **Multiple layers**

  One SLABDATE block with N layers. Each cast unit has its own LAYER block. Embeds, reinforcement and insulations belong to one concrete part, and they are exported to the related LAYER block.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Single layer, 1 slabdate, 1 part</td>
<td>Each cast unit has its own SLABDATE block, no LAYER blocks.</td>
</tr>
<tr>
<td>• Single layer, n slabdate, n parts</td>
<td>Cast units with equal geometry are collected in one SLABDATE block. No LAYER or LOT blocks are defined. Embeds, reinforcement and insulation belonging to a cast unit with the same geometry are collected and exported in one SLABDATE block.</td>
</tr>
<tr>
<td>• Single layer, 1 slabdate, n parts</td>
<td>All similar wall shells are defined within one SLABDATE block instead of being defined in a separate SLABDATE block per wall shell. The option is useful when exporting special embeds.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Combined, n slabdate, 1 part</td>
<td>Combined export that can contain more than one cast unit.</td>
</tr>
<tr>
<td>1st exported layer</td>
<td>Select which part is exported in the first LAYER. This option allows to define which wall shell is positioned on the pallet first. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Main part (of cast unit)</td>
</tr>
<tr>
<td></td>
<td>• Biggest part</td>
</tr>
<tr>
<td></td>
<td>• Heaviest part</td>
</tr>
<tr>
<td>Consider layer split thicknesses</td>
<td>Select how the layers of the cast unit are exported. These options are available when you have set <strong>Output file structure</strong> to <strong>Multiple layers</strong>.</td>
</tr>
<tr>
<td></td>
<td>• No</td>
</tr>
<tr>
<td></td>
<td>The cast unit is exported as one volume.</td>
</tr>
<tr>
<td></td>
<td>• Yes</td>
</tr>
<tr>
<td></td>
<td>The different layers set on the Unitechnik user-defined attributes of a part are taken into consideration, and the cast unit is exported in two or three layers.</td>
</tr>
<tr>
<td>Blank symbol in exported file</td>
<td>Select the blank symbol to be used in the export file.</td>
</tr>
<tr>
<td></td>
<td>An example with &quot;_&quot; symbol:</td>
</tr>
<tr>
<td></td>
<td>HEADER__ 005 57_____ W1______W 57_________ Tekla Corporation__ __________</td>
</tr>
<tr>
<td></td>
<td>An example with &quot; &quot; symbol:</td>
</tr>
<tr>
<td></td>
<td>HEADER__ 005 57 W1 W1 57 Tekla Corporation</td>
</tr>
</tbody>
</table>

**See also**

- **Unitechnik on page 191**
- **Exporting to the Unitechnik format on page 193**
- **Unitechnik export: TS configuration tab on page 198**
25.3 **Unitechnik export: TS configuration tab**

Use the **TS configuration** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Rotation** | Select the scanning direction. Unitechnik export uses scanning layers to obtain the geometry of all parts in a cast unit.  
The scanning direction depends on the plane of the cast unit main part.  
A floor panel is scanned from bottom to top side. A wall panel and a column are scanned from one side to the other side. The position and direction of a basic shape of the exported cast unit depends on the rotation.  

| No | Floor: Bottom to top  
Wall: Front to rear side  
Column: Side to side  

| 180 | Floor: Top to bottom  
Wall: Rear to front side  
Column: From one side to the opposite side |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+90 around X</td>
<td>Floor: Left to right side</td>
</tr>
<tr>
<td></td>
<td>Wall: Top to bottom</td>
</tr>
<tr>
<td></td>
<td>Column: Side to side</td>
</tr>
<tr>
<td>-90 around X</td>
<td>Floor: Right to left side</td>
</tr>
<tr>
<td></td>
<td>Wall: Bottom to top</td>
</tr>
<tr>
<td></td>
<td>Column: From one side to the opposite side</td>
</tr>
<tr>
<td>-90 around Y</td>
<td>Floor: Rear to front side</td>
</tr>
<tr>
<td></td>
<td>Wall: Right to left side</td>
</tr>
<tr>
<td></td>
<td>Column: Top to bottom</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Example of rotation:</td>
<td></td>
</tr>
<tr>
<td>- Wrong scanning plane (from the right side to the left side):</td>
<td></td>
</tr>
</tbody>
</table>

[Images of diagrams and examples]
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra rotation</td>
<td>Select the rotation around the z coordinate. The z coordinate has the same direction, but the x and y directions are changed.</td>
</tr>
<tr>
<td></td>
<td>To show the actual coordinate system, set Draw pallet axis to Yes on the Pallet tab.</td>
</tr>
<tr>
<td></td>
<td>• No</td>
</tr>
<tr>
<td></td>
<td>No extra rotation.</td>
</tr>
<tr>
<td></td>
<td>• Swap X/Y</td>
</tr>
<tr>
<td></td>
<td>Swap x and y axis.</td>
</tr>
<tr>
<td></td>
<td>• X=max(X_dim,Y_dim) main part</td>
</tr>
<tr>
<td></td>
<td>X axis goes through the longer side of the main part.</td>
</tr>
<tr>
<td></td>
<td>• X=min(X_dim,Y_dim) main part</td>
</tr>
<tr>
<td></td>
<td>X axis goes through the shorter side of the main part.</td>
</tr>
<tr>
<td></td>
<td>• X=max(X_dim,Y_dim) cast unit</td>
</tr>
<tr>
<td></td>
<td>X axis goes through the longer side of the cast unit.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• X=min(X_dim,Y_dim) cast unit</td>
<td>X axis goes through the shorter side of the cast unit.</td>
</tr>
<tr>
<td>• +90 around Z</td>
<td>Rotates x and y axis around the z axis by 90 degrees.</td>
</tr>
<tr>
<td>• - 90 around Z</td>
<td>Rotates x and y axis around the z axis by -90 degrees.</td>
</tr>
<tr>
<td>• 180 around Z</td>
<td>Rotates x and y axis around the z axis by 180 degrees.</td>
</tr>
</tbody>
</table>

The following example shows the coordinate system with no rotation and no extra rotation settings. Panel 1 has the z axis set parallel to the shorter side. It is incorrect in the Unitechnik format, so the coordinate system has to be rotated. Panel 2 shows a rotation by 90 degrees around the z axis.

**Scan position**

The number of the scanning layers depends on the selected scan position. Each object of the cast unit is scanned in one direction.

Select the position in which all parts are scanned. Each part is scanned separately. Scanning plane is parallel to the basic shape plane.

• **Bottom and top**

Two scanning planes at the start and at the end of the bounding box of the scanning part.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bottom only</td>
<td>One scanning plane at the start of the bounding box of the scanning part.</td>
</tr>
<tr>
<td>• Top only</td>
<td>One scanning plane at the end of the bounding box of the scanning part.</td>
</tr>
<tr>
<td>• Middle only</td>
<td>One scanning plane at the middle of bounding box of the scanning part.</td>
</tr>
</tbody>
</table>

To move the position of the exact scanning plane, use the Scan position offset boxes below to define start offset and end offset.

<table>
<thead>
<tr>
<th>Merge CONTOUR layers</th>
<th>You can export one scanned layer only. With two scanned layers, they have to be merged into one layer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Intersection</td>
<td>Creates polygon intersection of two contour geometries.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>a. First scanned layer</td>
<td></td>
</tr>
<tr>
<td>b. Second scanned layer</td>
<td></td>
</tr>
<tr>
<td>c. Layer</td>
<td></td>
</tr>
<tr>
<td>• Union</td>
<td>Creates polygon union of two contour geometries.</td>
</tr>
</tbody>
</table>

**Merge CUTOUT layers**
The same as **Contour export**, but for holes only.

**Extend contour and add formwork**
Select whether to extend the contour by embeds which are outside the element.

**Name for additional formwork (embed)**
Define a name for the embed.

**Geometry export**
Select whether the geometry of the exported part is represented as polygons or lines.

Polygons exported:
Option

Description

Unitechnik

205

Unitechnik export: TS configuration tab


<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines exported:</td>
<td>The image contains a snippet of a CAD file in a command-line format, indicating the exported lines and contours. This snippet shows the export process and the structure of the exported data.</td>
</tr>
<tr>
<td>Export rounded holes as circle (K)</td>
<td>Select whether you want to export rounded holes as circles (K) or polygons/lines.</td>
</tr>
<tr>
<td>Export project coordinates</td>
<td>Select whether you want to swap X and Y axis of the exported project coordinates.</td>
</tr>
<tr>
<td>Draw scanned geometry</td>
<td>The exported geometry can be shown with <strong>Draw scanned geometry</strong>. This property shows the inside lines of the exported reinforcing bars. Select whether you want to check if the geometry of the exported parts is correct. It shows the lines representing the exported rectangle of the basic shape, the exported geometry of parts, cuts, embeds, and reinforcement. Embeds are projected to the plane of the basic shape. The reinforcement lines are positioned inside each reinforcing bar.</td>
</tr>
</tbody>
</table>

Unitechnik 206 Unitechnik export: TS configuration tab
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Basic shape</td>
<td></td>
</tr>
<tr>
<td>2. Geometry of the main element</td>
<td></td>
</tr>
<tr>
<td>3. Cut geometry</td>
<td></td>
</tr>
<tr>
<td>4. Embed geometry</td>
<td></td>
</tr>
<tr>
<td><strong>Double wall turned</strong></td>
<td>Select whether the first shell of a double wall on the pallet is turned.</td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik on page 191
- Exporting to the Unitechnik format on page 193
- Unitechnik export: Main tab on page 194
- Unitechnik export: Embeds tab on page 207
- Unitechnik export: Reinforcement tab on page 212
- Unitechnik export: Reinf. checking tab on page 219
- Unitechnik export: Reinf. data specification tab on page 220
- Unitechnik export: Data specification tab on page 221
- Unitechnik export: Line attributes tab on page 222
- Unitechnik export: Pallet tab on page 226
- Unitechnik export: Log files tab on page 227
## 25.4 Unitechnik export: Embeds tab

Use the **Embeds** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal embeds</td>
<td>Select which parts are considered as embeds. Embedded parts are exported in the <strong>MOUNPART</strong> block. If the embed block consists of several parts, it is useful to weld all embeds into one block and then connect the created block with a concrete part to a cast unit. Subassemblies are also supported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected + steel</strong></td>
</tr>
<tr>
<td></td>
<td>All classes listed in the <strong>Embeds classes</strong> box are considered as embeds. All steel parts are also considered as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected</strong></td>
</tr>
<tr>
<td></td>
<td>Classes listed in the <strong>Embeds classes</strong> box are only considered as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No export</strong></td>
</tr>
<tr>
<td></td>
<td>Ignores the <strong>Embeds classes</strong> box and exports all steel parts as standard parts.</td>
</tr>
<tr>
<td><strong>Embeds classes</strong></td>
<td>Enter the classes for embeds.</td>
</tr>
<tr>
<td><strong>Export assemblies</strong></td>
<td>Select how embeds and steel blocks are exported. Embeds are exported as parts. All embedded welds and assembly relations are ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Welded embeds and the assembly block are exported as one part.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Only the main part of the embedded block or embedded assembly is exported.</strong></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram 1" /> The main part of the embedded block extended in the x direction to cover all the parts of the embedded block is exported.</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Diagram 2" /> Only the bounding box around the main part of the embedded block or embedded assembly is exported.</td>
</tr>
<tr>
<td><strong>Def export code</strong></td>
<td>Define how the insertion point and the direction for embeds is calculated. Possible values are 1, 2, 3, 11, 12, 21, 22, 23, 31 and 32.</td>
</tr>
<tr>
<td><strong>Cut outer assemblies</strong></td>
<td>Select how the embedded parts that are outside the concrete element are exported.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Diagram 3" /> All parts in the embed are exported.</td>
</tr>
<tr>
<td></td>
<td><img src="image4.png" alt="Diagram 4" /> Only the embedded parts that are inside of the concrete element are exported. Embedded parts that are outside the concrete element are ignored. If an embedded part is partly inside a concrete element, the exported geometry of the embedded part is changed to cut.</td>
</tr>
<tr>
<td></td>
<td><img src="image5.png" alt="Diagram 5" /> Same as the previous option, but only embedded parts with class defined in Cut outer only classes are taken into account.</td>
</tr>
<tr>
<td><strong>Cut outer only classes</strong></td>
<td>Enter the classes of parts whose geometry is changed to cut when you have selected the last option in the Cut outer assemblies list.</td>
</tr>
<tr>
<td><strong>Special assemblies export / Special export assembly file name</strong></td>
<td>The options affect the exported geometry of the embeds. The real geometry is replaced by the geometry defined in text files. The default name of the text file is spec_assemblies_def.txt and is searched for in the model folder. Use Special export</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>assembly file name</td>
<td>to define the name and the location of the text file.</td>
</tr>
</tbody>
</table>

Required structure of the text file is:
- Name(text) Number_of_lines_defined(number)
- S(representing single line) Start_coors(number number) End_coors(number number)
- S(representing single line) Start_coors(number number) End_coors(number number)

Example of the file:

```
Quicky 4
S -100 100 100 -100
S 100 100 -100 -100
S -100 -100 100 -100
S -100 100 100 100
QuickyS 2
S -50 0 50 0
S 0 -50 0 50
E-Doze 2
S -100 100 100 100
S 0 -100 0 0
```

The geometry of all embeds (from example with names Quicky, QuickyS, E-Doze) are replaced by geometry defined in the text file. In the following example, the part number 1 (the name is Beam) was not found in the text file so the geometry is exact. On the opposite side the part number 2 (the name is Quicky) was found, so the geometry is replaced.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embed Z position</td>
<td>Select the embed z position. The options are Minimum to pallet or Start point.</td>
</tr>
<tr>
<td></td>
<td>Alternatively, you can use the <code>spec_assemblies_def.txt</code> file to set the position of the embeds.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>Quicky 4 1 1 middle</td>
</tr>
<tr>
<td></td>
<td>S -100 100 100 -100</td>
</tr>
<tr>
<td></td>
<td>S 100 100 -100 -100</td>
</tr>
<tr>
<td></td>
<td>S -100 -100 100 -100</td>
</tr>
<tr>
<td></td>
<td>S -100 100 100 100</td>
</tr>
<tr>
<td>Insulation classes</td>
<td>Define the insulation classes. Parts with classes in this list will be exported as insulation parts. All parts considered insulation are exported in the MOUNPART block.</td>
</tr>
<tr>
<td>Electric tubes classes</td>
<td>Define the electric tubes classes. Parts with classes in this list will be exported as MOUNPART with lines geometry.</td>
</tr>
<tr>
<td>Opening embed classes</td>
<td>Define the opening embed classes. Parts with classes in this list will be exported as normal embeds in the MOUNPART block. The geometry will not be considered in the CONTOUR and CUTOUT blocks of the concrete part.</td>
</tr>
<tr>
<td>Opening cutout classes</td>
<td>Define the opening cutout classes. Parts with classes in this list will be exported only in regard to their geometry in the CUTOUT block of the concrete part. They will not be exported in the MOUNPART block.</td>
</tr>
<tr>
<td>Type of mounting part</td>
<td>You can define the type of mounting part in the MOUNPART block using a user-defined attribute.</td>
</tr>
<tr>
<td>Reference number</td>
<td>You can define the reference number of a mounting part in the MOUNPART block using a user-defined attribute.</td>
</tr>
<tr>
<td>Export insulation</td>
<td>Select whether insulation parts are exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels.</td>
</tr>
<tr>
<td>Export surface</td>
<td>Select whether surfaces are exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels.</td>
</tr>
<tr>
<td>Mountpart name</td>
<td>Enter the MOUNPART name</td>
</tr>
<tr>
<td>Install identification</td>
<td>Select the installation identification for the MOUNPART block. The options are Installed (0), Only plotted (1), Only installed (2), Not installed, not plotted (3), Installed in reinforcement (4), Installed automatically (5)</td>
</tr>
</tbody>
</table>

See also

- Unitechnik on page 191
- Exporting to the Unitechnik format on page 193
- Unitechnik export: Main tab on page 194
25.5 Unitechnik export: Reinforcement tab

Use the Reinforcement tab to control the Unitechnik export properties.

You can export single reinforcing bars, groups of straight and bent reinforcing bars, and rectangular or polygonal or bent meshes. The reinforcing bar group, or rectangular or polygonal mesh is divided into several single reinforcing bars. All reinforcing bars are exported in the RODSTOCK block.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebars export</td>
<td>When set to Yes, straight reinforcing bars are exported. Hooks are supported.</td>
</tr>
<tr>
<td>Bent rebars export</td>
<td>When set to Yes, bent reinforcing bars are exported. Hooks are supported.</td>
</tr>
<tr>
<td>Meshes export</td>
<td>When set to Yes, polygonal or rectangular meshes are exported. Hooks are supported.</td>
</tr>
<tr>
<td>Bent meshes export</td>
<td>When set to Yes, bent meshes are exported.</td>
</tr>
<tr>
<td>Bent reinf. as undolled</td>
<td>When set to Yes, bent reinforcement is exported as unfolded.</td>
</tr>
<tr>
<td>Export meshes as embeds</td>
<td>When set to Yes, meshes are exported as embeds.</td>
</tr>
<tr>
<td>Braced girder export</td>
<td>When set to Yes, reinforcing bars or steel rods representing braced girders are exported separately in the BRGIRDER block.</td>
</tr>
<tr>
<td>Braced girder classes</td>
<td>Enter the class of reinforcing bars, steel rods or profiles representing braced girders. For example, 15 17 5 means that parts with class 15, 17, or 5 are considered braced girders. If the Braced girder export and Braced girder classes boxes are not used, the braced girders will be exported incorrectly as reinforcement or embeds.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Braced girder type</strong></td>
<td>Select the string value of girder type field in the <code>BRGIRDER</code> block in the exported file.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Empty</strong></td>
</tr>
<tr>
<td></td>
<td>No string is exported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Name</strong></td>
</tr>
<tr>
<td></td>
<td>The name of the braced girder type is exported. If the name of the top part of a braced girder is empty, the names of the rods are checked.</td>
</tr>
<tr>
<td></td>
<td>• <strong>UDA</strong></td>
</tr>
<tr>
<td></td>
<td>You can export the user-defined attribute values for a braced girder type (<code>type</code>), braced girder article number (<code>art_number</code>), or braced girder fabricator name (<code>fabricator</code>).</td>
</tr>
<tr>
<td></td>
<td>The UDAs can be added to the braced girder if the parts have been created using the system component <em>Braced girder (88)</em> or <em>Braced girder (89)</em> and you have entered the needed values on the dialog boxes of the components.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User defined text</strong></td>
</tr>
<tr>
<td></td>
<td>The value you enter in the box next to this option is exported.</td>
</tr>
<tr>
<td><strong>Reinforcement export type</strong></td>
<td>Define the structure of the exported file for reinforcement.</td>
</tr>
<tr>
<td><strong>Plant with lying robot only</strong></td>
<td>All embeds without modifications are exported.</td>
</tr>
<tr>
<td><strong>Fabrication of welded rebars</strong></td>
<td>If <strong>Export type</strong> is set to <em>Fabrication of welded rebars</em>, a single reinforcing bar is exported in one ST<strong>EELMAT* block, all reinforcing bars of one group are exported together in one ST</strong>EELMAT* block, and all reinforcing bars of one mesh are also exported together in one ST**EELMAT* block.</td>
</tr>
<tr>
<td></td>
<td>The structure of the output file (one <code>SLABDATE</code> is shown only):</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>HEADER __</td>
<td></td>
</tr>
<tr>
<td>SLABDATE</td>
<td></td>
</tr>
<tr>
<td>CONTOUR__</td>
<td></td>
</tr>
<tr>
<td>CUTOUT__</td>
<td></td>
</tr>
<tr>
<td>MOUNPART</td>
<td></td>
</tr>
<tr>
<td>RODSTOCK</td>
<td></td>
</tr>
<tr>
<td>BRGIRDER</td>
<td></td>
</tr>
<tr>
<td>REFORCERM</td>
<td></td>
</tr>
<tr>
<td>STEELMAT</td>
<td></td>
</tr>
<tr>
<td>RODSTOCK</td>
<td></td>
</tr>
<tr>
<td>BRGIRDER</td>
<td></td>
</tr>
<tr>
<td>END STEELMAT</td>
<td></td>
</tr>
<tr>
<td>STEELMAT</td>
<td></td>
</tr>
<tr>
<td>RODSTOCK</td>
<td></td>
</tr>
<tr>
<td>BRGIRDER</td>
<td></td>
</tr>
<tr>
<td>END STEELMAT</td>
<td></td>
</tr>
<tr>
<td>EXTRON__</td>
<td></td>
</tr>
<tr>
<td>END REFORCERM</td>
<td></td>
</tr>
<tr>
<td>END SLABDATE</td>
<td></td>
</tr>
<tr>
<td>END HEADER__</td>
<td></td>
</tr>
</tbody>
</table>

**Collect reinforcement**

The structure of the output file is the same as for Fabrication of welded rebar. This option allows you to collect mesh, single reinforcing bars and reinforcing bar groups into groups exported in one STEELMAT block. The groups are collected based on the Collect based on field. You can also collect meshes which belong to different cast units.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (orange color): The mesh belongs to the bottom panel of the cast unit, mesh name is MESH1.</td>
<td></td>
</tr>
<tr>
<td>2 (blue color): Two single bars, the name is MESH1.</td>
<td></td>
</tr>
<tr>
<td>3 (green color): One reinforcing bar group belongs to the top panel, the name is MESH1.</td>
<td></td>
</tr>
</tbody>
</table>

If **Reinforcement export type** is set to **Collect reinforcement** and **Collect based on** is set to **Name**, all three different reinforcement types are collected into one mesh, which is exported in one STEELMAT block.

**Meshes as MOUNPART**

*Meshes are exported in the MOUNPART block.*

<table>
<thead>
<tr>
<th>Collect based on</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Collect if distance is lower then</strong></td>
<td>Define the maximum distance between the meshes to be collected.</td>
</tr>
</tbody>
</table>

- **Name**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same name are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with the same name equals one mesh in the exported file.

- **Class**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same class number are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with one class number equal one mesh in the exported file.

- **Grade**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same grade are collected into meshes.

- **UDA**
  - Meshes, single reinforcing bars and reinforcing bar groups with the same user-defined attribute are collected into meshes.

  The value you enter in the box next to this option is the UDA value.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reinforcing bars length</td>
<td>Select how the reinforcing bar length is calculated.</td>
</tr>
<tr>
<td></td>
<td>• Lines in the middle</td>
</tr>
</tbody>
</table>

![Diagram of reinforcing bars length calculation]

Unitechnik export: Reinforcement tab
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Lines at the edge</td>
<td><img src="image" alt="Diagram showing lines at the edge" /></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option</td>
<td>• GetValue(Length)</td>
</tr>
<tr>
<td>Reinforcing bars diameter</td>
<td>Select how the reinforcing bar diameter is exported. This selection affects the results of the <strong>Rebar length</strong> option.</td>
</tr>
<tr>
<td>Reinforcement types</td>
<td>Select the reinforcing bar type in a mesh to be exported. 1 and 2 are for the rods in the bottom layer. 5 and 6 are for the rods in the top layer. 4 is for other or inclined rods. 8 is for loose bars.</td>
</tr>
<tr>
<td>Classes for loose rebars type 8</td>
<td>Enter the classes of loose reinforcing bars to be collected. The bars are a part of a mesh and are exported as reinforcing bar type 8.</td>
</tr>
<tr>
<td>Classes for non-automated rebars</td>
<td>Enter the classes of non-automatic reinforcing bars to be collected.</td>
</tr>
<tr>
<td>Rebar direction angle limit</td>
<td>Select whether the reinforcing bars are sorted according to their angle direction.  •  No The reinforcing bars are not sorted.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
• From 0 to 180 | The reinforcing bars are exported as they are read from Tekla Structures and sorted according to their x and y position.
• From 0 to 180 ordered | The reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with lower angles are first.
• From 180 to 0 ordered | The reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with higher angles are first.

Add mesh stabilizing wires | Select whether to add wires to the reinforcement mesh to stabilize the mesh. Use for meshes with large openings.
Stabilization wire max spacing | Enter a value to define the maximum spacing of the wires that stabilize the reinforcement mesh.
Meshes sort | Select whether meshes are sorted.
Meshes offset | Select whether the mesh has an offset defined in the STEELMAT block. If the option is set to Yes, the value for X and Y direction is set to zero. If the option is set to No, the X and Y values are exported according to modeled situation.

See also

Unitechnik on page 191
Exporting to the Unitechnik format on page 193
Unitechnik export: Main tab on page 194
Unitechnik export: TS configuration tab on page 198
Unitechnik export: Embeds tab on page 207
Unitechnik export: Reinf. checking tab on page 219
Unitechnik export: Reinf. data specification tab on page 220
Unitechnik export: Data specification tab on page 221
Unitechnik export: Line attributes tab on page 222
Unitechnik export: Pallet tab on page 226
Unitechnik export: Log files tab on page 227

25.6 Unitechnik export: Reinf. checking tab
Use the Reinf. checking tab to control the Unitechnik export properties.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebar diameter limitation</td>
<td>Minimum and maximum diameter for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation</td>
<td>Minimum and maximum length for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation (Longitudinal)</td>
<td>Minimum and maximum diameter for longitudinal reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation (Cross)</td>
<td>Minimum and maximum length for cross reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Export others</td>
<td>Select whether the reinforcing bars that do not meet the above limitations are exported at all (No), as loose reinforcing bars of type 4 or 8, or whether the diameter and length limitations are ignored.</td>
</tr>
</tbody>
</table>

**See also**
- Unitechnik on page 191
- Exporting to the Unitechnik format on page 193
- Unitechnik export: Main tab on page 194
- Unitechnik export: TS configuration tab on page 198
- Unitechnik export: Embeds tab on page 207
- Unitechnik export: Reinforcement tab on page 212
- Unitechnik export: Data specification tab on page 221
- Unitechnik export: Line attributes tab on page 222
- Unitechnik export: Pallet tab on page 226
- Unitechnik export: Log files tab on page 227

### 25.7 Unitechnik export: Reinf. data specification tab

Use the Reinf. data specification tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebars: Article number rebar</td>
<td>Select which property you want to export as a reinforcing bar article number for rebars in the STEELMAT block.</td>
</tr>
<tr>
<td>Rebars: Article number mesh</td>
<td>Select which property you want to export as a mesh article number for rebars in the STEELMAT block.</td>
</tr>
<tr>
<td>Meashes: Article number rebar</td>
<td>Select which property you want to export as a reinforcing bar article number for meshes in the STEELMAT block.</td>
</tr>
<tr>
<td>Meashes: Article number mesh</td>
<td>Select which property you want to export as a mesh article number for meshes in the STEELMAT block.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Meshes designation</td>
<td>Select what information you want to export about the meshes in STEELMAT block.</td>
</tr>
<tr>
<td>Info text (60)</td>
<td>Select the information that will be exported for meshes exported as embeds. Information fields (1-2) in meshes block are filled with the selected data.</td>
</tr>
<tr>
<td>Info text (61)</td>
<td>Information fields (1-2) in the CAGE block are filled with the selected data.</td>
</tr>
</tbody>
</table>

See also

- Unitechnik on page 191
- Exporting to the Unitechnik format on page 193
- Unitechnik export: Main tab on page 194
- Unitechnik export: TS configuration tab on page 198
- Unitechnik export: Embeds tab on page 207
- Unitechnik export: Reinforcement tab on page 212
- Unitechnik export: Reinf. checking tab on page 219
- Unitechnik export: Data specification tab on page 221
- Unitechnik export: Line attributes tab on page 222
- Unitechnik export: Pallet tab on page 226
- Unitechnik export: Log files tab on page 227

### 25.8 Unitechnik export: Data specification tab

Use the Data specification tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of order</td>
<td>Order fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Name of component</td>
<td>Component fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Drawing number</td>
<td>Drawing number fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Product code</td>
<td>Product code fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Project line3 text</td>
<td>Project information fields (3rd line) in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Project line4 text</td>
<td>Project information fields (4rd line) in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File creator (UT 6.0)</td>
<td>You can select to export the Tekla Structures version information, use name or user-defined text in the HEADER block.</td>
</tr>
<tr>
<td>Free field (UT 5.2)</td>
<td>Only for Unitechnik 5.2. You can select to export the following information to the HEADER block: user name, user-defined text, file name with extension, file name without extension, or model name.</td>
</tr>
<tr>
<td>Slab number</td>
<td>Slab number field in the SLABDATE blocks is filled with the selected data.</td>
</tr>
<tr>
<td>Transport unit number,</td>
<td>Define a value for the transport unit and sequence numbers in the SLABDATE blocks.</td>
</tr>
<tr>
<td>Transport sequence number</td>
<td></td>
</tr>
<tr>
<td>Production thickness</td>
<td>Calculates the production thickness in SLABDATE block based on cast unit width or concrete part width.</td>
</tr>
<tr>
<td>Info 1 text (60) – Info 4</td>
<td>Information fields (1-4) in the SLABDATE and MOUNPART blocks are filled with the selected data.</td>
</tr>
<tr>
<td>text (60)</td>
<td></td>
</tr>
</tbody>
</table>

See also

Unitechnik on page 191
Exporting to the Unitechnik format on page 193
Unitechnik export: Main tab on page 194
Unitechnik export: TS configuration tab on page 198
Unitechnik export: Embeds tab on page 207
Unitechnik export: Reinforcement tab on page 212
Unitechnik export: Reinf. checking tab on page 219
Unitechnik export: Reinf. data specification tab on page 220
Unitechnik export: Line attributes tab on page 222
Unitechnik export: Pallet tab on page 226
Unitechnik export: Log files tab on page 227

25.9 Unitechnik export: Line attributes tab

Use the **Line attributes** tab to control the Unitechnik export properties. Sometimes line attribute values that are exported in the Unitechnik files are not suitable for the particular situation. For example, to preserve lightness in the model, you might have fewer chamfers in the model than there will be in the actual structure. For this reason, you might want to override some line attributes in the export so that the model remains light, but the exported Unitechnik files are correct. You can do this by using the options on the **Line attributes** tab.
### Option Description

**Export line attributes for contour**

Select whether the line attribute values are used for contours ([Export line attributes for contour](#)) or for holes ([Export line attributes for cutouts](#)) in the export.

- **None**
  
  Line attribute values are not used.

- **All lines**
  
  Line attribute values are used for all lines.

- **Outmost lines only**
  
  Line attribute values are used only for the outermost lines in the part:

  ![Diagram](#)

  This option is available only for contours.

**Border line overriding**

You can enter up to six border line modifications in the line attribute export.

- **No border lines are overridden.**
  
  ![Diagram](#)

- **Vertical outermost border lines at the start are overridden.**
  
  ![Diagram](#)

- **Horizontal outermost border lines at the bottom are overridden.**
  
  ![Diagram](#)

- **Vertical outermost border lines at the end are overridden.**
  
  ![Diagram](#)
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Horizontal outermost border lines at the top are overridden.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Horizontal outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>All inclined outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>All outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>All vertical border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Option 1 Image" /></td>
<td>All horizontal border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Option 2 Image" /></td>
<td>All vertical and horizontal border lines except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Option 3 Image" /></td>
<td>All border lines except outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Option 4 Image" /></td>
<td>All border lines except the horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Option 5 Image" /></td>
<td>All border lines are overridden.</td>
</tr>
<tr>
<td><strong>Orig. attr, New attr.</strong></td>
<td>Define the original attribute (Orig. attr) and the attribute that will be used in the export (New attr.).</td>
</tr>
<tr>
<td></td>
<td>In the example below the horizontal outermost border line at the top would get a line attribute value 0033 originally, but the value will be overridden, and the line attribute value in the Unitechnik file will be 0040.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export line attributes for cutouts</td>
<td>Select whether all line attributes are exported for holes.</td>
</tr>
<tr>
<td>Export angle of 1st and last vertical border</td>
<td>Select whether you want to export the angle of cut at the first and last vertical border.</td>
</tr>
</tbody>
</table>

See also

- Unitechnik on page 191
- Exporting to the Unitechnik format on page 193
- Unitechnik export: Main tab on page 194
- Unitechnik export: TS configuration tab on page 198
- Unitechnik export: Embeds tab on page 207
- Unitechnik export: Reinforcement tab on page 212
- Unitechnik export: Reinf. checking tab on page 219
- Unitechnik export: Reinf. data specification tab on page 220
- Unitechnik export: Data specification tab on page 221
- Unitechnik export: Pallet tab on page 226
- Unitechnik export: Log files tab on page 227

## 25.10 Unitechnik export: Pallet tab

Use the Pallet tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw pallet axis</td>
<td>Select whether to show the coordinate system. The axes are displayed with dotted lines.</td>
</tr>
<tr>
<td>Wall to pallet checking</td>
<td>Select whether the export checks the wall size against the pallet size. If you select the Yes, if exceeded, do not export option, the Pallet width, Pallet length, and Max. cast unit thickness options cannot be empty.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Pallet width</strong></td>
<td>Define the pallet width. With the help of pallet width and length the <strong>Wall to pallet checking</strong> option can check if a wall element is too big and does not fit to a pallet. If the wall element does not fit to a pallet, the wall element is turned.</td>
</tr>
<tr>
<td><strong>Pallet length</strong></td>
<td>Define the pallet length.</td>
</tr>
<tr>
<td><strong>Max canst unit thickness</strong></td>
<td>Define the maximum cast unit thickness. To avoid collision with the drying chamber, the maximum thickness of a cast unit should be smaller than the maximum opening of the drying chamber.</td>
</tr>
<tr>
<td><strong>Placing on pallet</strong></td>
<td>Select if the placing is checked from the start or end of the pallet.</td>
</tr>
<tr>
<td><strong>Offset at start or end</strong></td>
<td>Define the offset at start or end of the pallet used in checking.</td>
</tr>
<tr>
<td><strong>Clearance between cast units</strong></td>
<td>Define the clearance between the cast units used in checking.</td>
</tr>
<tr>
<td><strong>Same cast unit thickness needed</strong></td>
<td>Select if the cast unit thickness is checked.</td>
</tr>
</tbody>
</table>

**See also**

*Unitechnik on page 191*

*Exporting to the Unitechnik format on page 193*

*Unitechnik export: Main tab on page 194*

*Unitechnik export: TS configuration tab on page 198*

*Unitechnik export: Embeds tab on page 207*

*Unitechnik export: Reinforcement tab on page 212*

*Unitechnik export: Reinf. checking tab on page 219*

*Unitechnik export: Reinf. data specification tab on page 220*

*Unitechnik export: Data specification tab on page 221*

*Unitechnik export: Line attributes tab on page 222*

*Unitechnik export: Log files tab on page 227*

---

**25.11 Unitechnik export: Log files tab**

Use the **Log files** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Log file directory path</strong></td>
<td>Define the path for a log file. If the path is empty, then the log file is saved in the same location as the export files.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create main Log file</td>
<td>Select whether to create a one main log file.</td>
</tr>
<tr>
<td>Create Log file for each file</td>
<td>Select whether a log file is created separately for each export file.</td>
</tr>
<tr>
<td>Write history to log file and UDA</td>
<td>Create a log file containing the history of the exported parts. The information is also written to the UDA UT_export_history of the main part. The following data is gathered: export time, part information, export path and file, and who has performed the export.</td>
</tr>
<tr>
<td>Show error dialog boxes</td>
<td>Select whether an error message is shown when exported parts are not numbered correctly or when the embedded parts have no parent part.</td>
</tr>
</tbody>
</table>

See also

Unitechnik on page 191
Exporting to the Unitechnik format on page 193
Unitechnik export: Main tab on page 194
Unitechnik export: TS configuration tab on page 198
Unitechnik export: Embeds tab on page 207
Unitechnik export: Reinforcement tab on page 212
Unitechnik export: Reinf. checking tab on page 219
Unitechnik export: Reinf. data specification tab on page 220
Unitechnik export: Data specification tab on page 221
Unitechnik export: Line attributes tab on page 222
Unitechnik export: Pallet tab on page 226
Use **Layout Manager** to import and export layout data between Tekla Structures and a field layout device. **Layout Manager** enables you to use accurate model data on the construction site.

The image below illustrates the phases in the field layout workflow.

1. First define layout points and layout lines in your model, and organize them in suitable groups in **Layout Manager**. We recommend that you first set up the groups in **Layout Manager**, then model the points and lines and organize them in the groups. The points and lines are used in a layout device on the construction site to position parts correctly.

2. Once you have defined the layout data, you can export the data from **Layout Manager** to a field layout device in three different export formats: point file (*.txt), job file (*.cnx), and field link file (*.tfl).

3. You can check and measure the positions of the exported layout points (design points) on the site using a field layout device. The layout device helps you to position the parts.
To place the part boundaries correctly, measure the as-built positions of the parts on the site and create measured points along the part boundaries.

When you have measured the as-built positions and created measured points, you can import the points to Tekla Structures. You can first preview the points in Layout Manager.

Finally, you can view the measured points in the model.

To import and export directly with a handheld mobile device such as Trimble® LM80, you need to connect your computer to the device. Your computer needs to have software that enables it to communicate with a mobile device. For information on how to connect your computer to Trimble layout devices, see the Trimble website.

See also

Creating a group in Layout Manager on page 230
Creating a layout point on page 232
Creating a layout line on page 233
Viewing groups, layout points and layout lines on page 234
Exporting from Layout Manager on page 235
Importing to Layout Manager on page 238

26.1 Creating a group in Layout Manager

You can create groups in Layout Manager to organize layout points and layout lines suitably.

To create a group in Layout Manager:

1. Click Tools --> Layout Manager...

2. Right-click Layout Manager Object Group and select Add Group.
   You may want to set up several groups so that you can organize the points and lines into groups as they are modeled.

3. If needed, click the group to rename it.
   A group name can have 18 characters.

   NOTE Layout Manager may show an Unassigned group in the tree structure. The Unassigned group shows layout points and layout lines that have inadequate group information. Such points and lines have usually been created in an earlier Layout Manager version.
Defining numbering settings for groups in Layout Manager

You can define that all groups in Layout Manager have the same numbering settings. When you change the settings, the changed settings are used in all the groups you create after the change. The settings in the existing groups are not changed.

To define numbering settings for groups:

1. Click Tools --> Layout Manager...
2. Click Settings > Group.
3. Define the numbering settings.
   a. Enter the prefix in the Prefix box.
   b. Enter the starting number in the Starting number box.
   c. Enter the maximum length of the number in the Number max length box.
   d. Enter a delimiter to separate the prefix and the number in the Delimiter box: a hyphen or an empty space.
   e. Select from the Fill leading space list whether the leading space in front of the number is filled with zeroes or not, for example, PFX 00001 or PFX 1
4. Click OK.
5. To apply the numbering settings to the points and lines in a group, right-click the group and select Auto Naming.

NOTE You can modify the numbering settings of an individual group if you do not want to use the default settings. Select the group and change the settings in the property pane. To restore the default settings, click Reset.

See also

Creating a group in Layout Manager on page 230
Defining a local coordinate system for a group in Layout Manager

You can define a local coordinate system for each group. Local coordinate systems may be relative to a municipal monument or to the local project site datum. In many cases, models may already be properly placed so that no local coordinate system needs to be defined.

To define a local coordinate system for a group:

1. Click Tools --> Layout Manager...

2. Select a group.

3. Define the coordinates using the Group local coordinate system options in the property pane.
   a. Click the Pick button next to the Location box and pick the origin in the model.
   b. Click the Pick button next to the Axis X box and set the x direction in the model.
   c. Click the Pick button next to the Axis Y box and set the y direction in the model.

4. Click Set.

NOTE: You can set the work plane using a command in View --> Set Work Plane. When you have set the work plane, select a group in Layout Manager. Click the Pick button next to the Use current work plane option under Group local coordinate system and click Set.

See also
Creating a group in Layout Manager on page 230

26.2 Creating a layout point

Use the Layout Point tool in the Component Catalog to create layout points. The layout points that you create in the model are design points that you can export to a layout device.

Before you start, ensure that the Select components selection switch is activated.

To create a layout point:

1. Double-click the Layout Point tool in the list of components in the Component Catalog.

2. Define the properties of the layout point on the Parameters tab.
   a. Enter a name and a description for the layout point.

   The following special characters are allowed in layout point names: _ ~ % ! @ # & . = + - and space.

   Note that the maximum length of the name is 16 characters if you export layout data to .cnx and .tfl formats. When exporting to a text file, there is no limitation to the number of characters in the name. The maximum length of the description is 24 characters.
b. Enter the diameter of the layout point.

   Layout Manager uses the XS_IMPERIAL advanced option to determine the units. Set XS_IMPERIAL to TRUE to show imperial units.

c. Select whether the layout point is a reference point or not.

   A reference point is a mapping point to another coordinate system such as a geospatial coordinate system or a municipal monument.

d. Select a color for the layout point.

e. Select a shape for the layout point.

f. Select a group from the list or create a new group by entering a name.

3. Select a location for the layout point in the model.

   The layout point is created when you select the location.

4. Click Tools --> Layout Manager....

5. Click Refresh to show the added point.

   NOTE You can also add a layout point to a group in Layout Manager. First select a group, then select the point in the model. Right-click the group and select Add Selected from the pop-up menu. Click the Refresh button to show the point.

See also

Creating a group in Layout Manager on page 230
Measured points in Layout Manager on page 240

26.3 Creating a layout line

Use the Layout Line tool in the Component Catalog to create layout lines.

Before you start, ensure that the Select components selection switch is activated. Create layout points in your model. A layout line is created between two layout points.

To create a layout line:

1. Double-click the Layout Line tool in the list of components in the Component Catalog.

2. Define the properties of the layout line.

   a. Enter a name and a description for the layout line.

   b. Enter the diameter of the layout line.

      Layout Manager uses the XS_IMPERIAL advanced option to determine the units. Set XS_IMPERIAL to TRUE to show imperial units.
c. Select a color for the layout line.
d. Select a group from the list or create a new group by entering a name.

3. Pick the first layout point.

4. Pick the second layout point.
   The start point and the end point cannot be in the same location.
   The layout line is created.

5. Click Tools → Layout Manager...

6. Click Refresh to show the added line.

   NOTE You can also add a layout line to a group in Layout Manager. First select a group, then select the line in the model. Right-click the group and select Add Selected from the pop-up menu.
   Click the Refresh button to show the line.

See also
Creating a group in Layout Manager on page 230
Creating a layout point on page 232

26.4 Viewing groups, layout points and layout lines

The properties of groups, layout points and layout lines are shown in the property pane in Layout Manager. You can zoom to and highlight selected layout points and layout lines in the model and in Layout Manager.

Click Tools → Layout Manager... and do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide the properties of groups, layout points and layout lines in Layout Manager</td>
<td>Click the Show property pane button in Layout Manager. The property pane is visible by default.</td>
</tr>
<tr>
<td>Zoom in to a point or a line in the model</td>
<td>1. Select the point or the line in Layout Manager.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the point or the line.</td>
</tr>
<tr>
<td></td>
<td>3. Select Zoom Selected from the pop-up menu.</td>
</tr>
<tr>
<td>Highlight a point or a line in Layout Manager</td>
<td>1. Select the point or the line in the model.</td>
</tr>
<tr>
<td></td>
<td>2. Click 🞆 in Layout Manager.</td>
</tr>
<tr>
<td></td>
<td>3. Select Highlight selected model point.</td>
</tr>
<tr>
<td></td>
<td>To remove the highlighting, select Redraw.</td>
</tr>
</tbody>
</table>
26.5 Exporting from Layout Manager

You can export layout data from your model to a layout device. You can export the layout data from Layout Manager to a file and move the file later to a layout device. You can also export a file directly to a layout device if you connect the layout device to your computer using a USB or a Bluetooth connection. Note that in addition to Trimble devices, other layout devices can also read in the .txt and .cnx file types.

To export layout data from Layout Manager:
1. Click Tools --&gt; Layout Manager...
2. Click Settings to check that you have defined the needed export settings.
3. Select the group that you want to export.
   If you have defined a local coordinate system for a group, the points in such a group are exported according to the local coordinate system. The local coordinates of the points are shown in the export dialog box. The temporary work plane location will not affect the coordinates of the exported points.
   If you select more than one group, ensure that the groups have the same local coordinate system. If the groups have different local coordinate systems, a warning message is displayed and you cannot proceed to export.
4. Click Export.
5. Select an export option:
   - Export point file (.txt) to export layout points.
   - Export job file (.cnx) to export all layout data that is in the model to Trimble® LM80.
   - Export Field Link File (.tlf) to export all layout data that is in the model to a field link device.
   - Export job file (x86) to export all layout data that is in the model to Trimble® LM80. This option can be used in 32-bit computers only.

The layout points that you create in the model are design points that you can export to a layout device.

Note that the maximum length of the layout point name is 16 characters if you export layout data to .cnx and .tlf formats. When exporting to a text file, there is no limitation to the number of characters in the name. The maximum length of the description is 24 characters.
6. Enter a name for the export file.
7. Define the destination folder.

8. Click Save.

9. If needed, select a drawing in Map file.

   You can attach a layout drawing when exporting a job file (.cnx) and a field link file (.tfl). You can use the layout drawing with the layout point data in the layout device.

10. Click OK.

See also

Layout Manager on page 229
Defining default export settings in Layout Manager on page 236
Defining the drawing scale in Layout Manager on page 237

Defining default export settings in Layout Manager

You can define the default export settings for each export file type: point file (.txt), Trimble LM80 job file (.cnx), and Trimble Field Link (.tfl). The units depend on the settings in Tools --> Options --> Options --> Units and decimals.

To define the default export settings:

1. Click Tools --> Layout Manager...

2. Click Settings.

3. Click Point File to define the export settings for point files (.txt).

   a. Select the unit.
   b. Select the delimiter.
   c. Define the order of column headers in point files. Right-click a header in the list and select Move Up or Move Down.

4. Click Trimble LM80 to define the export settings for Trimble® LM80 job files (.cnx).

   a. Select the Default directory.
   b. Select the default Length unit.
      
      You can select to export as meters, feet-inches, or survey feet.
   c. Select the plane Angle unit.
      
      The default angle unit is Degree.
   d. Select the Version of the Trimble® LM80 device.
      
      The default version is V4. Ensure that the setting matches the version of your layout device.
5. Click **Trimble Field Link** to define the Trimble Field Link file default directory for field link files (.tfl).

6. Click **OK**.

**See also**

*Exporting from Layout Manager on page 235*

---

**Defining the drawing scale in Layout Manager**

You can include a drawing when exporting all layout data in a job file or a field link file from **Layout Manager**. To ensure that the drawing is exported correctly, you need to define the drawing scale.

To define the drawing scale:

1. Create a drawing of your model.
   - We recommend you make the drawing as simple as possible, include only parts and grids, to show the drawing correctly in a layout device. You can, for example, create a drawing template to be used in **Layout Manager** export.

2. Double-click the view frame and open **View Properties**.

3. Copy the drawing scale.

4. Click **Tools --> Layout Manager...**.

5. Click **Drawing Scale Calculator** in **Layout Manager**.

6. Enter the drawing scale in the **Scale Denominator** box.

7. Click **Calculate**.
   - The drawing scale is shown in the **Scale** box.

8. Copy the drawing scale from the **Scale** box and close the **Drawing Scale Calculator** dialog box.

9. Click **Drawing File --> Export...** in the drawing.

10. Define the export file name on the **Export file** tab.

11. Go to the **Options** tab.

12. Paste the copied drawing scale in the **Drawing scale box**.

13. Click **Export**.

You can now export the job file or the field link file and the drawing from **Layout Manager**.

**See also**

*Exporting from Layout Manager on page 235*
26.6 Importing to Layout Manager

You can import layout data to your model from a layout device to verify the as-built conditions. You can copy the file that contains the layout data from the layout device to your computer and import the file later to Layout Manager. You can also import a file directly to Layout Manager if you connect the layout device to your computer using a USB or a Bluetooth connection.

To import layout data to Layout Manager:

1. Click Tools --&gt; Layout Manager...
2. Set the work plane to the model origin or to the location you want to use as the origin when importing points and lines.
3. Click Import
4. Select an import option.
   - Import point file (.txt) to import layout points.
     Point files (.txt) are always imported to the Design Points tab, regardless of whether they have been measured on the site or not.
   - Import job file (.cnx) to import all layout data in a Trimble® LM80 job file.
     Job files (.cnx) are imported to the Measured Points tab.
   - Import Field Link file (.tfl) to import all layout data in a field link file.
     Field link files (.tfl) import both design points that have been exported from Tekla Structures originally and measured points that have been measured on the site. In the import dialog box, a design point is flagged if the point name and, therefore, the point already exists. We recommend that you do not import an existing design point. Clear the check box next to the flag to exclude an existing point from the import.
   - Import job file (.cnx 32 bit only) to import all layout data in a Trimble® LM80 job file to a 32-bit computer. You need to connect your computer directly to the Trimble® LM80 device to use this option.
5. Select the file to import.
6. Click Load to show the file contents.
7. If needed, define the point file columns in the Text File Import – Column Headers Mapping dialog box.
8. Define the import location in your model using the Insert coordinate system options.
   You can either select the Insert to default coordinate system option or define the location. To define the location:
   - Click the Pick button next to the Location box and pick the origin in the model.
   - Click the Pick button next to the Axis X box and set the x direction in the model.
• Click the **Pick** button next to the **Axis Y** box and set the y direction in the model.

• Click **Set**.

9. Select the group to which the layout data is imported.

   If you do not select any existing group or create a new group, the layout points are imported using their existing Trimble layer categories.

10. Click **OK**.

**NOTE**

Design points are layout points that have been created in the Tekla Structures model.

Measured points are layout points that have been measured on the construction site.

---

**See also**

- Layout Manager on page 229
- Defining point file columns in Layout Manager on page 239
- Measured points in Layout Manager on page 240

---

**Defining point file columns in Layout Manager**

You can import layout points to your model in a point file. The point file lists the layout point names and the coordinates. If the point file does not have a header or if Layout Manager does not recognize the header, the Text File Import – Column Headers Mapping dialog box is displayed.

To define the point file header columns:

1. Check that the point file content matches the columns.

   The content of the point file is shown in the table at the bottom part of the dialog box. You need to check that the content is shown in the correct columns. The columns are shown at the top part of the dialog box.

   Example of a point file:

   ```text
   Layout point 6, 0, 13.12336, , 0
   Layout point 5, 0, 6.56168, , 0
   Layout point 4, 4.92126, 0, , 0
   Layout point 3, 9.84252, 6.56168, , 0
   Layout point 2, 4.92126, 13.12336, , 0
   Layout point 1, 9.84252, 13.12336, , 0
   Layout point, 9.84252, 0, , 0
   ```
2. If needed, change the columns at the top of the dialog box.

3. Select a measuring unit.

4. Select in the Process first line option whether the first line in the point file is a header row or not.
   - Yes means that the first line has layout point data and that it is not a header line.
   - No means that the first line is a header line.

5. Click OK.

See also
Importing to Layout Manager on page 238

Measured points in Layout Manager
Measured points are points that are measured on the construction site using a layout device and imported to Tekla Structures. You can view the properties of measured points in the property pane in Layout Manager or in the Layout Point tool dialog box. In addition to the general point properties, such as name, diameter, and shape, measured points have measured point properties that cannot be modified in Tekla Structures.
To view the properties, select the point in **Layout Manager** or double-click the point in the model.

The measured point properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Is Stakeout Point</strong></td>
<td>You can label a measured point as staked in the Trimble® LM80 device if it deviates from the corresponding layout point created in the model. The property is shown in the <strong>Layout Point</strong> tool dialog box.</td>
</tr>
<tr>
<td><strong>Is Field Point</strong></td>
<td>A field point has been measured on the construction site and imported to Tekla Structures. <strong>Is Field Line</strong> is the corresponding property for layout lines. The property is shown in the <strong>Layout Point</strong> tool dialog box.</td>
</tr>
<tr>
<td>HR</td>
<td>Height of rod is the height of the prism on the pole. It is used to determine instrument height, and therefore the actual elevation of the measured point.</td>
</tr>
<tr>
<td>HA</td>
<td>Horizontal angle is the angle that was measured from the back sight or 0 angle.</td>
</tr>
<tr>
<td>VA</td>
<td>Vertical angle is the difference in angle measurement from the horizontal position of the instrument scope.</td>
</tr>
<tr>
<td>SD</td>
<td>Slope distance is the actual distance regardless of elevation change. Horizontal angle is the distance along a horizontal plane.</td>
</tr>
<tr>
<td>PPM</td>
<td>Parts per million is a factor used to determine measurements that take into account the air conditions and how they affect the ability of light to travel through the air. This property is important in the measurement calculation and accuracy.</td>
</tr>
<tr>
<td>Benchmark offset</td>
<td>Benchmark offset is a measurement that is taken to define a benchmark that elevation measurements are calculated from.</td>
</tr>
</tbody>
</table>
See also

Importing to Layout Manager on page 238
Creating a layout point on page 232
You can publish your Tekla Structures models as web pages that can be viewed via the Internet using Internet Explorer.

See also
Publishing a model as a web page on page 243
Customizing Web Viewer tooltips on page 244
Web templates on page 245
E-mailing Web Viewer models on page 246
Receiving Web Viewer models on page 246
Sending Web Viewer links on page 246
Creating a named view in Web Viewer on page 247
Creating a clip plane in Web Viewer on page 248
Showing and hiding an object in Web Viewer on page 249
Using a large model in Web Viewer on page 250
Moving and zooming in Web Viewer on page 250

27.1 Publishing a model as a web page

To publish a Tekla Structures model as a web page:
1. Click File --> Publish as Web Page...
2. Select Publish as Web Page.
3. Select whether to publish the entire model or selected objects.
   If you are publishing selected objects, use the appropriate selection switch to control whether parts, or parts in assemblies or cast units are published.
4. Select the file type.
5. Define a title for the published web page.

6. Select a Web Viewer template.

7. Define the destination folder and the file name.
   
   You can define the location and the name of the published model folder. You can also rename the published file but do not change the file name extension (*.xml). By default, Tekla Structures creates a PublicWeb folder with sub-folders in the current model folder and places the published model there as an index.html file.

8. Select the tooltip template.
   
   You can create your own tooltip templates in Template Editor. The preview shows how the tooltip is shown in Web Viewer.

9. Click Publish.

The web browser includes several commands for examining the model. You can right-click the model in the browser to access a pop-up menu containing these commands.

See also

Customizing Web Viewer tooltips on page 244
Web templates on page 245

27.2 Customizing Web Viewer tooltips

You can define what kind of tooltips are shown in a published Web Viewer model. Use Template Editor to create a tooltip template.

To customize Web Viewer tooltips:

1. Click Drawings & Reports --> Template Editor... .

2. Create a new template.

3. Save the template in the *.rpt format in the ..\Tekla Structures \<version>\environments\<environment>\template\tooltips folder.

4. Click File --> Publish as Web Page... .

5. Select a customized tooltip template in the Tooltip in Web Viewer list.
   
   The preview shows how the tooltip is shown in Web Viewer.

6. Click Publish.

NOTE If you do not want to show the template name as a file name in the tooltip template list, add the template in the WebViewerToolTips.ini file. The file is located in the same folder as the tooltip templates. For example, to show MyPartInformation.rpt as My Part Information add: albi_MyPartInformation=MyPartInformation.rpt
See also
Publishing a model as a web page on page 243

27.3 Web templates

The subfolders under ..\Tekla Structures\<version>\nt\WebTemplates \TeklaWebViewer contain all Web Viewer specific materials, for example, a tool (*.dll) for viewing the model and templates for HTML files.

When you publish a model as a web page, Tekla Structures copies the tool and the files to the folder you have given in the File name box in the Publish as Web Page dialog box. You cannot modify the tool, but you can modify the HTML files to include information that is relevant to your company and the project.
Project-specific fields must be inside % signs in the HTML files. Tekla Structures uses information from the model you are publishing in these fields. For example, when you want the project name to show in the Web Viewer model, add %NAME% in the HTML file. When you publish your model, Tekla Structures takes the project name from the Project Properties dialog box.

**NOTE** Do not remove the string %PUBLISHED_MODEL% from the index.html file. Tekla Structures replaces the string with the file name information from the Publish as Web Page dialog box.

See also

Publishing a model as a web page on page 243

### 27.4 E-mailing Web Viewer models

To e-mail a published model:

1. Zip the entire PublicWeb folder.
   
   Remember to use the folder structure.

2. Attach the .zip file to an e-mail message and send it to the recipient.

See also

Receiving Web Viewer models on page 246

### 27.5 Receiving Web Viewer models

When you receive a zipped Web Viewer model, ensure that you keep the folder names when extracting the files. To open the model, double-click the index.html file.

See also

Creating a named view in Web Viewer on page 247
Creating a clip plane in Web Viewer on page 248
Showing and hiding an object in Web Viewer on page 249
Using a large model in Web Viewer on page 250
Moving and zooming in Web Viewer on page 250
27.6 Sending Web Viewer links

There are two tools you can use to send links from the Web Viewer:

- **Send Web Viewer Link**
  Use this tool to send a link to a single Tekla Structures view.
  To see the view name in the Named views list, the recipient must copy the text string and paste it into the Web Viewer model.
  To send several views, copy the text strings pointing to the views into a text file and send the text file. The recipient then copies the contents of the text file and pastes it into the Web Viewer model.

- **Send ULR Link**
  Use this tool to send a URL link to the model.
  The recipient must have access to the folder that contains your published model.

See also
- Receiving Web Viewer models on page 246
- Creating a named view in Web Viewer on page 247

27.7 Creating a named view in Web Viewer

To create a named view from a published model:

1. Open the index.html of the published model.
2. Zoom in to the part of the model from which you want to create the view.
3. Right-click and select Copy location.
4. Create a new file in any text editor (for example, Microsoft Notepad) and paste the location information into it. It should look, for example, as follows:

   [webviewer pointinformation] name: "XYZ"
   projectiontype: perspective
   position: (2947.732 809.972 11.216) direction: (0.128 0.974 -0.187) upvector: (0.024 0.185 0.982)

5. Enter a name for the view. Replace the default name xyz with a name you want the view to have.
6. Copy the updated location information to the published model. Select all text in the text editor, right-click and select Copy.
7. In Web Viewer, right-click on the model and select Paste location.
   The view name appears in the Named views list.
Web Viewer does not save named views with the published model. You can save the text file that contains the location information, then cut and paste the text to the published model in Web Viewer the next time you want to use the view.

To allow others to see your named views, send the views using the **Send Web Viewer link** tool.

See also

*Sending Web Viewer links on page 246*

### 27.8 Creating a clip plane in Web Viewer

Use the keyboard shortcut P or the pop-up menu to create a clip plane.

1. To create a clip plane, use the keyboard shortcut P, and select a plane in the model.
2. To select the clip plane, click the scissor symbol.
Moving clip planes

Move the clip plane by dragging the scissor symbol.

You can change the location of the symbol by holding down the Shift key and moving the symbol.

Select one clip plane and press the space bar to jump between the clip planes.

See also
Tekla Web Viewer on page 243

27.9 Showing and hiding an object in Web Viewer

To show and hide an object in a Web Viewer model:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide an object</td>
<td>1. Move the mouse pointer over the object.</td>
</tr>
<tr>
<td></td>
<td>2. Hold down the Ctrl key and scroll up using the mouse wheel (or press the Page Up key).</td>
</tr>
<tr>
<td>Show a hidden object</td>
<td>1. Move the mouse pointer over the hidden object.</td>
</tr>
</tbody>
</table>
27.10  Using a large model in Web Viewer

You can disable full content rendering in Web Viewer to use a large model faster.

To use a large model faster in Web Viewer:
1. Right-click and select **Disable full content rendering** from the pop-up menu.
2. To enable full content rendering again, select **Enable full content rendering** from the pop-up menu.

See also

Tekla Web Viewer on page 243

27.11  Moving and zooming in Web Viewer

To move and zoom in a Web Viewer model:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in or out</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Press the <strong>Page Up</strong> or <strong>Page Down</strong> key.</td>
</tr>
<tr>
<td></td>
<td>• Scroll the mouse wheel up and down.</td>
</tr>
<tr>
<td>Move the model</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Pan</strong> and drag.</td>
</tr>
<tr>
<td></td>
<td>• Drag with the mouse middle button.</td>
</tr>
<tr>
<td>Rotate the model</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Rotate</strong> and drag.</td>
</tr>
<tr>
<td></td>
<td>• Hold down the <strong>Ctrl</strong> key and drag with the middle mouse button.</td>
</tr>
<tr>
<td>Fly through the model</td>
<td>1. Click <strong>Fly</strong> and move the mouse forward to fly forward.</td>
</tr>
</tbody>
</table>

See also

Tekla Web Viewer on page 243
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change flying direction</td>
<td>2. To change flying direction, move the mouse to the desired direction.</td>
</tr>
<tr>
<td></td>
<td>3. To stop, click Esc.</td>
</tr>
<tr>
<td>Center the model on the screen</td>
<td>Click Center.</td>
</tr>
<tr>
<td>Return the model to the original view</td>
<td>Click Home.</td>
</tr>
<tr>
<td>Relocate the center of rotation</td>
<td>1. Press the V key.</td>
</tr>
<tr>
<td></td>
<td>2. Click to select a new center of rotation.</td>
</tr>
</tbody>
</table>

You can also right-click the model and select the move and zoom commands from the pop-up menu.

**See also**

*Tekla Web Viewer on page 243*
Tekla BIMsight is a free project collaboration software.

With Tekla BIMsight you can combine models from different project participants and check for hard and soft conflicts visually and with conflict checking tools. You can communicate with other parties involved in the project by adding notes, markups and project documentation to the models.

You can download Tekla BIMsight at www.teklabimsight.com.

See also
Importing reference models from Tekla BIMsight on page 252
Importing additional reference models from a Tekla BIMsight project on page 253
Publishing a model to Tekla BIMsight on page 253

28.1 Importing reference models from Tekla BIMsight

You can import models from a Tekla BIMsight project to Tekla Structures as reference models.

To import reference models from a Tekla BIMsight project:
1. Click File --> Import from Tekla BIMsight...
   The Import From Tekla BIMsight dialog box opens.
2. Browse for the Tekla BIMsight project (.tbp file).
3. Click Import to import the models from the Tekla BIMsight project.
   You may need to subdivide the reference models, fit the work area in the model, and change the main 3D view depth to see the reference models entirely after importing.

See also
Importing additional reference models from a Tekla BIMsight project on page 253
28.2 Importing additional reference models from a Tekla BIMsight project

Additional models may have been added to a Tekla BIMsight project after you have imported reference models from the project to Tekla Structures. You can import the additional reference models to Tekla Structures.

To import additional reference models from a Tekla BIMsight project:
1. Save the Tekla BIMsight project with the same name as previously.
2. In Tekla Structures, click File --> Import from Tekla BIMsight...
3. Browse for the Tekla BIMsight project (.tbp file).
4. Click Import to import the models from the Tekla BIMsight project.

New reference models are added to the Tekla Structures model. The existing reference models are not modified in any way. Tekla Structures keeps track of the reference models by checking the TeklaBIMsightGUID attributes.

28.3 Publishing a model to Tekla BIMsight

You can publish your Tekla Structures model and the reference models included in the model as a Tekla BIMsight project file.

To publish a Tekla Structures model as a Tekla BIMsight project (.tbp):
1. Click File --> Publish to Tekla BIMsight...
   The Publish to Tekla BIMsight dialog box appears.
2. Enter a name for the project file.
3. Select the folder where you want to save the project file.
4. Select other options as required.
   • You can include assemblies, base quantities, bolts, grids and reinforcements in the published project.
   • You can split models according to phases.
   • Select the Open After Publish check box to open the project in Tekla BIMsight after publishing.
5. Do one of the following:
   • Click Publish All to publish the whole model. If the model contains reference models they are also included.
   • Click Publish Selected to publish the selected objects.
See also

IFC base quantities on page 65
Tekla Structural Designer is a software that allows you to design reinforced concrete buildings and steel buildings. It works with real physical objects such as beams, columns and slabs. The information transferred is the physical information such as geometry, section sizes and grade as well as attributed data. In Tekla Structures, you can import from and export to Tekla Structural Designer.

Tekla Structural Designer is a code-based modeling tool, which enables structural engineers to establish a code compliance design of the structure, and perform calculations and schema design, for example. All the design/code data is held within Tekla Structural Designer at all times.

Tekla Structural Designer will analyze and design structures to a range of International codes of practice.

The initial model can be started in either Tekla Structures or Tekla Structural Designer, depending on the project needs. You can import and export many times, and make use of the effective change management functionality.

The integration process allows you to pass models between Tekla Structural Designer and Tekla Structures, allowing the updates in the model at both ends. As the model is integrated between software applications, the changes are updated, and modifications performed since the last integration operation are maintained within the model.

Tekla Structural Designer and Tekla Structures accept and produce files in the .cxl neutral file format. The .cxl file format is an XML based neutral file format that allows applications to link Tekla Structural Designer.

See also

Importing with Tekla Structural Designer integrator on page 257
Re-importing with Tekla Structural Designer integrator on page 258
Exporting with Tekla Structural Designer integrator on page 259
Additional information about integration between Tekla Structures and Tekla Structural Designer on page 260
29.1 Example workflow of integration between Tekla Structures and Tekla Structural Designer

Integration between Tekla Structures and Tekla Structural Designer has been developed to ensure that the initial model can be started in either tool without any detriment to the design process. This added flexibility enables companies to align their software solutions closely to their own workflows. (i.e. The initial model can be created in Tekla Structural Designer by the engineer or in Tekla Structures by the technician.)

It is recommended that Tekla Structures model is used as the "master model" for geometrical changes as this model also is linked to the BIM documentation. Alterations made to the model geometry are best handled by altering the Tekla Structures model and transferring the changes through to Tekla Structural Designer for redesign.

A typical workflow and the decision making process through the different stages of a project could be as follows:

Initial scheme stage

- The initial model may be started in Tekla Structures or Tekla Structural Designer without any detriment to the process.
- A number of factors may determine which software is used for starting the modeling process, such as availability of staff, or deliverable requirements.
- Unless there are external drivers, Tekla Structures may prove to be the best starting point for the model as it can provide most of the deliverable items at the initial stage.
- The model does not need to cover the complete building, it might be a typical bay or floor, for example.
- The generated structure can be designed in Tekla Structural Designer for initial section sizing at the initial stage and synchronized back to Tekla Structures for initial drawings or material list creation.
- Simple drawings can be created at this stage, this can be done in Tekla Structures or Tekla Structural Designer.
- Initial material lists for cost estimates can be generated at this stage.

Detailed design stage

- It is not always appropriate to carry models forward from the Initial scheme stage to the Detailed design stage as changes to the overall scheme may have been made, which will not be reflected in the initial scheme model. It is sometimes better to begin the model again.
- Models can be started in Tekla Structures or Tekla Structural Designer to suit the user. The models can then be transferred to the other modeling system.
- Importantly, the two models can be worked on at the same time, with synchronization of the two models taking place to suit the workflow.
- Tekla Structural Designer can be used for a full gravity and lateral design of the structure.
- Within Tekla Structures, drawings can be generated to a tender stage level and general arrangements submitted to building control for approval.
Construction stage

- Using the model from the **Detailed design stage**, much of the **Construction stage** process will take place in Tekla Structures so that the integration with other disciplines can be accounted for.
- The design is not revisited unless the client drives the requirement for change.
- If a re-design of the structure is required, the same synchronization of Tekla Structures or Tekla Structural Designer models can be carried out to suit the user.
- The model will be completed within Tekla Structures and fully detailed drawings for parts can be created along with construction level arrangement drawings of the structure.
- Detail integration checks with other disciplines (e.g. mechanical and electrical engineers) can be carried out at this stage.

### 29.2 Importing with Tekla Structural Designer integrator

Import with Tekla Structural Designer integrator creates Tekla Structures parts, such as beams, columns, slabs, and shear walls based on the contents of the imported .cxl neutral file.

Before importing, open Tekla Structures and the model where you want to import.

To import from Tekla Structural Designer:

1. Select **File --> Tekla Structural Designer --> Import from**.
2. In the import dialog box, enter the path of the import .cxl file in the **Import file** box or click the ... button next to the box to browse for the file.
3. Once you have selected a valid file, the import buttons and the **Preview Conversion** button will be enabled. To read the import file and display all the proposed profile and material grade conversions to be used, click the **Preview Conversion** button.

   The import uses an internal conversion list containing the standard profiles and grades. Any member with profile or material that cannot be converted using the internal conversion will be flagged in red and the Tekla Structures name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and materials manually in the following way:
   a. Create a profile and/or material conversion file in a text editor using the file name extension .cnv.
      The conversion files can also be used to override the standard conversion.
   b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then the corresponding Tekla Structures name, for example:
If the conversion files are not used, the members with profiles or materials that cannot be converted will still be created but they will use the import file profile or material, which may be invalid in Tekla Structures, and the members may be drawn as lines in the model, but can then be edited manually in Tekla Structures.

5. Select the grid options:
   - **Delete Tekla Structures’ grids**: Import will remove all grid lines/planes from the current Tekla Structures model.
   - **Import grids from import file**: The grid lines from the import file will be imported into the Tekla Structures model. A grid line pattern will be created, and all the imported grid lines will be attached as individual grid planes to this pattern.

6. Import by pressing one of the following buttons:
   - **Import at Origin**: Import the model using the global X, Y and Z coordinates with the global origin as the 0,0,0 point for the import model’s coordinate system.
   - **Import at Location**: Select a point in the model to use as 0,0,0 and select a second point to define the X axis to use.

If none of the items in the import file have previously been imported into the current model, Tekla Structures imports the contents of the selected import file and creates all the required objects in the Tekla Structures model.

See also

**Re-importing with Tekla Structural Designer integrator on page 258**

### 29.3 Re-importing with Tekla Structural Designer integrator

When you import from Tekla Structural Designer you can control which changes will be made in the Tekla Structures model. If none of the objects in the import file haven been previously imported in Tekla Structures, the import will complete after Tekla Structures has created the required objects. If objects already exist then the new members will be listed as new, but if no objects exist then the import will just take place.

To re-import from Tekla Structural Designer:

1. Follow the steps in Importing from Tekla Structural Designer on page 257.
2. To display the properties of an object, select the object from the list on the left in the import verification dialog box.

   If you select more than one object, only the properties for the first object on the list are displayed, but all the objects that you selected are highlighted in the model.
3. If any object in the import file has previously been imported into the Tekla Structures model, the Model Comparison Tool dialog box is displayed showing the changes and allowing you to control which changes will be made in the Tekla Structures model. You can do one of the following:

- **Ignore deleted list**: The `.cxl` file may contain a list of objects deleted in Tekla Structural Designer. If objects in this list still exist in the Tekla Structures model, they will be deleted unless this check box is selected.

- **Ignore new items**: Objects that did not previously exist in the Tekla Structures model that are in the import file are excluded from the import if you select this check box.

4. To append the Tekla Structures object ID to the object type string in the comparison tool list, select **Display part IDs**.

5. If updating the positions of objects is not required, selecting **Profile and material updates only** will only update the object profiles and materials, and ignore other changes.

6. To reduce the amount of information displayed about the objects that have been updated, select **Only display changed fields**.
   
   Only the values that have been changed are displayed instead of all the object properties.

7. Click **Accept** to use the current settings and complete the import.

   Once the import is complete you can view the changes in the model using Tekla Structural Designer_Integration Status object group color and transparency settings (View --> Representation --> Object Representation).

See also

Importing with Tekla Structural Designer integrator on page 257

### 29.4 Exporting with Tekla Structural Designer integrator

Export with Tekla Structural Designer integrator allows you to export the entire Tekla Structures model or a selected subset of the model. The exported `.cxl` file can be uploaded to Tekla Structural Designer to update the model, or to create a new Tekla Structural Designer model based on the Tekla Structures model.

Before exporting, open Tekla Structures and the model from which you want to export.

To export to Tekla Structural Designer:

1. Select **File --> Tekla Structural Designer --> Export to**.

2. In the export dialog box, either enter the path of the export file in the **Export file** box or click the ... button at the end to browse to a folder and enter a name for the file.
3. Once you have selected a valid file, the export buttons and the **Preview Conversion** button will be enabled. To process the model and display all the proposed profile and material grade conversions to be used, click the **Preview Conversion** button.

The export uses an internal conversion list containing the standard profiles and grades. Any member with profile or material that cannot be converted using the internal conversion will be flagged in red and the export name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and materials in the following way:
   a. Create a profile and/or material conversion file in a text editor using the file name extension `.cnv`.
      The conversion files can also be used to override the standard conversion.
   b. In the text file, enter the `.cxl` profile or material name, the equal sign (=) and then the corresponding Tekla Structures name, for example:
      
      ```
      STB 229x305x70=TEE229*305*70 for profile
      S275JR=S275 for material
      ```
      If the conversion files are not used, the objects with profiles or materials that cannot be converted will still be created but they will use the export file profile or material that may be invalid.

5. You can export the whole Tekla Structures model or only the objects that you select. Do one of the following to create the neutral file:
   - To export the whole model, click **Export Model**.
   - To export only the selected parts, select the parts from the model and click **Export Selected**.

      The use of select and view filters is recommended to ensure that only structural part of the model or elements requiring design are exported.

      The **Quick report** window will show you the result of the export.

See also

*Additional information about integration between Tekla Structures and Tekla Structural Designer on page 260*

## 29.5 Additional information about integration between Tekla Structures and Tekla Structural Designer

- It is possible to round trip twin profile sections between Tekla Structural Designer and Tekla Structures. The UK twin profiles in Tekla Structural Designer have a fixed gap and have been added to the automatic conversion. For other countries, it is necessary to use...
the conversion file. The conversion file line for profiles is slightly different because you need to include the gap in the line.

See below for three different double-angle profiles from Tekla Structural Designer:

2xUEA(LL) 100x75x8#00615=RSA100*75*8:10(LL)
2xUEA(SL) 75x100x8#00616=RSA100*75*8:12(SL)
2xEA 120x120x10#00614=RSA120*120*10

• The number after the “#” symbol is the profile code in the .cxl or .3dn file format. The code is different depending on the profile type, whether it is metric or imperial and which country it is from.

• The first number in the profile code represents whether the profile is metric or imperial: 0 for metric, 1 for imperial.

• The next two digits in the profile code represent the country in this case 06 for UK.

• The last two digits in the profile code indicate the profile type, 15 for long leg to long leg, 16 for short leg to short leg and 14 for equal angles.

• The Tekla Structures profile is the L shape to use for each of the two members Tekla Structures will create to represent the single item in Fastrak. The number after the colon (:) is the gap to use between the profiles in Tekla Structures, and the (LL) and (SL) convey the required orientation of the members.

• On export, using the same conversion file, the two members in Tekla Structures will be written to the .cxl file as one twin profile member assuming it is still logical and possible to do so.

• The current export excludes the Westok items from the export allowing the user to choose to retain Tekla Structural Designer items during the import to Tekla Structural Designer. This is currently the only way to retain the Westok properties in Tekla Structural Designer.

• Westok beams are imported from Tekla Structural Designer to Tekla Structures as parametric profiles. Currently only standard, circular, non-stiffened holes are imported.

• The cold rolled profile catalogs in Tekla Structural Designer differ from those in Tekla Structures. This means that transferring cold rolled members between the two systems is not always complete.

• The timber profiles in Tekla Structures differ from timber catalogs in Tekla Structural Designer. Therefore by default the timber conversions are limited, however resolving this issue is simply a matter of using a conversion file and creating any of the require profiles yourself in the Tekla Structures profile catalog.

• Curved objects can only be transferred from Tekla Structures to Tekla Structural Designer if they have been modeled as curved polybeams created using three points, because normal beams created with curved properties are not supported.

• Curved grids are currently imported into Tekla Structures as straight grids from the start to the end of the Tekla Structural Designer grid line, ignoring the curve.
Tekla Structural Designer grid lines can be defined anywhere and can be completely irregular patterned. The import to Tekla Structures deals with this by creating a single grid pattern and adding all the grid planes to that grid pattern. Some of the advantages of making all the grid planes in a single grid pattern are that the intersection points work correctly and grid elevations views can be created easily. The main disadvantage of this method is that the grid pattern cannot be updated in Tekla Structures by making changes in the grid pattern's properties.

See also
- Importing with Tekla Structural Designer integrator on page 257
- Re-importing with Tekla Structural Designer integrator on page 258
- Exporting with Tekla Structural Designer integrator on page 259
Tekla Warehouse is a service for collaboration, and for storing and sharing Tekla Structures content.

Tekla Warehouse provides centralized access to a wide range of content that you can use in your Tekla Structures models.

With Tekla Warehouse you can:

• Publish your content online.
• Use your company network or a commercial file storage and synchronization service to share content.
• Save content locally for private use.

In Tekla Warehouse, content is organized into collections.

Tekla Structures collections contain official Tekla content that you can use in your models. The content is grouped by geographical area. There is also a global folder for content that is not location specific.

Tekla Warehouse has the following content categories:

• Applications
• Custom components
• 3D products
• Profiles
• Materials
• Bolts
• Reinforcement
• Model setup files
• Drawing setup files
• Report templates

Accessing Tekla Warehouse

To open Tekla Warehouse while using Tekla Structures, do one of the following:
• Click File --> Open Tekla Warehouse.

• Click on the General toolbar.

Tekla Warehouse Service
Tekla Warehouse consists of the Tekla Warehouse web site (https://warehouse.tekla.com/) and the Tekla Warehouse Service.

You need Tekla Warehouse Service to benefit from all the features Tekla Warehouse offers, for example, easy installation of content into a Tekla Structures model, or local and network collections.

See also
For more information on Tekla Warehouse, go to Tekla Warehouse and click About, or see Getting started with Tekla Warehouse.
31 Analysis and design systems

Analysis and design systems are used to design and analyze the frame or components within a structure. These applications calculate the loading, stresses and strains on the elements. They also calculate the moments, shears and deflections on objects under various loading conditions.

These types of applications make use of various forms of analysis from the traditional first order static, second order p-delta, geometric non-linear or buckling analysis. They can also make use of various forms of dynamic analysis from modal extraction to time history and response spectrum analysis along with the sizing of steel, concrete and timber elements to the relevant national and international design codes.

Some examples of these systems are CSC Orion, ETABS, STAAD.Pro, SAP2000, Robot, ISM, S-Frame, MIDAS, Dlubal, SCIA, Powerframe, GTStrudl, Strusoft, and AxisVM.

See also
Analysis and design direct links on page 265
STAAD.Pro on page 267
SAP2000 on page 266
Robot on page 266
ISM on page 267
S-Frame on page 268

31.1 Analysis and design direct links

When you have a direct link to an analysis and design application, and you export the analysis model from Tekla Structures using that particular analysis application, the model is opened in the application. Tekla Structures and the analysis and design application need to be installed on the same computer.

The analysis and design direct links are created either using the Tekla Open API or the older COM link (Common Object Model transfer technology). A number of direct links are available including AxisVM, CSC Orion, Diamonds, Dlubal, ETABS, GTStrudl, ModeSt, MIDAS, NISA,
Powerframe, ISM, Robot, SAP2000, SCIA, S-Frame, STAAD.Pro, STRUDS, and Strusoft. CSC Orion, ETABS, STAAD.Pro, SAP2000, Robot and ISM are available for downloading in Tekla Warehouse. For the other applications, the links can be downloaded from the vendor web sites or by contacting the vendor.

There are special 64-bit installations for STAAD.Pro, SAP2000, Robot and ISM. The other direct links should only be used with 32-bit installations of Tekla Structures, which can be loaded on a computer with a 64-bit operating system.

Robot on page 266
SAP2000 on page 266
STAAD.Pro on page 267
ISM on page 267
ETABS

31.2 Robot

The Robot Millennium A&D application is owned by Autodesk Inc. Full product details can be found on the Robot Millennium web site.

• This application is suitable for basic interoperability, and it can export and import cis/2 files.
• If you install Tekla Structures and Robot Millennium on the same computer, then a direct link can be used.
• Currently only the EC3, LRFD, CM66, E32 and ANS design codes are available in Robot when using the direct link.
• If you are upgrading to Robot 2012, you will need to uninstall Robot 2011 along with the Autodesk Robot Structural Analysis link. Then install Robot 2012 and the link again. This way you make Tekla Structures point to the Robot 2012 application.

See also
Linking Tekla Structures with Robot
Analysis and design direct links on page 265

31.3 SAP2000

The SAP2000 analysis & design application is written by Computers & Structures, Inc. Full product details can be found on their website.

• The SAP2000 analysis & design application can export and import cis/2 and ifc files, and export SDNF files.
• If Tekla Structures and SAP2000 are installed on the same computer, then a direct link can be used.

• It is important that you run SAP2000 for the first time as a standalone application before your load the link. Just start SAP2000 and create a new model, save it and close SAP2000. This will then update your registry which is needed by the link.

See also
Linking Tekla Structures with SAP2000
Analysis and design direct links on page 265

31.4 STAAD.Pro

The STAAD.Pro analysis and design application is owned by Bentley Systems, Incorporated. Full product details can be found on their website.

• STAAD.Pro can export and import CIS/2 files, along with their std format. It has become a semi-industrial standard especially in the plant and heavy engineering segments.

• If Tekla Structures and STAAD.Pro are installed on the same computer, then a direct link can be used.

• Profile mapping for different installation environments is achieved by mapping the profiles used by Tekla Structures and Bentley in files called ProfileExportMapping.cnv and ProfileImportMapping.cnv located in the TeklaStructures\TS_STAAD folder. Currently these files are only used in import.

See also
Linking Tekla Structures with STAAD.Pro
Analysis and design direct links on page 265

31.5 ISM

Bentley's Integrated Structural Modeling (ISM) is a technology for sharing structural engineering project information among structural modeling, analysis, design, drafting and detailing applications.

ISM is similar to Building Information Modeling (BIM), but focuses on the information that is important in the design, construction and modification of the load bearing components of buildings, bridges and other structures. Full product details can be found on their website.

The ISM link is different form the other analysis and design links in that the physical model is also transferred at the same time as the analysis and design model and the ISM model can be imported into an empty Tekla Structures model. The round-trip of model information is also controlled by a synchronizer.
If Tekla Structures version 17.0, 18.0, 18.1 or later and an ISM enabled Analysis & Design application or Bentley Viewer v8i are installed on the same computer then a direct link can be used.

In order to use the link the ISM Structural Synchronizer version 3.0 needs to be loaded before the link.

See also
Linking Tekla Structures with an ISM enabled Analysis & Design application
Analysis and design direct links on page 265

31.6 S-Frame

S-Frame Analysis is owned and developed by S-FRAME Software Inc. It is a complete 4D structural modeling, analysis and design solution for steel, concrete, linear and non-linear structural models. Full product details can be found on their website https://s-frame.com.

- S-Frame can export and import .dxf files. If Tekla Structures and S-Frame are installed on the same computer, then a direct link can be used. A copy of the link can be requested from S-FRAME Software Inc. Descriptions regarding the link can be found here: Building information modeling (BIM) links.
- In some areas S-Frame used to be distributed by CSC, in which case the installation points to different folders. The model name must not include spaces as this currently is an issue as the analysis and design frame is not created if spaces are included.

The process of importing to and exporting from S-Frame

The Tekla API link allows you to write code to connect to an open model in Tekla and query or manipulate the model. The link was established by using both the S-Frame and Tekla APIs. It uses a library database to manage items between Tekla Structures and S-Frame.

A copy of the link and instructions on using the link can be requested from S-Frame Software Inc.

The whole process involves the following steps: importing to S-Frame, displaying imported items, and exporting from S-Frame. This process is described below.

Importing objects to S-Frame and displaying the objects
1. The S-Frame software checks to see if there is an open model in Tekla Structures using the Tekla API.
2. If a connection can be established, the Tekla Structures model is queried for a list of model objects, such as modeled members or panels.
3. The returned objects are iterated through, recognized types are processed, and equivalent S-Frame objects are added or updated to a library database.
4. The IDs from Tekla Structures are stored so that items can be mapped back and forth between Tekla Structures and S-Frame.

5. Once the objects have been iterated through, the library database is queried, and the updated or created objects referenced in the library are displayed in S-Frame display window.

**Exporting from S-Frame**

1. The S-Frame is queried for objects that are displayed in the S-Frame display window.

2. The library is iterated through for types of known objects (members and panels) that can be mapped back and forth between Tekla Structures and S-Frame.

3. Using the unique IDs stored in the import, the Tekla Structures model is queried to see if items exist. If they do not, they will need to be created, and the library will be updated.

4. Items can then be added or updated to Tekla Structures to match what is in S-Frame.
Disclaimer

© 2015 Tekla Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Tekla does not guarantee that the text is free of technical inaccuracies or typographical errors. Tekla reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Tekla Corporation in the European Union, the United States, and/or other countries. More about Tekla trademarks: http://www.tekla.com/tekla-trademarks. Trimble is a registered trademark or trademark of Trimble Navigation Limited in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Tekla does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.
EPM toolkit © 1995–2004 EPM Technology a.s., Oslo, Norway. All rights reserved.
Open CASCADE Technology © 2001–2014 Open CASCADE SA. All rights reserved.
FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.
Teigha © 2003–2014 Open Design Alliance. All rights reserved.
This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party licenses, go to Tekla Structures, click Help --> About and click the Third party licenses button.

The elements of the software described in this Manual are protected by several patents and possibly pending patent applications in the European Union and/or other countries. For more information go to page http://www.tekla.com/tekla-patents.
Index

3
3D DWG/DXF exporting................................................................. 75

A
analysis & design
direct links............................................................................. 265
Robot......................................................................................... 266
SAP2000.................................................................................... 266
systems...................................................................................... 265
ASCII
exporting................................................................. 151,152
file description................................................................. 152
importing................................................................. 151,152

B
base quantities........................................................................... 65
Bus............................................................................................. 129
importing.................................................................................. 146
BVBS
exporting................................................................................. 184,186,188,189

C
CAD models
re-importing............................................................................. 139
CAD............................................................................................. 129
export file types............................................................................. 123
exporting..................................................................................... 134,135
import file types............................................................................. 123
importing..................................................................................... 123,124
Calma.......................................................................................... 129
checking reference model contents........................................... 40
checking
exported IFC model..................................................................... 64
CIMSteel...................................................................................... 129
conversion files............................................................................ 164
exporting..................................................................................... 161
exporting to an analysis model.................................................. 162
importing..................................................................................... 161
CIMSteel design/manufacturing models
exporting..................................................................................... 163
CIS Model..................................................................................... 129
CIS Model/CIMSteel..................................................................... 129
CIS status..................................................................................... 129
CIS/2............................................................................................. 161
CIS................................................................................................. 267
conversion files............................................................................ 164
exporting..................................................................................... 161
exporting to an analysis model.................................................. 162
importing..................................................................................... 161
clip plane
Web Viewer.................................................................................. 248
CNC colors
exported IFC objects..................................................................... 66
compatible software..................................................................... 13
contour marking......................................................................... 112
conversion files............................................................................ 28
CIMSteel...................................................................................... 164
creating......................................................................................... 29
twin profiles.................................................................................. 29
converting
DSTV files to DXF files.................................................................. 114
IFC objects..................................................................................... 49
creating
contour marking......................................................................... 112
creating named views
Web Viewer.................................................................................. 247
creating
conversion files............................................................................ 29
layers for DWG export................................................................. 87
layout line...................................................................................... 233
Layout Manager groups................................................................. 230
layout point..................................................................................... 232
NC files in DSTV format.............................................................. 97
pop-marks...................................................................................... 109

273
### D

defining groups

- Layout Manager............................................................. 231
- custom line type for DWG export.................................... 88
- export settings in Layout Manager.................................... 236
- Layout Manager groups................................................... 231
- line types and weights for layers in DWG export...................... 89
- Web Viewer tooltips......................................................... 244
- design models................................................................. 163
- DGN.................................................................................. 119
- exporting............................................................................ 121
- import................................................................................ 119
- supported objects............................................................ 120
- direct links........................................................................ 265
- drawing export
- defining customized line type mappings............................... 83
drawings

- export layers...................................................................... 79,81,82
- exporting............................................................................. 77,79,83
- line types.............................................................................. 85

- DSTV................................................................................... 96,129,142
- converting to DXF............................................................... 114
- creating NC files............................................................... 97
- exporting............................................................................. 148,149
- importing............................................................................. 142
- supported entities............................................................. 149
- DSTV file description......................................................... 96

- DWG.................................................................................... 74
drawing export layers......................................................... 79,81,82
export example................................................................. 86
exporting 3D................................................................. 75
exporting drawings............................................................. 77,79
importing............................................................................. 75
objects in export layers..................................................... 80

- DXF.................................................................................... 74
drawing export layers......................................................... 79,81,82
exporting 3D................................................................. 75
exporting drawings............................................................. 77,79
importing............................................................................. 75
objects in export layers..................................................... 80

e-mailing

- Web Viewer........................................................................... 246

ELiPLAN

- exporting.................................................. 176,177,178,179,181,182
- importing........................................................................... 176

Eureka LMP............................................................................ 129
examples

- converting IFC objects......................................................... 55
- creating layers for DWG export......................................... 87
- creating rule for DWG export............................................. 87
- creating selection filter...................................................... 86
- defining custom line type for DWG export........................... 88
- defining line types and weights for layers............................. 89
- exporting drawing............................................................... 91
- setting up layers for DWG export......................................... 86
export layers......................................................................... 79,81
assigning objects............................................................... 80
copying to another project................................................. 82
exporting

- CAD................................................................................. 134
- 3D DWG/DXF................................................................. 75
- ASCII................................................................................. 151
- assigning objects to drawing export layers......................... 80
- BVBS.............................................................................. 184,186,188,189
- CAD................................................................................. 135
- CAD export file types......................................................... 123
- checking exported IFC model............................................. 64
- CIMSteel............................................................................ 161
- CIS.................................................................................... 161
- compatible formats........................................................... 11
- compatible software.......................................................... 13
- DGN................................................................................. 121
drawing.............................................................................. 91
drawing export layers......................................................... 79,81,82
drawings................................................................. 83,237
drawings to 2D DWG/DXF files............................................. 77,79
DSTV............................................................................. 148
ELiPLAN............................................................................ 176,177,178,179,181,182
FEM.................................................................................. 135
FEM export file types......................................................... 141
IFC base quantities........................................................... 65
into IFC.............................................................................. 62
NC files
settings.................................................................99

O
object conversion..............................................48,49,50
objects.inp..............................................................38
objects
related IFC entities.............................................65

P
PDF
import...............................................................118
importing to model..............................................118
PDMS.................................................................135
Plantview.............................................................129
importing models...............................................126
PML
exporting.............................................................135
pop-marks..............................................................108
creating.................................................................109
prfexp_cis.cnv.....................................................164
project folders
exporting drawings...............................................82
project
defining IFC entity for export............................60
properties
Layout Manager..................................................234
property sets
defining in IFC export........................................68
in IFC export........................................................67
publishing
model.................................................................243
model as web page...............................................243
model to Tekla BIMsight.................................253
inserting.............................................................34
loading...............................................................33
modifying details...............................................38
reference model objects.....................................41
supported DGN objects......................................120
reports
importing...........................................................140
Robot.................................................................266

S
S-Frame
displaying............................................................268
exporting............................................................268
importing............................................................268
SACS.................................................................129
SAP2000...............................................................266
SDNF.................................................................129
exporting............................................................135
importing............................................................124
sending links
Web Viewer models..........................................246
sending
Web Viewer.......................................................246
showing objects..................................................249
Web Viewer.......................................................249
SketchUp...........................................................73
exporting............................................................73
software..............................................................13
Staad.................................................................129
exporting............................................................147
importing............................................................143
table type specifications....................................144
STAAD.Pro........................................................267
Stan 3D...............................................................129
importing............................................................145
SteelFab/SCIA.....................................................129
importing............................................................128

T
table type specifications
STAAD...............................................................144
Tekla BIMsight...................................................252
importing additional models.............................253
importing reference models..............................252
publishing models from Tekla Structures.............253
Tekla Structural Designer............................................. 255
  exporting to.......................................................... 259
  importing from.................................................... 257
  re-importing from................................................ 258
Tekla Warehouse.........................................................263
Tekla Warehouse Service.............................................. 263
Tekla Web Viewer..........................................................243
tube NC files.................................................................. 116
twin profiles
  conversion................................................................. 29

Unitechnik
  exporting.................................................................191,193,194,198,207,212,219,220,221,222,226,227
user-defined attribute values
  importing.................................................................155,156,157,158,159
user-defined attributes
  copying properties from IFC objects......................... 52

viewing
  layout lines.............................................................. 234
  Layout Manager properties........................................ 234
  layout points............................................................ 234

web templates............................................................. 245
Web Viewer.............................................................. 243,249
  clip plane................................................................. 248
  e-mailing models...................................................... 246
  full content rendering............................................... 250
  large models............................................................ 250
  moving..................................................................... 250
  named views............................................................. 247
  receiving models....................................................... 246
  sending links............................................................ 246
  sending models.......................................................... 246
  tooltips....................................................................... 244
  web templates........................................................... 245
  zooming..................................................................... 250

XML
  exporting....................................................................... 135
  IFC export property set configuration......................... 70

zooming
  Web Viewer.............................................................. 250